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 ABOUT THIS GUIDE

This User Guide is a reference for DFT. You can read from start to finish or jump 

around as you please. This guide is available in Acrobat PDF format.

Copyright
No part of this document may be reproduced or transmitted in any form or by 

any means, electronic or mechanical, including photocopying and recording, 

for any purpose without the express written consent of Digital Film Tools.

Copyright © Digital Film Tools, LLC. 2019. All Rights Reserved

April 13, 2019

About Us
Digital Film Tools brings together the unbeatable combination of superior 

software designers, motion picture visual effects veterans, video editors and 

photographers. Add three Emmy Awards and experience in creating visual 

effects for hundreds of feature films, commercials and television shows and you 

have a recipe for success. The understanding of photography, film and video 

editing, and in particular visual effects, allows us to design productive and 

highly specialized software. Software that is useful as well as easy to use. Our 

products stand up to the rigors of production and are the culmination of many 

years of experience.

Our philosophy is to bring our visual effects tools and techniques to the 

masses. What was once found only in expensive high-end packages or existed 

as proprietary in-house tools, is now available to photographers, artists, 

designers, and video/film editors. Did I mention affordable? Our software 

doesn't cost an arm and a leg and won't break the bank.
• 
• 
•
•
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 INTRODUCTION

DFT
DFT (aka Digital Film Tools) is the definitive digital toolbox meant to simulate 

optical camera filters, specialized lenses, film stocks and grain, lens flares, 

optical lab processes, color correction as well as natural light and photographic 

effects. 

Available as plug-ins for all popular video and film post production programs as 

well as a standalone application, DFT provides you with everything you will 

need to enhance your images using a staggering amount of filter presets. Using 

the DFT Standalone or photo plug-in versions, any filter can be limited to a 

portion of the screen using sophisticated but simple to use masking controls. A 

layering system to apply multiple filters as well as the Standalone’s batch 

processing system rounds out DFT’s set of tools.

DFT is comprised of the following filters: Ambient Light, Auto Adjust, Black and 

White, Bleach Bypass, Blur, Borders, Cartoon, Center Spot, Chroma Bands, 

Chromatic Aberration, Color, Color Correct, Color Gradient, Color Infrared, 

Colorize Gradient, Color Shadow, Color Spot, Cross Processing, Curves, Day 

for Night, DeBand, DeBlock, DeFog, DeFringe, DeNoise, Depth of Field, Detail, 

Develop, Diffusion, Dot, Double Fog, Dual Gradient, Enhancing, Eye Light, Fan 

Rays, Film Stocks, Flag, Flashing, Fluorescent, Fog, F-Stop, Frost, Gels, Glow, 

Glow Darks, Glow Edges, Grain, Grunge, Harris Shutter, Haze, High Contrast, 

Hot Spot, Ice Halos, Infrared, Kelvin, Key Light, Lens Distortion, Lens Flare, 

Levels, Light, Looks, Low Contrast, Match, Mist, Multi-Star, ND Gradient, Net, 

Night Vision, Overexpose, Ozone, Paint, Pastel, Pencil, Photographic, 

Polarizer, Printer Points, Rack Focus, Radial Exposure, Radial Streaks, Radial 

Tint, Rainbow, Random Spikes, Rays, Reflector, ReLight, Selective Color 

Correct, Selective Saturation, Sepia, Shadows/Highlights, Sharpen, Skin Tone, 

Silk, Sky, Soft Light, Spikes, Spiral Rays, Split Field, Split Tone, Star, Streaks, 

Sunset, Telecine, Temperature, Texture, Three Strip, Tint, Tone Adjust, Two 

Strip, Vignette, Water Droplets, Wide Angle Lens, and X -Ray.
DFT User Guide    
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DFT Features

General
• Simulation of optical glass camera filters, specialized lenses, film stocks, lens

flares, optical lab processes, grain, exacting color correction as well as natural
light and photographic effects

• 112 individual filters

• Thousands of customizable presets

Film Stocks & Looks
• 294 different color and black and white still photographic film stocks, motion 

picture films stocks and historical photographic processes

• 89 color grading presets from Academy Award nominated movies including 2001 
A Space Odyssey, Apocalypse Now, Blade Runner, Back to the Future, 
Frankenstein, Gone with the Wind, King Kong, Saving Private Ryan and Titanic

• 68 stylized color and black and white looks

Lighting
• 331 optical lens flare presets organized into Anamorphic, Circular, Polygons, Star,

Starburst and Stylized categories

• 193 different lighting gels to colorize your images

• Gobo library for lighting effects includes 751 gobos categorized into Abstract,
Doors, Elements, Foliage, Snowflakes, Textures and Windows groups

Photo Versions
• Paint system that includes Black/White, Blur, Clone, Color, Eraser, Mosaic, Red-

Eye, Repair and Scatter brushes

• Layering system for multiple filter application

• Sophisticated but easy to use masking tools

• Variation generator for effect parameters

Architecture
• Mac Retina Display Support

• 8, 16, 32 bit image processing

• Multi-processor acceleration

• GPU acceleration
DFT User Guide
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Filter Categories
The Filters are categorized by filter function: Color, Diffusion, Film Lab, 

Grads/Tints, Image, Lens, Light, and Special Effects.

Color
1 Auto Adjust

2 Black and White

3 Color

4 Color Correct

5 Curves

6 Develop

7 Enhancing

8 F-Stop

9 Fluorescent

10 Haze

11 High Contrast

12 Kelvin

13 Levels

14 Low Contrast

15 Match

16 Ozone

17 Polarizer

18 Printer Points

19 Selective Color Correct

20 Selective Saturation

21 Shadows/Highlights

22 Sky

23 Telecine

24 Temperature

25 Tone Adjust
DFT User Guide    
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Diffusion
1 Center Spot

2 Diffusion

3 Double Fog

4 Fog

5 Frost

6 Mist

7 Net

8 Silk

Film Lab
1 Bleach Bypass

2 Cross Processing

3 Film Stocks

4 Flashing

5 Grain

6 Grunge

7 Overexpose

8 Three Strip

9 Two Strip

Grads/Tints
1 Color Spot

2 Color Gradient

3 Colorize Gradient

4 Dual Gradient

5 Gels

6 ND Gradient

7 Photographic

8 Radial Tint

9 Sepia
DFT User Guide    
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10 Skin Tone

11 Split Tone

12 Sunset

13 Tint

Image
1 DeBand

2 DeBlock

3 DeFog

4 DeNoise

5 Detail

6 Paint

7 Sharpen

Lens
1 Blur

2 Chromatic Aberration

3 DeFringe

4 Depth of Field

5 Lens Distortion

6 Rack Focus

7 Radial Exposure

8 Split Field

9 Vignette

10 Wide Angle Lens

Light
1 Ambient Light

2 Chroma Bands

3 Dot

4 Edge Glow

5 Eye Light
DFT User Guide    
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6 Fan Rays

7 Flag

8 Glow

9 Glow Darks

10 Halo

11 Hot Spot

12 Ice Halos

13 Key Light

14 Lens Flare

15 Light

16 Multi-Star

17 Radial Streaks

18 Rainbow

19 Random Spikes

20 Rays

21 Reflector

22 ReLight

23 Soft Light

24 Spikes

25 Spiral Rays

26 Star

27 Streaks

28 Water Droplets

Special Effects
1 Borders

2 Cartoon

3 Color Infrared

4 Color Shadow

5 Day for Night
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6 Harris Shutter

7 Infrared

8 Looks

9 Night Vision

10 Pastel

11 Pencil

12 Texture

13 X-Ray
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 INSTALLATION

Photo Plug-ins
1 Download DFT at www.digitalfilmtools.com

2 Double-click on the file that was downloaded and run through the installation 
process.

3 When prompted, select the destination programs to install to. You can choose 
from Photoshop, Photoshop Elements, and Lightroom.

4 Start your program and load or select an image.

5 Apply a DFT filter:

• Photoshop/Elements: In the Filter menu, select DFT v1 from the Digital Film Tools 
group.

• Lightroom: In the Photo menu, select Edit In and then choose Edit in DFT v1.

A dialog box pops up when you run DFT.

6 If you purchased the software, select Activate DFT and follow the instructions.

or 

7 Select Request Trial Activation (Internet Required) and click Next to receive a 
fully functioning version of DFT for the specified trial period. At the end of the 
trial period, DFT reverts to a limited demo mode.

or

8 Select Run in Demo Mode and click Finish.

Note: In Demo Mode, a watermark is superimposed over the image.
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Adding DFT to Lightroom as an External Editor
If Lightroom is found during the installation of DFT, DFT will automatically be 

added as an external editor. If for some reason DFT does not show up as an 

external editor, you can manually add DFT as an external editor by following 

the steps below.

1 Open the Preferences in Lightroom.

2 Click the External Editing tab.

3 In the Additional External Editor section, select TIFF for File Format, sRGB for 
Color Space, 8 or 16 bits/component for Bit Depth, set the desired Resolution, 
and choose None for Compression.

Note: DFT is only compatible with TIFF files (8 or 16-bit, with no compression).

4 Click on Choose to select an application. Navigate to the location of DFT.

• On Windows, the default installation location for DFT will be: C:\Program 
Files\Digital Film Tools\DFT

• On Macintosh, the default installation location for DFT will be: /Macintosh 
HD/Applications/Digital Film Tools/DFT

5 Select the DFT Lightroom file and click Choose.

6 Under the Preset drop-down menu, select Save Current Settings as New Preset… 
and name the preset DFT v1.

DFT can now be easily accessed under the Photo menu as a preset external 

editor.
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 UNINSTALLING

Windows
From the Windows Start Menu, select Programs > Digital Film Tools > DFT v1 

> Uninstall DFT.

Macintosh
Go to Applications/Digital Film Tools/DFT v1 and double-click on Uninstall DFT.
DFT User Guide    
• 
• 
•
•
•



• 

Activation Options  30 

• 
• 
• 
•
•
•

 ACTIVATING, DEACTIVATING AND 
TRANSFERRING LICENSES

Activation Options

Internet Activate
Activates DFT over the Internet.

Request License from Self-Service Website
If you do not have an Internet Connection on the computer where you want to 

run DFT, use this option. The self-service website will generate a license file 

which you can then transfer to the desired computer.

Install a License File
Loads a license file obtained from the self-service website or received by email.

Note: If you experience an error when using Internet Activate, it is because you or your 
company uses a proxy server to access the Internet and/or your firewall is blocking our 
program’s access to the Internet. For proxy server users, select Advanced Options and 
enter the appropriate proxy server settings. For firewall users, open your firewall 
software and allow our software to access the Internet.

Deactivation Options
Once DFT has been activated, you can access the Deactivation options by 

selecting the License menu.

Internet Deactivate
Deactivates DFT over the Internet and is only available if you initially activated 

over the Internet. Use this method to return your Product Code back to the 

activation server. You will then be able to use your Product Code to activate 

DFT on another computer.

To deactivate a license:

1 Select License from the Help menu.

2 Choose Internet Deactivate and click Next.

DFT is now deactivated.
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License Transfer
Your Product Code allows you to run DFT on one computer at a time. However, 

you may transfer the license by deactivating on one computer and activating on 

another.

Internet Deactivate / Internet Activate is the preferred method of license 

transfer between computers, but is only available if you initially activated over 

the Internet and currently have Internet access. If you do not have Internet 

access, you will need to contact customer support to assist you in transferring 

the license.

To transfer a license:

1 Select License from the Help menu.

2 Choose Internet Deactivate and click Next.

DFT is now deactivated.

3 On the target computer, select Activate DFT and follow the instructions.

DFT will then activate on the new computer.
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 GENERAL TUTORIALS

DFT Workflow
1 Apply DFT to an image.

2 Choose a filter category.

3 Select a filter.

4 Try out the various filter presets.

5 Adjust the filter parameters to your liking.

6 Use masks to limit where the filter is applied.

7 Add additional filters.

8 Click the Done button to apply the filters to your image.

Applying a Single Filter
The General Tutorials build on one another and are designed to be done in 

order.

1 Apply DFT:

• Photoshop/Elements: In the Filter menu, select DFT v1 from the Digital Film Tools 
group.

• Lightroom: In the Photo menu, select Edit In and then choose Edit in DFT v1.
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The image appears in the Viewer and thumbnails (small images) are created 

for all of the effects in the current category of the Filters window.

2 Click on one of the categories in the Filters window and select a filter.

Presets for the selected filter are generated in the Presets window and the 

default preset for the filter is applied to the image in the Viewer.
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3 Select from the various filter presets by clicking them in the Presets window.

The image in the Viewer is updated as each Preset is clicked.
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You can set the opacity of the filter using the Layer Opacity control in the Effect 

window.

4 Click on the greater than character “>” to the right of the Layer Opacity spin 
controls to bring up the slider so that it can be adjusted.

In addition to opacity, Layers can be combined with the layer below using a 

variety of Blend modes.

Go to Blend Modes for explanations of the various modes.

5 Click the Done button to apply the filter to your image.
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The next time you apply DFT in Photoshop, your previous DFT setup consisting 

of filters, layers and masks will all be displayed and can be modified. For the 

DFT setup information to be remembered in Lightroom, you need to use “Edit 

Copy with Lightroom Adjustments” and render the result. If you then apply DFT 

to the newly rendered version and use “Edit Original”, your previous DFT setup 

will also be displayed and can be modified. This behavior in Lightroom can be 

disabled via the Save setup with image preference.

Tagging and Sorting Favorite Presets
Presets can be tagged as a Favorite allowing them to be sorted separately in 

the Presets window as well as in the Favorites tab of the Filters window.

1 Apply a DFT filter with presets.

2 Tag a preset as a Favorite by selecting the preset and pressing the Toggle 
Favorite icon located at the top right of the Presets window.

Presets tagged as a favorite display a yellow star at the top right of the preset.
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3 To sort the Presets window by Favorites, select Favorites in the Presets pop-up 
menu.

Adjusting Filter Parameters and Creating Presets
1 Select a DFT filter and choose a preset.

When the Parameters tab is selected at the bottom of the Presets and 

Parameters window, the Parameters window is visible and displays the current 

filter’s parameters.

2 If the Parameters window is not showing, click the Parameters tab at the bottom 
of the Presets window.
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3 In the Parameters window, adjust the filter parameters to your liking.

Adjusting the parameters will update and change the image in the Viewer.

Next, you can save your settings as a new custom preset, but you must first 

create a new name.

4 In the name field to the left of the Create Custom Preset icon, type in a new name.

5 Click the Create Custom Preset icon to create a new preset in the Presets window 
based on the current parameter settings.

6 Click the Presets tab at the bottom of the Parameters window to show the Presets 
window.
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7 In the Presets window, you will see the newly created custom preset.

Applying Multiple Filters
1 Select a DFT filter and choose a preset.

2 Adjust the filter parameters if you’d like.

Before another filter can be added, the first filter must be added as a layer in 

the Effect window.

3 Click the Add Layer icon at the top left of the Effect window.

The first filter drops down one position in the Effect window and is added as a 

layer. Multiple filters can be added in this manner.

Note: You can also use Add Layer even if no filter is applied. This way Layer Blend 
Modes can be used to create effects between layers.

Applying Multiple Layer Blend Modes
Instead of adding filters to a layer, you can use only the Layer Blend Mode to 

create an effect.
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1 Select a Layer Blend Mode.

Go to Blend Modes for explanations of the various modes.

2 Before another Layer Blend Mode can be added, click the Add Layer icon at the 
top left of the Effect window.

The first layer drops down one position in the Effect window and a new layer is 

added.

3 Select a different Layer Blend Mode for the new layer.

Multiple Layer Blend Mode’s can be added in this manner.

Viewing Individual Layers
1 Apply a couple of filters to your image and add them as layers.
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2 Click on the image thumbnail in the Effect window to display that layer in the 
Viewer.

With each click of the mouse, the Viewer displays each individual layer. 

3 When you are finished, click on the top layer’s image thumbnail.

Comparing Images
DFT can compare images using Side-by-Side, Vertical Split, Horizontal Split, 

A/B or Snapshot comparison modes. By default, the current filter and original 

image are selected for comparison.

The View/Compare icon in the Effect window changes which layers are used in 

the comparison.

1 Apply a DFT filter and make sure it is affecting the image in some way.

2 Click on the Side-by-Side Comparison icon.

Click
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Horizontal images are stacked vertically and vertical images are placed side by 

side.

3 Click the Vertical Split Comparison mode icon.
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You can now compare the images using a vertical split.

4 Move your cursor into the image area over the split line and when the cursor 
changes to a double-arrow, click and drag to move the split. 

Depending on the filter used, the split line may not be obvious, so triangular 

sashes on the outside of the image help you find it. If you drag the sash all the 

way around, it will swap directions.

5 Enable the A/B Comparison icon and then click the Show Other View icon that 
appears to cycle the current filter with the original image.

6 When done, press the A/B Comparison icon to turn it off.

7 Press the Snapshot icon. 
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Once clicked, a snapshot of the image in the Viewer is taken as well as the 

layer’s mask, if there is one.

8 Press the View Snapshot icon that appears.

View Snapshot allows you to now use the various comparison modes to 

compare the snapshot to other layers or different filter settings.

9 Turn off View Snapshot when done.

Editing Multiple Filters
When multiple filters have been applied, you have the choice of viewing and 

editing one layer at a time or viewing one layer while editing another.

By default, the Viewer and Parameters window display the image and controls 

for the top most layer. The layer displayed in the Viewer is controlled with the 

View/Compare icon 

while the controls shown in the Parameters and Presets window are displayed 

with the Edit icon.

Both of these icons are located in the Effect window above each layer’s 

thumbnail.
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View and Edit One Layer at a Time
1 Apply a couple of filters to your image and add them as layers.

2 To simultaneously view and edit a different layer, double-click on its image 
thumbnail.

The View/Compare and Edit icons automatically activate for the new layer, 

while the Viewer, Parameters and Presets windows update to display the new 

layer’s image and effect controls.

3 Use the effect controls in the Parameters window to edit the new layer.
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View One Layer while Editing Another
There are many instances where it is very useful to view one layer while editing 

another.

1 Double-click on the top most layer’s image thumbnail.

You are now viewing and editing the top layer. The layer that you are editing is 

considered the active layer and this is visually indicated by the layer’s lighter 

gray background. 

Change the active layer by clicking on a lower layer’s Edit icon.

2 Adjust the effect controls in the Parameters window or choose a new preset in 
the Presets window.

You are now Viewing the top layer while editing a layer below.
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Creating Variations
Variations based on either one or two parameters can be created and are 

displayed as thumbnails in a window below the Parameters and Presets 

window.

1 Apply a DFT filter.

2 If the Parameters window is not showing, click the Parameters tab at the bottom 
of the Presets window.
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3 Click on a parameter name in the Parameters window.

Variable parameters are Ranges, Toggles, and Colors.

When you select a parameter, the Variations appear and you'll see the 

variations being generated on that parameter. 

4 Click on a second parameter and it will generate variations between the two.

The first parameter you click on will be the dominant parameter - it'll go across 

the top of the Variations tab. So, you can get different results depending on the 

order you select the parameters.

5 Click on a selected parameter to toggle it back off again.

Note: You can only have one or two parameters selected at a time. If you click on a 
third parameter, the last parameter you clicked on will deselect itself. If you deselect 
both of the parameters or switch effects, the Variations window will disappear because 
the variations are no longer being generated.

Variations are generated based on the current effect parameters. So, you can 

pick some parameters for your variation, then go back to the Presets window 

and pick a different Preset, and the variations will regenerate.

See Variations for more information.
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Applying a Gradient Mask to a Layer
Masks allow you to limit the effect of a filter by revealing it only in white areas 

of the mask. White is on, black is off and gray areas in between represent a 

level of transparency. 

Masks are displayed to the right of the filter thumbnail in the Effect window.

The following mask types can be applied to a layer: Gradient, Spot, Path, Snap, 

EZ Mask, Selection and Paint by clicking the Add Mask icon in the Toolbar.

1 Apply DFT to an image.

Select a filter and preset that changes the image in an obvious way.

2 For instance, select the Grads/Tints > Tint filter.

Photo by Joshua Earle on Unsplash
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3 Click the Add Mask icon in the Toolbar and choose Gradient.

When the mask is applied to your layer, a couple of things happen. First, a 

mask thumbnail appears to the right of the image thumbnail. Second, the filter 

that was applied to the image is now limited to the white areas of the mask. 

Third, controls are added to the Toolbar as well as the Viewer depending upon 

the type of mask selected.

4 Click and drag the corner points in the Viewer to adjust the position of the 
Gradient mask.

Photo by Joshua Earle on Unsplash
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The direction and size of the Gradient can also be adjusted using the controls 

in the Toolbar.

5 Adjust the size of the gradient by first clicking the Gradient Size icon in the 
Toolbar and then dragging the slider that appears.

See Gradient Mask for more information.

Applying a Selection Mask to a Layer
Selection masks can be used to manipulate, isolate and protect specific parts 

of an image when making adjustments or applying filters.

Using advanced image slicing algorithms, masks are created using luminance, 

hue, saturation, average, red, green, blue, cyan, magenta, and yellow values.

1 Apply DFT to an image.

2 Select a filter and preset that changes the image in an obvious way.

3 Click the Add Mask icon in the Toolbar and choose Selection.

A number of controls appear in the Toolbar above the Viewer. The first control 

is called Extract On which determines which image values are used to create 

the mask. The default mask type is luminance, meaning brightness.

Photo © THINKSTOCK LLC--www.thinkstock.com
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4 Press the M key or the Show Mask icon above the Viewer to display the mask.

Position and Range Controls
The Position and Range parameters are key to isolating specific image values.

1 Change the Position parameter if you want to select different values to be used 
for the mask. The parameter can be adjusted by first clicking the Position icon in 
the Toolbar and then dragging the slider that appears.

Using the Luminance extraction method, a higher Position value shows more 

white values from the original image as white values in the mask. A lower 

Position value shows more black values from the original image as white values 

in the mask.

Once you’ve selected the “Position”, you can then add or subtract the “Range” 

of values to be included in the mask.

2 Adjust the Range parameter by clicking it’s icon in the Toolbar and then dragging 
the slider that appears.

Position 0, Range 25 Position 100, Range 25Original
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A higher Range value includes more white values in the mask while a lower 

Range value includes less values in the mask.
Position 100, Range 25 Position 100, Range 75Original
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In addition to using the slider controls in the Toolbar, the Position, Range and 

Radius parameters can be set using on-screen controls. Click on the image to 

place the on-screen control which consists of a center point and a solid circle. 

The Position value is set by the location of the center point, while the Range is 

set by sizing the circle. The larger the circle, the larger the range.

3 Adjust the Radius parameter by clicking it’s icon in the Toolbar and then 
dragging the slider that appears.

Range

Position
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When the Radius control is increased, a soft, circular mask is created to limit 

the selection. If the on-screen controls are used, the Radius is represented as 

a dashed circle.

In this case, the Radius allows me to isolate the clouds from the water.

4 You may want to adjust Black Clip to add more values to the black part of the 
mask and adjust White Clip to add more values to the white part of the mask.

5 If needed, Shrink/Grow can be used to make the mask smaller or larger and the 
Blur controls can soften the mask.

6 Press the M key to display the full color image in the Viewer.

See Selection Mask for more information.

Radius
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Applying a Path Mask to a Layer
A Path is an outline created by placing sequential points along an object. Think 

of it as connecting the dots if you will. Although paths can be open or closed, 

DFT only makes use of closed paths. Drawing a path is often a good solution 

for objects that can’t be masked in any other way.

1 Apply DFT to an image.

2 Select a filter and preset that changes the image in an obvious way.

3 Click the Add Mask icon in the Toolbar and select Path.

Once Path is selected, the effect of the filter in the Viewer can no longer be 

seen until a mask is created.

4 Click repeatedly in the Viewer to create a new shape.

Photo by Patrick Fore on Unsplash
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5 When done, click on the first point that was added to close the path.

The filter now appears only in the area contained within the path. To change the 

shape of the path, move the controls points. 

6 Click on one point to select it or click and drag a box around a group of points. 

7 Click and drag on one of the selected points to move them.

If needed, you can add new points by Alt+clicking on the path between two 

points. Points are deleted by selecting them and hitting the Delete key.

8 Create as many paths as you’d like.

When paths overlap, a hole in the mask occurs.

See Path Mask for more information.
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Applying a Snap Mask to a Layer
The Snap masking tool provides instant visual feedback by snapping an 

editable curve to an object's boundary even if it has vague or low contrast 

edges. This is made possible by utilizing unique graph-cutting and 

segmentation algorithms.

1 Apply DFT to an image.

2 Select a filter and preset that changes the image in an obvious way.

FG Mark

Boundary BG Mark

BG Mark

Photo © THINKSTOCK LLC--www.thinkstock.com
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3 Click the Add Mask icon in the Toolbar and select Snap.

Once Snap is selected, the effect of the filter in the Viewer can no longer be 

seen until a mask is created.

4 Define the area to be isolated by drawing a foreground line with the left mouse 
button.

The Mark Foreground icon is selected by default when you apply a Snap mask 

and that is why you can just start drawing with the left mouse button.

5 Define background areas by drawing lines with the right mouse button.

or
DFT User Guide    
• 
• 
•
•
•



• 

General Tutorials  60 

• 
• 
• 
•
•
•

6 Alternatively, you could select the Mark Background icon and draw with the left 
mouse button.

As soon as the first background line is drawn, Snap calculates a boundary 

curve that is displayed as a black and white dashed line around the object.

7 Draw additional foreground and background lines as needed until the object that 
you’d like to isolate is roughly surrounded by a boundary.
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Where the boundary doesn’t correctly follow the edge of your object, refine the 

boundary by using either the Edit Points or Override Edge icons in the Toolbar. 

When either of these tools is selected, the boundary created in the object 

marking step is converted into editable polygons and you will see a noticeable 

refinement in the boundary.

8 Click the Edit Points icon in the Toolbar and drag a point to adjust the shape of 
the polygon.

and / or

Before After
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9 Click the Override Edge icon in the Toolbar and draw a mark along the edge of 
your object where the boundary doesn’t correctly follow the edge.

10 When happy with the boundary you have created, click the Convert Curve to a 
Path icon in the Toolbar to apply it to the layer and convert it to an editable path.

A slider pops up to control the amount of points to be included in the path.

11 Drag the slider to reduce the number of path points or just click it to accept the 
current setting.

By default, Edit Points is selected after the path is created so that you can view 

and edit the points.

Before After

Photo © THINKSTOCK LLC--www.thinkstock.com
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12 To create a new boundary, select the Mark Foreground icon and repeat the above 
steps.

When boundaries overlap, a hole in the mask is created.

See Snap Mask for more information.

Applying a EZ Mask to a Layer
EZ Mask is an easy to use interactive image masking tool capable of isolating 

almost any object in an image--even if you are dealing with fine hair detail, 

smoke, or reflections. 

To work this magic, EZ Mask iteratively estimates the transparency value for 

every pixel in the image, based on a small sample of foreground (what you want 

to isolate) and background pixels marked by simple strokes on the image. 

Results show that compared with previous approaches, our method is more 

efficient and requires minimal effort to extract high quality masks for 

foregrounds with significant semi-transparent regions.

Stroke Trimap Tutorial
EZ Mask creates masks by using a trimap--a pre-segmented image consisting 

of three regions of foreground (what you want to isolate), background and 

unknown. Partial opacity values are then computed only for pixels inside the 

unknown region. Two trimap methods can be used: Stroke and Filled. This 

tutorial will use the Stroke method.
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Our trimaps can be relatively sparse consisting of individual foreground and 

background brush strokes. All pixels left unmarked will be treated as unknown. 

After processing, if any fine foreground details are missing from the mask, the 

Unknown brush can be used in these areas to help recover lost detail.

1 Apply DFT to an image.

2 Select a filter and preset that changes the image in an obvious way.

3 Click the Add Mask icon in the Toolbar and select EZ Mask.

Note: Once EZ Mask is selected, the effect of the filter in the Viewer can no longer be 
seen until a mask is created.

A good stroke technique is to draw an inner outline around the object you are 

extracting using the Paint Foreground brush and an outer outline using the 

Paint Background brush.

4 Define the area to be cutout by drawing foreground lines with the left mouse 
button. You can quickly draw straight lines if you click with the left mouse button, 
press Shift and then click in a different location. If you keep Shift depressed while 
clicking, you will create interconnected straight lines.

The Paint Foreground brush is selected by default when you enter EZ Mask 

and that is why you can just start drawing with the left mouse button.

User Input Mask
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The strokes should be near the boundary of the foreground, but not right up 

against the edge. Strokes that are closer to the boundary will dominate the 

creation of the mask. Also, if the foreground has varying colors, the strokes 

should cover these colors.

Note: The general rule is don’t put different stroke types too close together unless you 
need to.

5 Define background areas by drawing with the right mouse button.

or

6 Alternatively, you could select the Paint Background brush and draw with the left 
mouse button.
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If the background has varying colors, the strokes should cover these colors.

Warning: If you only provide a few sparse strokes, a Stroke trimap will take longer to 
process than a filled trimap.

7 Click the Generate Mask icon or press the Enter key.

Once EZ Mask is done processing, the mask will be shown in the mask 

thumbnail of the Effect window.

8 Press the M key to view the Mask in the Viewer.

In the Mask, white is foreground, black is background and any gray areas in 

between represent a level of transparency. If the mask is not acceptable after 

processing, add a few strokes near the region where the mask is not accurate.

Note: To quickly toggle off the display of your strokes, click on the layer’s image 
thumbnail. Click the mask thumbnail to re-display the strokes.

Good Stroke Example Bad Stroke Example
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9 If you see gray areas in the foreground object that should be completely white, 
make additional foreground marks in those areas.

10 If you see gray areas in the background that should be completely black, make 
additional background marks.

When drawing a stroke trimap, certain foreground details may be missing after 

the mask is generated. Using the Paint Missing brush in these areas can 

sometimes help recover lost detail.

11 Press the M key again to view the full color image.

12 If any fine foreground details are missing from the mask, click on the Paint 
Missing brush and draw over them with the left mouse button as illustrated by 
the purple strokes in the dog’s hair.

The purple colored strokes represent the missing areas.

13 Click the Generate Mask icon or the Enter key again to see how any new 
foreground, background and unknown strokes affect the mask.

See EZ Mask for more information.
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Filled Trimap Tutorial
EZ Mask creates masks by using a trimap--a pre-segmented image consisting 

of three regions of foreground (what you want to isolate), background and 

unknown. Partial opacity values are then computed only for pixels inside the 

unknown region. Two trimap methods can be used: Stroke and Filled. This 

tutorial will use the Filled method.

Foreground and background brush strokes are used to mark definite 

foreground and background pixels while the Unknown brush is used to mark 

unknown, or mixed regions. Using this method, the entire image is painted/filled 

with one of the three brushes.

1 Apply DFT to an image.

2 Select a filter and preset that changes the image in an obvious way.

3 Click the Add Mask icon in the Toolbar and select EZ Mask.

Note: Once EZ Mask is selected, the effect of the filter in the Viewer can no longer be 
seen until a mask is created.

Foreground Filled Trimap
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When drawing a filled trimap, the best method is to draw the unknown areas 

first. Unknown areas are typically areas where the foreground is transitioning 

to the background. In the image below, the hairy edges of the Alpaca would be 

considered unknown areas.

4 Define unknown areas by selecting the Paint Unknown brush and drawing 
around the edges of the foreground with the left mouse button. You can quickly 
draw straight lines if you click with the left mouse button, press Shift and then 
click in a different location. If you keep Shift depressed while clicking, you will 
create interconnected straight lines.
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Include as little solid foreground areas as possible, but be sure to draw over all 

of the unknown regions. Ideally, the unknown region in the trimap should only 

cover transparent pixels whose actual values are not completely foreground or 

background. In other words, the unknown region in the trimap should be as thin 

as possible to achieve the best masking result. 

5 Define the area to be cutout by selecting the Paint Foreground brush and the Fill 
tool.

Using the current brush, the Fill tool fills a region defined by a brush stroke or 

the edges of the screen.

6 Click inside the area defined by the blue, unknown brush.
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The area inside of the blue, unknown boundary automatically fills in with the 

green foreground brush. Using the Fill tool is much easier than drawing the 

entire area by hand.

7 Define background areas by using the Paint Background brush and the Fill tool. 
Since the Fill tool is already enabled, you don’t need to select it again.

8 Click on the background outside of the area defined by the blue, unknown brush.

The background area automatically fills in with the red background brush.
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9 Click the Generate Mask icon or press the Enter key.

Once EZ Mask is done processing, the mask will be shown in the mask 

thumbnail.

10 Press the M key to view the Mask in the Viewer.

In the Mask, white is foreground, black is background and any gray areas in 

between represent a level of transparency.

Note: To quickly toggle off the display of your strokes, click on the layer’s image 
thumbnail. Click the mask thumbnail to re-display the strokes.

11 If you see gray areas in the foreground object that should be completely white, 
make additional foreground marks in those areas. 

12 If you see gray areas in the background that should be completely black, make 
additional background marks.
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13 If there are areas that should be marked as unknown, make additional marks with 
the Paint Unknown brush.

14 Click the Generate Mask icon or Enter key again to see how any new foreground, 
background and unknown strokes affect the mask.

15 Press the M key again to view the full color image.

See EZ Mask for more information.

Applying a Paint Mask to a Layer
Organic masks are created using a paint brush.

1 Apply DFT to an image.

2 Select a filter and preset that changes the image in an obvious way.

3 Click the Add Mask icon in the Toolbar and select Paint.

Once the Paint mask is selected, the effect of the filter in the Viewer can no 

longer be seen until a paint stroke is made.
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4 To set the brush size, click on the Brush Size icon in the Toolbar, and drag the 
slider that appears.

or

5 Resize the brush in the Viewer by holding Ctrl(Win)/Cmd(Mac) and dragging in or 
out.

The Brush Softness and Opacity can also be adjusted by clicking their 

respective icons in the Toolbar.

6  Using the left mouse button, click and drag a portion of the Viewer.

The filter appears only in the area of the paint stroke.

7 To quickly erase a portion of the painted mask, paint with the right mouse button. 
Alternatively, select a O Brush Opacity and paint with the left mouse button.

Painting with a brush intensity that is a level of gray will apply the filter 

proportionate to that brush intensity. White areas in the mask apply the filter at 

full intensity while black areas show no filter.

See Paint Mask for more information.

Applying Multiple Masks to a Layer
More than one mask can be applied to a layer.

1 Apply DFT to an image.

2 Select a filter and preset that changes the image in an obvious way.
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3 Click the Add Mask icon in the Toolbar and choose Selection.

4 Click the Add Mask icon again and select Spot.

A Spot mask thumbnail appears to the right of the Selection mask and is 

automatically combined with it. View the Mask channel to see the results of the 

two masks.

5 Click the Show Mask icon above the Viewer so that you can see the combination 
of all your masks.

To change how the active mask is combined with the previous mask, use the 

Blend modes in the Toolbar. 

Photo by Oscar Dejean on Unsplash
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6 Select the Multiply blend mode to see how it affects the way the masks are 
combined.

7 Click the M shortcut key to switch the Viewer to display the full color image.

When you have multiple masks, the mask with the gray border around it is 

considered the active mask and it’s controls are displayed in the Toolbar.

To change the active mask, simply click on the thumbnail of another mask.
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Drag and Drop Layers, Filters and Masks

Drag and Drop Layers
The ordering of layers in the Effect window can be changed by dragging and 

dropping them to a new location.

1 Apply a filter and create a mask.

2 Click the Add Layer icon and a second filter and mask.

3 An entire layer can be moved to a new location by clicking and dragging on the 
layer’s title bar to the right of the filter name and releasing the mouse in the new 
location.

When the mouse button is released, the layer is moved to the new location. 

Drag and Drop Filters and Masks
Filters and masks from one layer can be copied to another layer using drag and 

drop.

1 Choose a layer that has a filter applied to it.

Before After
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2 Click and drag on the layer’s image thumbnail and release the mouse on the 
layer’s thumbnail where you want to copy the filter. When the cursor hovers over 
the image thumbnail of another layer, the cursor changes to a + sign indicating 
that it is OK to release the mouse.

When the mouse button is released, the destination filter is replaced with the 

source filter. 

Before After
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3 Click and drag on one of the layer’s mask thumbnails and release the mouse on 
the layer’s mask thumbnail where you want to copy the mask. When the cursor 
hovers over the mask thumbnail of another mask, the cursor changes to a + sign 
indicating that it is OK to release the mouse.

When the mouse button is released, the destination mask is replaced with the 

source mask. If you release the mouse over a layer without a mask, the mask 

will be added to the layer.

Setups
A Setup takes a snapshot of the filters and parameter settings applied to your 

image. Setups can be saved and loaded and are independent of the image they 

were originally applied to.

1 Apply a DFT filter.

2 Choose a preset and make some parameter adjustments.

Before After
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3 Add additional filters if you like by clicking the Add Layer icon at the top of the 
Effect Window and then selecting another filter.

4 Select File > Save Setup.

5 When the file browser opens, enter a name and click Save.

You can now apply this setup to a different image using File > Open Setup.
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 FILTER TUTORIALS

Ambient Light
Ambient creates light without a defined source and contributes to the overall 

brightness of a scene without casting shadows.

1 Apply Ambient Light from the Light category.

2 Try out some of the presets.

3 If the Parameters window is not showing, click the Parameters tab at the bottom 
of the Presets window.

4 Adjust the Brightness to set the intensity of the ambient light. 

5 To apply a custom light color to the image, click on the Color box and select a 
color.

6 To apply a colored gel to the light, select one from the Gels pop-up menu.

7 Click the Done icon to apply the filter to your image.

See the Ambient Light filter for more information.
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Auto Adjust
Automatically adjusts the image using Auto Color, Auto Contrast and Auto 

Levels processes.

1 Apply Auto Adjust from the Color category.

2 Try out the presets.

The only choices in Auto Adjust are Auto Color, Auto Contrast and Auto Levels.

3 If the Parameters window is not showing, click the Parameters tab at the bottom 
of the Presets window.

4 Use the Opacity slider to set the amount of auto adjustment.

See the Auto Adjust filter for more information.
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Black and White
Black and White converts color images to black and white simulating the look 

of Black and White photographic filters.

1 Apply Black and White from the Color category.

2 Try out some of the presets.

3 If the Parameters window is not showing, click the Parameters tab at the bottom 
of the Presets window.

4 From the Filter pop-up, select the type of black and white filter to be applied to 
your color image.

Your choice of filter can dramatically change the black and white result.

5 Use the Brightness, Contrast and Gamma controls to further adjust the image.

6 Click the Done icon to apply the filter to your image.

See the Black and White filter for more information.
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Bleach Bypass
Bleach Bypass is a film laboratory technique where, by skipping the bleach 

stage in the color processing sequence, silver is retained in the image along 

with the color dyes. The result is effectively a black and white image 

superimposed on a color image. Bleach Bypass images have increased 

contrast, reduced saturation, often giving a pastel effect.

1 Apply Bleach Bypass from the Film Lab category.

2 Try out some of the presets.

At the top left of the Presets window, the presets are categorized into various 

groups located inside a pop-up menu.

3 In the Presets window, choose a new preset group from the pop-up menu to see 
a different set of filter presets.

4 If the Parameters window is not showing, click the Parameters tab at the bottom 
of the Presets window.

5 Use the Amount slider to control the strength of the Bleach Bypass filter.

6 Saturation, Contrast and Temperature sliders are provided for additional 
enhancement.

7 Click the Done icon to apply the filter to your image.

See the Bleach Bypass filter for more information.
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Blur
Blurs the image with individual horizontal and vertical controls. It’s fast, high 

quality and blurs outside the frame which removes the dark inward bleeding 

edges of most blurs.

1 Apply Blur from the Lens category.

2 If the Parameters window is not showing, click the Parameters tab at the bottom 
of the Presets window.

3 Adjust the Blur-Horizontal slider.

Since Gang is activated by default, the Blur-Vertical amount will match the 

Horizontal value.

4 Un-click the Gang and now the Horizontal and Vertical sliders can be moved 
independently.

5 Set the Position of the blur if you’d like.

By default, the Position is set to Centered, where the image is equally blurred 

inward and outward. You can also set the Position to Inner or Outer. Inner and 

Outer are good for shrinking or growing mattes.

6 Click the Done icon to apply the filter to your image.

See the Blur filter for more information.
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Borders
Select from a variety of different pre-made borders or create your own.

1 Apply Borders from the Special Effects category.

2 Try out some of the presets.

At the top left of the Presets window, the presets are categorized into various 

groups located inside a pop-up menu.

3 In the Presets window, choose a new preset group from the pop-up menu to see 
a different set of filter presets.

4 If the Parameters window is not showing, click the Parameters tab at the bottom 
of the Presets window.

5 If you selected one of the pre-made Border 1-11 presets, you can adjust the 
Orientation, Invert state, Softness, Roughness and Randomization of the edge.

Variable colored, softened borders can also be created using Border > Type > 

Custom.

6 Select Border > Type > Custom. You can then adjust the Size, Color, Softness, 
Roughness and Randomization of the edge.

7 To adjust the image within the border, click and drag the center image point to 
the desired location.

8 You can also use the Transform > Scale and Rotate controls to transform the 
image within the border.

9 Click the Done icon to apply the filter to your image.

See the Borders filter for more information.
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Cartoon
Converts the image into a cartoon.

1 Apply Cartoon from the Special Effects category.

2 Select the Magnifier tool in the Viewer.

When the Magnifier is selected, a portion of the image is displayed at a 1:1 pixel 

ratio in the Magnifier window and shows the actual pixels of the image with the 

Cartoon filter applied. The Magnifier will accurately represent what the Cartoon 

filter will look like when applied to the full size image.

3 Try out some of the presets.

4 If the Parameters window is not showing, click the Parameters tab at the bottom 
of the Presets window.

5 Adjust the Amount to the desired level.

6 Set the Detail. Increasing the value shows more detail while decreasing the value 
shows less detail.

7 Adjust the Line control to set the amount of outlining.

8 Click the Done icon to apply the filter to your image.

See the Cartoon filter for more information.
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Center Spot
Center Spot diffuses and blurs distracting backgrounds while keeping a center 

spot in focus. The center spot can be moved, sized and the amount of blur can 

be controlled. Warm Center Spot combines the benefits of Center Spot with a 

warming filter making it ideal for portraits and skintones.

1 Apply Center Spot from the Diffusion category.

2 Try out some of the presets.

At the top left of the Presets window, the presets are categorized into various 

groups located inside a pop-up menu.

3 In the Presets window, choose a new preset group from the pop-up menu to see 
a different set of filter presets.

4 If the Parameters window is not showing, click the Parameters tab at the bottom 
of the Presets window.

5 Adjust the Spot > Position by clicking and dragging the center image point to the 
desired location. 

6 Set the Radius, Falloff Radius and Falloff.

The area covered by the spot will be in focus with all other areas blurred.

7 If you are curious, you can see what the Spot looks like by changing your View 
to Spot. Change your View to Output when done.

8 Adjust the Horizontal and Vertical Blur to your liking.

9 If you applied a Warm Center Spot preset, adjust the Temperature > Color and 
Opacity sliders to your liking.

10 Click the Done icon to apply the filter to your image.

See the Center Spot / Warm Center Spot filters for more information.
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Chroma Bands
Creates rainbow diffraction patterns.

1 Apply Chroma Bands from the Light category.

2 Try out some of the presets.

3 If the Parameters window is not showing, click the Parameters tab at the bottom 
of the Presets window.

4 Click and drag the point control to move the Chroma Bands and use Scale to 
change the size.

5 Change Spread to control the distribution of the bands and Taper to fade the 
edges.

6 Adjust Cycles to set the amount of bands and Density to control the amount of 
rays.

7 Set the Brightness and Chroma as desired.

8 Click the Done icon to apply the filter to your image.

See the Chroma Bands filter for more information.
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Chromatic Aberration
Chromatic aberration is caused by a lens having a different refractive index for 

different wavelengths of light and is seen as fringes of color around the edges 

of the image. This fringing is removed by un-distorting the individual color 

channels.

1 Apply Chromatic Aberration from the Lens category.

2 Select the Magnifier tool in the Viewer. 

When the Magnifier is selected, a portion of the image is displayed at a 1:1 pixel 

ratio in the Magnifier window and shows the actual pixels of the image with the 

Chromatic Aberration filter applied. The Magnifier will accurately represent 

what the Chromatic Aberration filter will look like when applied to the full size 

image.

Note: The Magnifier zoom controls are disabled in Chromatic Aberration for 
performance reasons.

3 Look at the edges of the image and determine if the chromatic aberration is 
red/cyan, green/magenta, or blue/yellow.

4 Start by adjusting the Distortion parameter for the particular color fringing that 
you are trying to remove. For instance, if you see red/cyan fringing, adjust the 
Distortion slider in the Red/Cyan group.

If you are using anamorphic motion picture lenses or are experiencing non-

radial, asymmetric fringing, you may need to adjust the Anamorphic Squeeze 

and Curvature X/Y parameters.

5 Click the Done icon to apply the filter to your image.

Note: Chromatic Aberration must be applied as the first layer (bottom of the layer stack) 
when multiple layers are used. Otherwise, all filters below will not be rendered.

See the Chromatic Aberration filter for more information.
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Color Correctors
DFT includes a number of different color correctors that are handy for adjusting 

an image’s color. They include: Color Correct, F-Stop, Printer Points, Telecine 

and Temperature. The Color Correct filter will be used in the following tutorial 

since it is similar to the other color correctors.

1 Apply Color Correct from the Color category.

2 Try out some of the presets.

3 Adjust any of the sliders in the Master group.

The master settings affect the entire image. However, you can also use mattes 

in the shadow, midtone and highlight regions to adjust the color selectively in 

those areas.

4 Change your View to Shadows, Midtones or Highlights to see the matte values.

The areas that are white in the matte are the areas that will be adjusted by the 

color controls. The areas defined as shadows, midtones or highlights can be 

adjusted by modifying the Position and Range parameters.

5 Use the Shadows, Midtones or Highlights Position parameters if you want to 
select different values for the adjustment.

6 Increase the Shadows, Midtones or Highlights Range controls to add more 
values to the adjustment. Decrease for less values.

7 Change your View to Output to see the image.

8 Adjust the sliders in the Shadows, Midtones or Highlights groups to see how it 
affects your image.
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An alternative to adjusting the sliders is to use the Color Wheels. 

The color wheels have the following controls:

Saturation Offset

Brightness
Hue/Saturation

Hue Rotate

Red, Green, Blue Value Display
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9 Move the center point on one of the Color Wheels to adjust the Hue and 
Saturation.

As the center point is moved, the Hue and Saturation adjustments are achieved 

by simultaneously changing the Red, Green and Blue parameters in the 

respective group: Master, Shadows, Midtones, or Highlights. The current Red, 

Green and Blue values are displayed below the Color Wheel.

10 Drag the colored dash on the outside of the Color Wheel to rotate the hue.

11 To increase or decrease the selected color’s saturation, adjust the Saturation 
Offset by sliding the dash on the left circular slider.
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12 Change the Brightness by dragging the dash on the right circular slider.

To reset a color wheel, you can right-click on any color wheel and select Reset 

> All, Shadows, Midtones, or Highlights.

13 Click the Done icon to apply the filter to your image.

See Color Correctors for more information.
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Color Gradient
Color Gradient colors and or darkens only a portion of the image giving you the 

ability to simulate any Color Gradient filter. Presets for your favorite color 

gradient filters are provided as well as the ability to create custom colors. There 

is a graduated transition for a smooth color blend between the 

colored/darkened portion and the original image.

1 Apply Color Gradient from the Grads/Tints category.

2 Try out some of the presets.

3 If the Parameters window is not showing, click the Parameters tab at the bottom 
of the Presets window.

4 Adjust the Grad > Type, Corner Points, Size and Angle.

To adjust the Corner Points, just click and drag them to the desired location.

Note: On some host programs, you must highlight the effect title in the Effect Controls 
window to see the on-screen controls.

Go to the Grad section of Common Filter Controls to see how the Grad controls 

work.

5 If you are curious, you can see what the gradient looks like by changing your 
View to Grad. Change your View to Output when done.

The white area of the gradient will be tinted.

6 If you want less coloring of the image, turn down the Filters > Opacity.

7 Image highlights can be retained by adjusting the Filters > Preserve Highlights 
control to a value of 100.

8 Click the Done icon to apply the filter to your image.

See the Color Gradient filter for more information.
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Color Infrared
Color Infrared simulates infrared filters used in conjunction with infrared 

sensitive film or sensors to produce very interesting false-color images with a 

dreamlike or sometimes lurid appearance.

1 Apply Color Infrared from the Special Effects category.

2 Try out some of the presets.

3 If the Parameters window is not showing, click the Parameters tab at the bottom 
of the Presets window.

4 Adjust the Magenta and Blue sliders to your liking.

5 Changing the Hue will only adjust hue in non-blue areas.

Color Infrared images usually have high contrast. 

6 Lower the Contrast setting if it is too high for your image.

7 Click the Done icon to apply the filter to your image.

See the Color Infrared filter for more information.
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Color Shadow
Creates a high contrast image overlayed with a gradient.

1 Apply Color Shadow from the Special Effects category.

2 Try out some of the presets.

3 If the Parameters window is not showing, click the Parameters tab at the bottom 
of the Presets window.

4 Adjust the Threshold to obtain the desired amount of image detail.

The color gradient can be adjusted to your specific image.

5 Adjust the Grad > Direction, Corner Points and Size to position and adjust the 
grad.

To adjust the Corner Points, just click and drag them to the desired location.

Go to the Grad section of Common Filter Controls to see how the Grad controls 

work.

6 To change the background or gradient colors, click on the Background Color, 
Color 1 or Color 2 > Color boxes and select a color.

Color 1 sets the top of the gradient and Color 2 sets the bottom of the gradient.

7 Click the Done icon to apply the filter to your image.

See the Color Shadow filter for more information.
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Color Spot
Tints the image using presets for common photographic filters except for a 

center spot which retains normal color. The center spot can be moved, sized 

and the amount of blur can be controlled. 

1 Apply Color Spot from the Grads/Tints category.

2 Try out some of the presets.

3 If the Parameters window is not showing, click the Parameters tab at the bottom 
of the Presets window.

4 Adjust the Spot > Position by clicking and dragging the center image point to the 
desired location. 

5 Set the Spot > Radius, Falloff Radius and Falloff.

6 If you are curious, you can see what the Spot looks like by changing your View 
to Spot. Change your View to Output when done.

The white area of the spot will be tinted.

7 If you want less coloring of the image, turn down the Color > Opacity.

8 Image highlights can be retained by adjusting the Color > Preserve Highlights 
control to a value of 100.

9 Click the Done icon to apply the filter to your image.

See the Color Spot filter for more information.
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Colorize Gradient
1 Apply Colorize Gradient from the Grads/Tints category.

2 Try out some of the presets.

3 If the Parameters window is not showing, click the Parameters tab at the bottom 
of the Presets window.

4 Choose your color by clicking on the Shadows, Midtones or Highlights > Color 
boxes and selecting a color.

5 Adjusting the Shadows, Midtones or Highlights > Position slider will set where 
the colors are applied to the image.

6 If you want less coloring of the image, turn down Opacity.

You can also use a gradient to control where the colorization is applied.

7 To use a gradient, click on Grad > Enable.

8 Adjust the Grad > Type, Corner Points, Size and Angle.

To adjust the Corner Points, just click and drag them to the desired location.

Note: On some host programs, you must highlight the effect title in the Effect Controls 
window to see the on-screen controls.

Go to the Grad section of Common Filter Controls to see how the Grad controls 

work.

9 If you are curious, you can see what the Grad looks like by changing your View 
to Grad. Change your View to Output when done.

Go to the Colorize Gradient filter for more information.
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Cross Processing
Cross-processing is a photographic technique where print film (C41) is 

processed in the set of chemicals usually used to process slide film (E6) or vice 

versa. The final result yields images with oddly skewed colors and increased 

contrast and saturation. Different film stocks produce different results, so we 

have created what we feel is a representative look.

1 Apply Cross Processing from the Film Lab category.

2 Try out some of the presets.

At the top left of the Presets window, the presets are categorized into various 

groups located inside a pop-up menu.

3 In the Presets window, choose a new preset group from the pop-up menu to see 
a different set of filter presets.

4 If the Parameters window is not showing, click the Parameters tab at the bottom 
of the Presets window.

5 Use the Amount slider to control the strength of the Cross Processing filter.

6 Switch the Mode to Slide to Print.

Both Print to Slide and Slide to Print modes are available.

7 Click the Done icon to apply the filter to your image.

See the Cross Processing filter for more information.
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Curves
Curves adjusts the entire tonal range of an image by changing the shape of 

RGB, Red, Green or Blue curves. Curve points can be adjusted throughout the 

range of shadows to highlights.

1 Apply Curves from the Color category.

2 Select RGB, Red, Green or Blue from the Curve Type pop-up menu. You can also 
click directly on an existing curve in the graph to select it.

Adding and deleting points from the curve is quick and easy.

3 Click directly on the curve to add a new point. Up to five points can be added.

4 Delete points by clicking and dragging them to the edge of the graph.

5 Move points by clicking and dragging them.

Adjust curve points to achieve a specific result.

Adjust Black

Adjust White

Adjust Gray

Curve Type
DFT User Guide    
• 
• 
•
•
•



• 

Filter Tutorials  102 

• 
• 
• 
•
•
•

6 Move a point in the top portion of the curve to adjust the shadows.

7 Move a point in the center of the curve to adjust the midtones.

8 Move a point in the top portion of the curve to adjust the highlights.

9 Move the curve upward or downward to lighten or darken the image. The steeper 
sections of the curve represent areas of higher contrast; flatter sections 
represent areas of lower contrast.

10 To darken highlights, move a point near the top of the curve downward. Moving 
a point either down or to the right maps the input value to a lower output value, 
and the image darkens.

11 To lighten the shadows, move a point near the bottom of the curve upward. 
Moving a point either up or to the left maps a lower input value to a higher output 
value, and the image lightens.

12 Use the RGB, Red, Green and Blue sliders to globally adjust the curves.

13 Click the Done icon to apply the filter to your image.

See the Curves filter for more information.
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Day for Night
Day for Night simulates a technique used for shooting exteriors in daylight 

made to look like they were photographed at night. 

1 Apply Day for Night from the Special Effects category.

Day for Night uses a type of diffusion that grows darks areas into bright areas. 

2 Try out some of the presets.

3 If the Parameters window is not showing, click the Parameters tab at the bottom 
of the Presets window.

4 Adjust the Diffusion > Blur and Opacity parameters to your liking.

The Day for Night effect relies on a blue tint to simulate moonlight. You can 

modify the color of the tint as well as its intensity using the Moonlight controls.

5 Use the Moonlight controls to adjust the tint applied to the image.

Photographically the image is underexposed by two stops or so. We duplicate 

the underexposure by using a combination of color correction controls. Modify 

the color correct presets brighter or darker depending on your image.

6 Change the Color Correct settings if necessary.

7 Click the Done icon to apply the filter to your image.

See the Day for Night filter for more information.
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Defog
Using advanced deweathering algorithms, Defog restores clear day contrasts 

and colors of a scene taken in bad weather such as fog and mist. It is also 

successful in removing the effects of optical Fog and Diffusion filters.

1 Apply Defog from the Special Effects category.

2 Try out some of the presets.

3 If the Parameters window is not showing, click the Parameters tab at the bottom 
of the Presets window.

4 Click on the Defog > Color picker and click on an area of fog.

This sets the color of the fog to be removed.

5 Adjust the Defog > Defog parameter to remove more fog or mist.

The fog is removed in a radial pattern emanating from the vanishing point. For 

instance, if your fog moves in the direction of top right to bottom left, set your 

vanishing point towards the top right corner and the fog removal will be more 

intense at the upper right and fall off at the bottom left. However, in most cases, 

the vanishing point can be left in the center of the screen and you will obtain 

acceptable results.

6 If needed, move the Vanishing Point to a new location by clicking and dragging 
the on-screen control in the center of the screen.

If the defogging operation causes the shadow areas to become too contrasty, 

adjust the Min Depth slider to a lower value. This will bring back some shadow 

detail.

7 Lower the Min Depth value if you have lost to much detail in the shadow portions 
of the image.

8 Click the Done icon to apply the filter to your image.

See the Defog filter for more information.
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DeFringe
Purple or blue fringing around overexposed areas is a result of sensor 

overloading in video as well as digital still cameras. DeFringe isolates and 

removes the various types of color fringing.

1 Apply DeFringe from the Lens category.

Determine the color of the fringing that you would like to remove. Let’s say that 

you have purple fringing in the highlight areas of your image.

2 If the Parameters window is not showing, click the Parameters tab at the bottom 
of the Presets window.

3 Go to the Magenta parameter group.

4 Move the Magenta slider to the right until the purple fringing is gone.

5 If the purple fringing is not being removed when the Magenta slider is adjusted, 
you may need to adjust the Position slider.

6 Change your View to Magenta to see the matte values. 

The areas that are white in the matte are the areas that will be defringed.

7 Change your View back to Output.

8 Move the Position slider to the right or left until you see the fringing go away.

This may be necessary if your purple fringing is not the same hue of what we 

consider to be magenta.

9 If there is still some magenta left, you may want to increase the value of the 
Range slider to include more values considered as magenta.

10 Click the Done icon to apply the filter to your image.

See the DeFringe filter for more information.
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Depth of Field
Depth of Field can be added to a scene by isolating and blurring only a portion 

of the image. The amount of blurring is directly proportionate to the luminance 

of the depth source.

1 Apply Depth of Field from the Lens category.

2 Try out some of the presets.

3 If the Parameters window is not showing, click the Parameters tab at the bottom 
of the Presets window.

4 Set the Depth > Depth to Matte.

5 Adjust the Blur sliders to your liking.

In some of the filters, a matte is generated to create the desired effect--in this 

case, depth of field.

6 Change your View to Depth to see the matte values. 

The areas that are white in the matte are the areas where blur will be 

introduced. The location of the blur within the scene can be adjusted by 

modifying the Matte > Position and Range parameters.

7 Change the Matte > Position parameter if you want to select different values to 
be used for the matte.

8 Increase the Matte > Range control to add more values to the matte. Decrease for 
less values.

9 Increase the Matte > Blur parameter to soften the transition areas of the matte.

10 Change your View to Output to see the filtered image.

The Depth of Field filter can also use a grad or an image as the depth source 

instead of the matte.

11 Set the Depth to Grad.

12 Adjust the Grad > Type, Corner Points, Size and Angle.

To adjust the Corner Points, just click and drag them to the desired location.

Note: On some host programs, you must highlight the effect title in the Effect Controls 
window to see the on-screen controls.
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Go to the Grad section of Common Filter Controls to see how the Grad controls 

work.

13 To use an image as the depth source:

• Change Depth > Depth to Input. 

• Click the Depth > Input > Browse button.

• Select a file.

14 Click the Done icon to apply the filter to your image.

See the Depth of Field filter for more information.
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Detail
Detail presents a new technique for performing selective sharpening, detail 

enhancement and edge aware smoothing.

1 Apply Detail from the Image category.

2 Select the Magnifier tool in the Viewer. 

When the Magnifier is selected, a portion of the image is displayed at a 1:1 pixel 

ratio in the Magnifier window and shows the actual pixels of the image with the 

Detail filter applied. The Magnifier will accurately represent what the Detail filter 

will look like when applied to the full size image.

3 Try out some of the presets.

At the top left of the Presets window, the presets are categorized into various 

groups located inside a pop-up menu.

4 In the Presets window, choose a new preset group from the pop-up menu to see 
a different set of filter presets.

5 If the Parameters window is not showing, click the Parameters tab at the bottom 
of the Presets window.

6 To sharpen or enhance detail, increase the values of the Detail > Coarse, Medium 
and Fine controls. Increasing the values sharpens/enhances detail while 
decreasing the values smooths/decreases detail.

7 Enable Detail > Gang to move all sliders at once.

If there are unwanted areas of the image that are being affected, you can 

optionally use a matte to isolate the effect.

8 Activate Matte > Enable.

9 Change your View to Matte to see the matte values.

The idea here is to generate a matte that isolates the areas of the image that 

will be affected. The white areas of the matte are the areas that will be modified 

by the Detail controls. The matte has been preset to a highlight luminance 

matte, but this can be easily changed.
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10 Select the appropriate Matte > Extract On option for your image.

11 If needed, change the Matte > Position parameter so that the image areas you are 
trying to smooth are as white as possible in the matte.

12 Adjust the Matte > Range value so that the white values of the matte are limited 
as much as possible to the image areas that you are trying to isolate.

13 Increase the Matte > Blur parameter if you want to soften the transition areas of 
the matte.

14 Change your View to Output to see the filtered image.

15 Click the Done icon to apply the filter to your image.

See the Detail filter for more information.
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Diffusion
Diffusion creates atmosphere by reducing contrast while creating a glow 

around highlights or shadows using an extensive texture library.

1 Apply Diffusion from the Diffusion category.

2 Try out some of the presets.

Each preset uses a different texture to create the diffusion effect.

3 If the Parameters window is not showing, click the Parameters tab at the bottom 
of the Presets window.

4 Adjust the Diffusion > Brightness parameter to control the amount of diffusion 
added to the image.

You can either use the texture by itself or combine it with a matte using one of 

the Texture > Blend modes. The areas that are white in the matte are the areas 

where diffusion will be introduced. 

5 Combine the texture with a matte by changing Texture > Blend from Texture Only 
to Multiply.

I like the Multiply blend mode because it only adds the texture in the areas of 

the matte.

6 Change your View to Matte to see the matte values. 

The areas that are white in the matte are the areas where diffusion will be 

introduced. The location of the diffusion within the scene can be adjusted by 

modifying the Matte > Position and Range parameters.

7 Change the Matte > Position parameter if you want to add diffusion to different 
areas of the image.

8 Adjust the Matte > Range slider to increase or decrease the image areas affected 
by the diffusion.

9 Change your View to Output to see the filtered image.

10 Adjust the position of the texture by clicking and dragging the center image point 
to the desired location.

11 You can also use the Texture > Transform controls to transform the texture.

12 Adjust the Diffusion > Brightness, Blur and Color of the diffusion to your liking.
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13 Click the Done icon to apply the filter to your image.

See the Diffusion filter for more information.
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Double Fog
The Double Fog filter creates a soft, misty atmosphere over the image by first 

applying fog using a vanishing point along the direction of increasing distance 

in the image. Then, a second pass blooms image highlights.

1 Apply Double Fog from the Diffusion category.

2 Try out some of the presets.

3 If the Parameters window is not showing, click the Parameters tab at the bottom 
of the Presets window.

4 Click on the Fog > Color parameter to set the color of the fog.

This sets the color of the fog to be added.

5 Adjust the Fog > Fog parameter to control how much overall fog is added to the 
image.

The fog is added in a radial pattern emanating from the vanishing point. For 

instance, if want your fog to move in the direction of top right to bottom left, set 

your vanishing point towards the top right corner and the fog will be more 

intense at the upper right and fall off at the bottom left. However, in most cases, 

the vanishing point can be left in the center of the screen and you will obtain 

acceptable results.

6 If needed, move the Vanishing Point to a new location by clicking and dragging 
the on-screen control in the center of the screen.

You can limit where the fog is added to your image by using the Min/Max Depth 

sliders. Min Depth controls how much fog is added in the darker areas of the 

image, while Max Depth controls how much fog is added in the brighter areas 

of the image.

7 Change the Min/Max Depth values if you want to control how fog is added in the 
shadow and highlight areas of the image.

Secondary fogging effects can be achieved using the Glow parameters. A 

portion of the screen is isolated with a matte, and based on this matte, 

additional fog and glow can be added.

8 Adjust the Glow > Brightness, Blur and Color settings to your liking.
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In some of the filters, a matte is generated to create the desired effect--in this 

case, highlight glow.

9 Change your View to Matte to see the matte values.

The areas that are white in the matte are the areas where glow will be 

introduced. For instance, If you want to put glow around bright lights, make sure 

that the light sources appear as white in the matte. The location and amount of 

the additional glow within the scene can be adjusted by modifying the Matte > 

Position and Range parameters.

10 Change the Matte > Position parameter if you want to select different luminance 
values to be used for the matte.

11 Increase the Matte > Range value to add more glow into the scene. Decrease for 
less glow.

12 Increase the Matte > Blur parameter to soften the transition areas of the matte.

13 Change your View to Output to see the filtered image.

14 To create Glow effects around highlights such as bright lights, change your Glow 
> Blend parameter to Add and make sure that your matte includes only the light 
sources.

15 Click the Done icon to apply the filter to your image.

See the Double Fog filter for more information.
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Dual Gradient
Dual Gradient applies two photographic filters to the image which are blended 

together with a gradient.

1 Apply Dual Gradient from the Grads/Tints category.

2 Try out some of the presets.

3 If the Parameters window is not showing, click the Parameters tab at the bottom 
of the Presets window.

The color gradient can be adjusted to your specific image.

4 Adjust the Grad > Direction, Corner Points and Size to position and adjust the 
grad.

To adjust the Corner Points, just click and drag them to the desired location.

Go to the Grad section of Common Filter Controls to see how the Grad controls 

work.

5 To set the Dual Gradient colors, click on the Color 1 or Color 2 > Color boxes and 
select a color.

6 If you want less coloring of the image, turn down the Color 1 or Color 2 > Opacity.

7 Image highlights can be retained by adjusting the Preserve Highlights control to 
a value of 100.

8 Change your View to Grad to see the color gradient being applied to the image.

9 Change your View back to Output to see the filtered image.

10 Click the Done icon to apply the filter to your image.

See the Dual Gradient filter for more information.
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Enhancing
Selectively enhance any color to make it pop with little to no effect on other 

colors.

1 Apply the Enhancing filter from the Color category.

2 Try out some of the presets.

At the top left of the Presets window, the presets are categorized into various 

groups located inside a pop-up menu.

3 In the Presets window, choose a new preset group from the pop-up menu to see 
a different set of filter presets.

4 If the Parameters window is not showing, click the Parameters tab at the bottom 
of the Presets window.

5 Adjust the Enhancing slider to make the red, orange and brown values pop.

In some of the filters, a matte is generated to create the desired effect--in this 

case, the enhancement effect. By default, the Matte > Hue is preset to red 

values.

6 Change your View to Matte to see the matte values. 

The areas that are white in the matte are the red, orange and brown areas of 

the image that will be enhanced. The enhancement effect within the scene can 

be adjusted by modifying the Matte > Hue and Range parameters.

7 Choose another Matte > Preset or change the Matte > Hue parameter if you want 
to add enhancement to different areas of the image.

8 Adjust the Matte > Range slider to increase or decrease the areas affected by the 
enhancement.

9 Change your View to Output to see the image.

10 Click the Done icon to apply the filter to your image.

See the Enhancing filter for more information.
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Eye Light
Creates a targeted light to be placed around a person's eyes.

1 Apply Eye Light from the Light category.

2 Adjust the position of the eye light by clicking and dragging the center image 
point to the desired location.

3 You can also use the Transform controls to transform the eye light.

4 Select either the Light > Blend > Add or Screen Blend mode. 

Add will burn out highlights while the Screen Mode will retain them.

5 Adjust the Light > Brightness to set the intensity of the light.

Note: You can darken the entire image except for the eye light shape by adjusting the 
Shadow > Brightness.

6 Use the Light > Blur sliders to control the softness of the light.

7 To apply a custom light color to the image, click on the Color box and select a 
color.

8 To apply a colored gel to the light, select one from the Gels pop-up menu.

9 Click the Done icon to apply the filter to your image.

See the Eye Light filter for more information.
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Fan Rays
Generates asymmetric fanned rays.

1 Apply Fan Rays from the Light category.

2 Try out some of the presets.

3 If the Parameters window is not showing, click the Parameters tab at the bottom 
of the Presets window.

4 Click and drag the point control to move the Fan Rays and use Scale to change 
the size.

5 Adjust the Brightness and Color.

6 Use Element Count to set the amount of rays.

7 Change Randomize and Jitter to vary the look of the rays.

8 Click the Done icon to apply the filter to your image.

See the Fan Rays filter for more information.
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Film Stocks
Film Stocks is a unique filter that simulates 294 different color and black 
and white still photographic film stocks, motion picture films stocks and 
historical photographic processes.

1 Apply Film Stocks from the Film Lab category.

2 Try out some of the presets.

At the top left of the Presets window, the film stocks are categorized into various 

groups located inside a pop-up menu.

3 In the Presets window, choose a new preset group from the pop-up menu to see 
a different set of film stock presets.

4 If the Parameters window is not showing, click the Parameters tab at the bottom 
of the Presets window.

Each preset sets a combination of the various parameters to achieve the 

desired effect, but only the parameters that are necessary. You can modify the 

existing settings including adjusting those controls that were not previously set.

5 Use the Amount slider to set the amount of the selected preset. The Amount 
mixes between the full effect of the preset and the original image.

To mimic the characteristics of a particular film stock, a combination of settings 

for the RGB channels have been set to form a film response curve.

6 Change the Film Response > RGB, R, G and B sliders. They will minimize or 
accentuate the pre-configured film response curve. 

Note: If you are using a black and white preset, the grayscale film response curve is 
adjusted using RGB.

7 Adjust any of the Black and White, Color Correct, Filter, Sharpen, Diffusion, 
Vignette or Grain settings to your liking.
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In the DFT interface, you can use Film Response > Curves to adjust the entire 

tonal range of an image by changing the shape of the curve. The Curves 

adjustment lets you adjust points throughout the tonal range of an image (from 

shadows to highlights).

8 Select RGB, Red, Green or Blue from the Curve Type pop-up menu. You can also 
click directly on an existing curve in the graph to select it.

Adding and deleting points from the curve is quick and easy.

9 Click directly on the curve to add a new point. Up to five points can be added.

10 Delete points by clicking and dragging them to the edge of the graph.

11 Move points by clicking and dragging them.

Adjust curve points to achieve a specific result.

12 Move a point in the top portion of the curve to adjust the shadows.

13 Move a point in the center of the curve to adjust the midtones.

14 Move a point in the top portion of the curve to adjust the highlights.

Adjust Black

Adjust White

Adjust Gray

Curve Type
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15 Move the curve upward or downward to lighten or darken the image. The steeper 
sections of the curve represent areas of higher contrast; flatter sections 
represent areas of lower contrast.

16 To darken highlights, move a point near the top of the curve downward. Moving 
a point either down or to the right maps the input value to a lower output value, 
and the image darkens.

17 To lighten the shadows, move a point near the bottom of the curve upward. 
Moving a point either up or to the left maps a lower input value to a higher output 
value, and the image lightens.

18 Click the Done icon to apply the filter to your image.

See the Film Stocks filter for more information.
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Flashing
Flashing allows you to use photographic filters to lower the contrast of your 

shadows or highlights. The motion picture lab can expose a small amount of 

light to the film at various stages of the developing and printing process. For 

example, Negative plus Dupe Negative flashing lifts blacks, while Print plus 

Master Positive flashing softens whites.

1 Apply Flashing from the Film Lab category.

2 Try out some of the presets.

At the top left of the Presets window, the presets are categorized into various 

groups located inside a pop-up menu.

3 In the Presets window, choose a new preset group from the pop-up menu to see 
a different set of filter presets. 

4 If the Parameters window is not showing, click the Parameters tab at the bottom 
of the Presets window.

5 Adjust the Shadows > Brightness slider to brighten shadow areas.

6 Adjust the Highlights > Brightness slider to darken highlight areas.

7 To flash the Shadows or Highlights with a custom color, click on the Shadows or 
Highlights > Color box and select a color.

8 To choose one of the preset filters, select a filter from the Shadows or Highlights 
> Presets list.

9 Once colors have been chosen, adjust the Shadows or Highlights > Brightness 
sliders to set the amount of color added to either the Shadows or Highlights.

10 Change your View to Shadows or Highlights to see the matte values. 

In some of the filters, a matte is generated to create the desired effect--in this 

case, flashing. The areas that are white in the matte are the areas that will be 

adjusted by either the Shadows or Highlights sliders. The areas defined as 

Shadows or Highlights can be adjusted by modifying the Position and Range 

parameters.

11 Use the Shadows or Highlights Position parameters if you want to select 
different values to be used for the matte.
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12 Increase the Shadows or Highlights Range controls to add more values to the 
matte. Decrease for less values.

13 Change your View to Output to see the image.

14 Click the Done icon to apply the filter to your image.

See the Flashing filter for more information.
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Flag / Dot
Flags and Dots are rectangular and circular lighting control devices used to 

create shadow areas on a motion picture or photographic set. This concept has 

been extended to digital so that areas of the image can be selectively 

darkened.

1 Apply Flag or Dot from the Light category.

2 Adjust the position of the flag or dot by clicking and dragging the center image 
point to the desired location.

3 You can also use the Transform controls to transform the flag or dot.

4 Adjust the Flag or Dot > Brightness to set the intensity.

5 Use the Flag or Dot > Blur sliders to control the softness.

6 Click the Done icon to apply the filter to your image.

See the Flag and Dot filters for more information.
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Fluorescent
Removes the green cast caused by fluorescent bulbs.

1 Apply Fluorescent from the Color category.

2 Try out some of the presets.

3 If the Parameters window is not showing, click the Parameters tab at the bottom 
of the Presets window.

4 Adjust the Temperature slider as needed.

5 Click the Done icon to apply the filter to your image.

See the Fluorescent filter for more information.
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Fog
The Fog filter creates a soft, misty atmosphere over the image and glows 

highlights.

1 Apply Fog from the Diffusion category.

2 Try out some of the presets.

3 If the Parameters window is not showing, click the Parameters tab at the bottom 
of the Presets window.

4 Adjust the Fog > Brightness, Blur and Color settings to your liking.

In some of the filters, a matte is generated to create the desired effect--in this 

case, fog.

5 Change your View to Matte to see the matte values. 

The areas that are white in the matte are the areas where fog will be introduced. 

The location of the fog within the scene can be adjusted by modifying the Matte 

> Position and Range parameters.

6 Change the Matte > Position parameter if you want to select different luminance 
values to be used for the matte.

7 Increase the Matte > Range value to add more fog into the scene. Decrease for 
less fog.

8 Change your View to Output to see the filtered image.

9 Increase the Matte > Blur parameter to soften the transition areas of the matte.

10 Click the Done icon to apply the filter to your image.

See the Fog filter for more information.
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Frost
Frost glows highlights and reduces contrast while softening facial blemishes 

and wrinkles.

Black Frost offers all the benefits of the Frost filter in a more subtle form. This 

filter subtly controls highlights, reduces contrast and provides a harder look 

than the Frost filter, while suppressing facial blemishes and wrinkles.

1 Apply Frost from the Diffusion category.

2 Select the Magnifier tool in the Viewer. 

When the Magnifier is selected, a portion of the image is displayed at a 1:1 pixel 

ratio in the Magnifier window and shows the actual pixels of the image with the 

Frost filter applied. The Magnifier will accurately represent what the Frost filter 

will look like when applied to the full size image.

3 Try out some of the presets.

At the top left of the Presets window, the presets are categorized into various 

groups located inside a pop-up menu.

4 In the Presets window, choose a new preset group from the pop-up menu to see 
a different set of filter presets.

5 If the Parameters window is not showing, click the Parameters tab at the bottom 
of the Presets window.

6 Adjust Detail > Smoothing to smooth out fine detail.

Smoothing uses an edge aware smoothing algorithm to minimize fine image 

detail so that areas with courser detail are unaffected.

7 Adjust the Mist > Brightness, Blur and Color settings to your liking.

In some of the filters, a matte is generated to create the desired effect--in this 

case, mist.

8 Change your View to Matte to see the matte values. 
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The areas that are white in the matte are the areas where mist will be 

introduced. The location of the mist within the scene can be adjusted by 

modifying the Matte > Position and Range parameters.

9 Change the Matte > Position parameter if you want to select different values to 
be used for the matte.

10 Increase the Matte > Range control to add more values to the matte. Decrease for 
less values.

11 Increase the Matte > Blur parameter to soften the transition areas of the matte.

12 Change your View to Output to see the filtered image.

13 Click the Done button to apply the filter to your image.

See the Frost filters for more information.
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Gels
Photographers, cinematographers and lighting designers use colored filters or 

gels in front of lights. We have created digital equivalents of the lighting gels 

and these same exact colors can be applied to the entire image or inside a 

gradient. In cooperation with Gamproducts and Rosco, we have created digital 

versions of their popular gels.

1 Apply Gels from the Grads/Tints category.

2 Try out some of the presets.

At the top left of the Presets window, the gels are categorized into various 

groups located inside a pop-up menu.

3 In the Presets window, choose a new presets group from the pop-up menu to see 
a different set of gel presets.

4 If the Parameters window is not showing, click the Parameters tab at the bottom 
of the Presets window.

5 Adjust the Color > Opacity, Preserve Highlights and Exposure Compensation 
sliders to your liking.

The selected gel can be applied through a gradient creating a graduated 

transition between the colored portion and the original image.

6 Click on the Grad > Enable checkbox to activate the Grad.

7 Adjust the Grad > Type, Corner Points, Size and Angle.

To adjust the Corner Points, just click and drag them to the desired location.

Go to the Grad section of Common Filter Controls to see how the Grad controls 

work.

8 Click the Done icon to apply the filter to your image.

See the Gels filter for more information.
DFT User Guide    
• 
• 
•
•
•



• 

Filter Tutorials  129 

• 
• 
• 
•
•
•

Glow
Glow creates glows around selected areas of the image based on a generated 

matte.

1 Apply Glow from the Light category.

2 Try out some of the presets.

3 If the Parameters window is not showing, click the Parameters tab at the bottom 
of the Presets window.

4 Select either the Glow > Blend > Add or Screen blend mode. 

Add will burn out highlights while the Screen Mode will retain them.

5 Adjust the Glow > Brightness, Blur and Color settings to your liking.

In some of the filters, a matte is generated to create the desired effect--in this 

case, glow.

6 Change your View to Matte to see the matte values. 

The areas that are white in the matte are the areas where glow will be 

introduced. The location of the glow within the scene can be adjusted by 

modifying the Matte > Position and Range parameters.

7 Change the Matte > Position parameter if you want to select different values to 
be used for the matte.

8 Increase the Matte > Range control to add more values to the matte. Decrease for 
less values.

9 Increase the Matte > Blur parameter to soften the transition areas of the matte.

10 Change your View to Output to see the filtered image.

11 Click the Done icon to apply the filter to your image.

See the Glow filter for more information.
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Glow Darks
Glows and grows the darks areas of the image

1 Apply Glow Darks from the Light category.

2 Try out some of the presets.

3 If the Parameters window is not showing, click the Parameters tab at the bottom 
of the Presets window.

4 Adjust the Glow > Amount and Blur settings to your liking.

In some of the filters, a matte is generated to create the desired effect--in this 

case, glowing darks.

5 Change your View to Matte to see the matte values. 

The areas that are white in the matte are the areas where glow will be 

introduced. The location of the glow within the scene can be adjusted by 

modifying the Matte > Position and Range parameters.

6 Change the Matte > Position parameter if you want to select different values to 
be used for the matte.

7 Increase the Matte > Range control to add more values to the matte. Decrease for 
less values.

8 Increase the Matte > Blur parameter to soften the transition areas of the matte.

9 Change your View to Output to see the filtered image.

10 Click the Done icon to apply the filter to your image.

See the Glow Darks filter for more information.
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Glow Edges
Glow Edges isolates lines and edges in an image and then adds glow only to 

these areas resulting in a stylized look.

1 Apply the Glow Edges filter from the Light category.

2 Try out some of the presets.

3 If the Parameters window is not showing, click the Parameters tab at the bottom 
of the Presets window.

4 Select either the Add or Screen Blend mode. Add will burn out highlights while 
the Screen mode will retain them.

5 Adjust the Glow > Brightness, Blur and Color settings to your liking.

In Glow Edges, an edge matte is generated to create the desired effect.

6 Change your View to Edge to see the matte values. 

The areas that are white in the edge matte are the areas where glow will be 

introduced.

7 Adjust the Edge > Brightness to make sure that you have sufficient white areas 
in the edge matte.

8 Set the Edge > Blur to smooth out the edge matte.

9 Change your View to Output to see the filtered image.

10 Click the Done icon to apply the filter to your image.

See the Glow Edges filter for more information.
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Grain
Grain simulates film grain with control of size, intensity and softness.

1 Apply Grain from the Film Lab category.

2 Select the Magnifier tool in the Viewer. 

When the Magnifier is selected, a portion of the image is displayed at a 1:1 pixel 

ratio in the Magnifier window and shows the actual pixels of the image with the 

Grain filter applied. The Magnifier will accurately represent what the Grain filter 

will look like when applied to the full size image.

3 Try out some of the presets.

4 If the Parameters window is not showing, click the Parameters tab at the bottom 
of the Presets window.

5 Adjust the Size parameter.

The larger the Size setting, the larger the grain will be.

6 Manipulate the Red, Green and Blue Amount parameters.

The Amount parameters set the red, green and blue intensities of the grain. 

Film stocks generally have varying amounts of red, green and blue intensities 

with the blue intensity generally higher than the rest. If you turn the red, green 

and blue amount sliders to a value of 0, the grain will disappear.

7 Change the Softness parameter.

The Softness parameter sets the softness of the grain. Normally, only minor 

softness adjustments are necessary, usually between a value of 0-1.

8 Adjust the Response Position and Response Range to control where you will see 
grain in the image. 

In most cases, film grain is apparent over the entire image except the brightest 

whites with the black areas being the most affected. A low Response Position 

value places grain in the darkest image values, while a high Response Position 
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value places grain in the brightest areas. Response Range will increase or 

decrease the area where grain is added to the image based on the value of the 

slider.

9 If you want, use Response Minimum to set the minimum level of grain that is 
always added to the image.

10 Click the Done icon to apply the filter to your image.

See the Grain filter for more information.
DFT User Guide    
• 
• 
•
•
•



• 

Filter Tutorials  134 

• 
• 
• 
•
•
•

Grunge
Adds film dirt, hair, scratches, stains, splotches, vignetting and grain--all to 

make your pristine image look like damaged film.

1 Apply Grunge from the Film Lab category.

2 Try out some of the presets.

3 If the Parameters window is not showing, click the Parameters tab at the bottom 
of the Presets window.

4 Use any combination of dirt, hair, scratches, stains, splotches, vignetting and 
grain by adjusting the respective element’s Opacity slider.

5 Change the Randomize slider and you will have a new pattern of whatever 
element you are adding.

Each grunge element can either be black or white depending on whether 

Positive or Negative is selected in the Type pop-up menu. Positive films have 

black grunge elements and negative films have white elements.

6 Choose either Positive or Negative in the Type pop-up menu for each grunge 
element.

7 Click the Done icon to apply the filter to your image.

See the Grunge filter for more information.
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Harris Shutter
The Harris Shutter filter uses separate images for the red, green and blue 

channels or offsets the individual channels of a sequence in time.

1 Apply Harris Shutter from the Special Effects category.

2 Select the source for the Red, Green and Blue channels.

If an image is not assigned using the Source parameters, the original image’s 

color channel will be used.

3 Adjust the Red, Green and Blue > Amounts to the desired level.

4 Click the Done icon to apply the filter to your image.

See the Harris Shutter filter for more information.
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Haze / Sky

Haze
Reduces excessive blue by absorbing UV light and eliminates haze which 

tends to wash out color and image clarity.

Sky
Reduces UV light, haze and is pink tinted for added warmth and better colors. 

It is especially useful for images shot in outdoor open shade and on overcast 

days.

1 Apply Haze or Sky from the Color category.

2 Try out some of the presets.

3 If the Parameters window is not showing, click the Parameters tab at the bottom 
of the Presets window.

4 Set the amount of haze to be removed from the scene using the Haze control.

5 Adjust the Temperature and Cyan/Magenta parameters to your liking. 

Note: Cyan/Magenta is only included in the Sky filter.

6 Click the Done icon to apply the filter to your image.

See the Haze and Sky filters for more information.
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High Contrast
Creates an extreme high contrast image.

1 Apply High Contrast from the Color category.

2 Try out some of the presets.

3 If the Parameters window is not showing, click the Parameters tab at the bottom 
of the Presets window.

4 Adjust the Contrast and Amount sliders until you achieve the desired amount of 
contrast.

5 Click the Done icon to apply the filter to your image.

See the High Contrast filter for more information.
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Hot Spot
Utilized in most lens flares, glow ball simulates the circular glow created when 

a light source interacts with a lens.

1 Apply Hot Spot from the Light category.

2 Try out some of the presets.

3 If the Parameters window is not showing, click the Parameters tab at the bottom 
of the Presets window.

4 Click and drag the point control to move the Hot Spot and use Total Scale to 
change the size.

5 Adjust the Brightness, Inner Color and Outer Color.

6 Change the Ring controls to vary the look of the ring.

7 Click the Done icon to apply the filter to your image.

See the Hot Spot filter for more information.
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Ice Halos
Ice halos are created when small ice crystals in the atmosphere generate halos 

by reflecting and refracting light. Most notably, circles form around the sun or 

moon as well as rare occurrences when the entire sky is painted with a web of 

arcing halos.

1 Apply Ice Halos from the Light category.

2 Try out some of the presets.

3 If the Parameters window is not showing, click the Parameters tab at the bottom 
of the Presets window.

4 You can also choose different ice halos by adjusting the Halo > Sun Altitude 
slider.

5 Choose Light > Blend > Add or Screen blend mode.

Add will burn out highlights while Screen will retain them.

6 In the Light menu, adjust the Brightness as well as the Displacement and Blur of 
the ice halo if you’d like. 

7 Adjust the position of the ice halo by clicking and dragging the center image 
point to the desired location.

8 You can also use the Halo > Scale control to transform the ice halo.

9 Combine the ice halo with a matte by changing Halo > Blend from Halo Only to 
Matte.

Matte only adds the ice halo in the areas of the matte. If you are not seeing 

enough of the ice halo, your matte should be adjusted.

10 Change your View selector to Matte to see the matte values.

The default matte settings are preset to a highlight matte. The areas that are 

white in the matte are the areas where the ice halo will be added into the image. 

The location of the ice halo within the scene can be adjusted by changing the 

Matte > Position and Range parameters.

11 Change the View selector from Matte to Output.

12 Change the Matte > Position parameter if you want to change where you see the 
ice halo.
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13 Increase the Matte > Range value to add more of the ice halo to the scene. 
Decrease to see less of the ice halo.

14 Increase the Matte > Blur parameter to soften the matte.

15 Click the Done icon to apply the filter to your image.

See the Ice Halos filter for more information.
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Infrared
Infrared simulates infrared filters used in conjunction with infrared sensitive film 

or sensors to produce very interesting black and white images with glow in 

highlight areas. 

1 Apply Infrared from the Special Effects category.

2 Try out some of the presets.

3 If the Parameters window is not showing, click the Parameters tab at the bottom 
of the Presets window.

4 Choose the type of black and white filter to be applied to your color image from 
the Black and White pop-up menu.

The type of Black and White filter that you choose can dramatically change the 

look of your image.

5 Set the Mist > Brightness and Blur to your liking.

6 If you want, you can use the Color Correct controls to modify the Brightness, 
Contrast and Gamma of the image.

In some of the filters, a matte is generated to create the desired effect--in this 

case, diffusion.

7 Change your View to Matte to see the matte values. 

The areas that are white in the matte are the areas where diffusion will be 

introduced. The location of the diffusion within the scene can be adjusted by 

modifying the Matte > Position and Range parameters.

8 Change the Matte > Position parameter if you want to select different values to 
be used for the matte.

9 Increase the Matte > Range control to add more values to the matte. Decrease for 
less values.

10 Increase the Matte > Blur parameter to soften the transition areas of the matte.

11 Change your View to Output to see the filtered image.

12 Click the Done icon to apply the filter to your image.
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See the Infrared filter for more information.
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Kelvin
Degrees Kelvin is the standard unit of measure for color temperature which is 

a way to characterize the spectral properties of a light source. Low color 

temperature implies warmer (redder) light, while high color temperature implies 

a colder (bluer) light.

1 Apply Kelvin from the Color category.

2 Try out some of the presets.

3 If the Parameters window is not showing, click the Parameters tab at the bottom 
of the Presets window.

The Color Temperature of the image is determined by the difference of the 

Destination and Source Kelvin parameters.

4 Adjust the Destination Kelvin slider.

Presets for a number of different light sources and conditions are provided in 

degrees Kelvin, the standard unit of measure for color temperature.

5 If you want less coloring of the image, turn down the Color Temperature > 
Opacity.

6 Image highlights can be retained by adjusting the Color Temperature > Preserve 
Highlights control to a value of 100.

The temperature adjustment can be applied through a gradient creating a 

graduated transition between the colored portion and the original image.

7 Click on the Grad > Enable checkbox to activate the Grad.

8 Adjust the Grad > Type, Corner Points, Size and Angle.

To adjust the Corner Points, just click and drag them to the desired location. 

Go to the Grad section of Common Filter Controls to see how the Grad controls 

work.

9 If you are curious, you can see what the Grad looks like by changing your View 
to Grad. Change your View to Output when done.
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10 Click the Done icon to apply the filter to your image.

See the Kelvin filter for more information.
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Key Light
Using Key Light, an image can be relit by with either a directional or point light.

1 Apply Key Light from the Light category.

Parallel is the default light source type and creates a directional light source.

2 Select the Magnifier tool in the Viewer. 

When the Magnifier is selected, a portion of the image is displayed at a 1:1 pixel 

ratio in the Magnifier window and shows the actual pixels of the image with the 

Key Light filter applied. The Magnifier will accurately represent what the Key 

Light filter will look like when applied to the full size image.

3 Adjust the Angle to change the direction of the light source.

4 Set the Strength slider for the desired light intensity.

5 Switch the Type to Point.

A point light is used where the light either emanates from or fades into a 

vanishing point depending on the state of the Invert control.

6 Move the point control in the center of the screen to change the Point light 
location.

7 Activate Invert and the light source will fade into a vanishing point.

8 Set the Strength slider.

9 Click the Done icon to apply the filter to your image.

See the Key Light filter for more information.
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Lens Distortion
Lens Distortion corrects for pin-cushioning and barrel distortion of camera 

lenses. It is also useful for creating the look of a wide angle lens.

1 Apply Lens Distortion from the Lens category.

2 Start by adjusting the Distortion control to straighten out any curved lines that 
should be straight.

Note: Positive Distortion parameters correct Pin-cushioning while negative values 
correct Barrel distortion.

Depending on the lens that was used, you may need to also adjust the 

Anamorphic Squeeze and Curvature X and Y parameters.

3 Click the Done icon to apply the filter to your image.

Note: Lens Distortion must be applied as the first layer (bottom of the layer stack) when 
multiple layers are used. Otherwise, all filters below will not be rendered.

See the Lens Distortion filter for more information.
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Lens Flare
Lens flares are produced by the scattering or flaring of light within a lens when 

pointed into a bright light. Although an image aberration, lens flares can be 

added for dramatic effect.

1 Apply Lens Flare from the Light category.

2 Try out some of the presets.

At the top left of the Presets window, the lens flares are categorized into various 

groups located inside a pop-up menu.

3 In the Presets window, choose a new preset group from the pop-up menu to see 
a different set of lens flare presets.

4 If the Parameters window is not showing, click the Parameters tab at the bottom 
of the Presets window.

5 Click and drag the hot spot point control to move the origin of the lens flare. This 
is the Position control.

6 Click and drag the center point control to change the end position of the lens 
flare. This is the Pivot control.

7 Adjust the Color, Brightness, Scale and Angle as desired.

If the lens flare is positioned towards the edge of the frame, you can use the 

Edge Flare controls to simulate the flaring of the light source as the flare enters 

or exists the frame.

8 Change the Edge Flare > Amount and Size and then move the lens flare towards 
the edge of the screen to see the effect.

9 Noise can be added to all elements by enabling Noise > All Elements and then 
setting the noise controls. 

Note: To selectively add noise to a single element, you would enable the Lens Noise 
parameter within the Flare Editor for the desired element. See the next tutorial.

To edit lens flare elements, open the Flare Editor.

Editing A Lens Flare
1 Click the Edit Flare button.
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The Flare Editor interface opens consisting of a Viewer, Parameters, Global, 

Flare (currently used flare elements) and Elements (all available elements). 

Note: The controls shown in the Global tab affect all elements. These are the same as 
those shown in the DFT interface prior to opening the Flare Editor.

2 Click on an element in the Flare window to select it.

The controls for the selected element are displayed in the Parameters tab.

3 Adjust the parameters to taste.

When multiple elements are selected, the controls for all selected elements are 

displayed and grouped in the Parameters window.

4 Add additional elements by either...

• Double-click an element in the Elements window and it is added to the end of the 
stack in the Flare window. If an element is selected in the Flare window prior to the 
double-click, the new element is added after the selection.

or

• Drag and drop from the Elements window to the Flare window or Viewer. Multiple 
selected elements can be dragged and dropped simultaneously.

5 To move an element to a new position in the stack, drag the element’s icon to a 
new position. Multiple elements can be moved at once.

6 To rename an element, click in the element’s text box and type to rename it.

7 To delete an element, select it and press the Delete key.

8 To delete all elements and start from scratch, press the Reset icon at the top left 
of the Viewer.

9 Click the Done icon to exit the Flare Editor.

10 Click the Done icon again to apply the filter to your image.

See the Lens Flare filter for more information.
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Levels
Levels is an image adjustment tool which can move and stretch the brightness 

levels of an image histogram. It has the power to adjust brightness, contrast, 

and tonal range by specifying the location of complete black, complete white, 

and midtones in a histogram

1 Apply Levels from the Color category.

2 To adjust the shadows and highlights, drag the black and white Input Levels 
sliders at either end of the histogram.

For example, if you move the black point slider to the right at level 23.1, 

Photoshop maps all the pixels at level 23.1 and lower to black. Similarly, if you 

move the white point slider to the left at level 89.1, Photoshop maps all pixels 

at level 89.1 and higher to white. The mapping affects the darkest and lightest 

pixels in each channel. The corresponding pixels in the other channels are 

adjusted proportionately to avoid altering the color balance.

Note: You can also enter values directly into any of the numeric input fields.
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3 To adjust midtones, use the middle Input slider to make a gamma adjustment.

Moving the middle Input slider to the left makes the overall image lighter. 

Moving the middle Input slider to the right has the opposite effect, making the 

image darker.

4 To decrease the contrast of the image, use the Output Levels.

You can view the adjusted histogram by either pressing the H key or by 

selecting View > Window > Histogram.

5 Click the Done icon to apply the levels adjustment to your image.

See the Levels filter for more information.
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Light
Light can be added to a scene where none existed before just as if you were 

adding light at the time of shooting. Realistic lighting and shadow is introduced 

using digital versions of lighting gobos.

1 Apply Light from the Light category.

2 Try out some of the presets.

At the top left of the Presets window, the gobos are categorized into various 

groups located inside a pop-up menu.

3 In the Presets window, choose a new gobo group from the pop-up menu to see 
a different set of gobo presets.

4 If the Parameters window is not showing, click the Parameters tab at the bottom 
of the Presets window.

5 Choose Light > Blend > Add, Screen or Subtract for the blend mode.

Add will burn out highlights while Screen will retain them. Subtract, on the other 

hand, will add shadow in place of light in the area of the gobo.

6 In the Light menu, adjust the Brightness, Displacement, and Blur of the light. 

Adding blur to the light makes the light glow.

7 Adjust the position of the gobo by clicking and dragging the center image point 
to the desired location.

8 You can also use the Gobo > Transform controls to transform the gobo.

9 To apply a custom light color to the image, click on the Light > Color box and 
select a color.

10 To apply a colored gel to the light, select one from the Light > Gels pop-up 
menus.

11 Combine the gobo with a matte by changing Gobo > Blend from Gobo Only to 
Multiply.

I like the Multiply blend mode because it only adds the gobo in the areas of the 

matte.

12 Change your View selector to Matte to see the matte values.
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The default matte settings are preset to a highlight matte to create the light 

effect. If you are not seeing sufficient light, your matte should be adjusted. The 

areas that are white in the matte are the areas where light will be added into the 

image. The location of the light within the scene can be adjusted by changing 

the Matte > Position and Range parameters.

13 Change the Matte > Position parameter if you want to select different values to 
be used for the light.

14 Increase the Matte > Range value to add more light into the scene. Decrease for 
less light.

15 Increase the Matte > Blur parameter to soften the transition areas of the light.

16 Change the View selector from Matte to Output.

17 The softness of the light can also be adjusted using the Light > Blur setting.

18 To use your own image as a light source:

• Select Gobo > Gobo > Browse.

• When the file browser opens, navigate to your image and select it.

19 Click the Done icon to apply the filter to your image.

See the Light filter for more information.
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Low Contrast
Low Contrast spreads highlights into darker areas, lowers contrast and keeps 

bright areas bright.

1 Apply Low Contrast from the Color category.

2 Try out some of the presets.

3 If the Parameters window is not showing, click the Parameters tab at the bottom 
of the Presets window.

4 Adjust the Contrast > Light Brightness and Contrast > Light Spread to control the 
brightness and distance of the light being spread into the shadow areas.

In some of the filters, a matte is generated to create the desired effect--in this 

case, low contrast.

5 Change your View to Matte to see the matte values. 

The areas that are white in the matte will be the image areas used to spread 

light into the shadow areas. The location of the low contrast within the scene 

can be adjusted by modifying the Matte > Position and Range parameters.

6 Change the Matte > Position parameter if you want to select different values to 
be used for the matte.

7 Increase the Matte > Range control to add more values to the matte. Decrease for 
less values.

8 Change your View to Spread to see the special matte used to create the low 
contrast effect.

The Spread matte will change as the Contrast > Light Spread slider is adjusted.

9 Move the Contrast > Light Spread slider to see how it affects the Spread matte. 
Leave it at a value of 200 when you are done.

10 Change your View to Output to see the filtered image.

11 Adjust the Contrast > Shadow Brightness if your shadows are still too dark.

12 Click the Done icon to apply the filter to your image.

See the Low Contrast filter for more information.
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Match
Matches the brightness and color from one image and applies it to another.

1 Apply the Match filter from the Color category to a target image.

2 Select the source image to be matched using the Source selector.

The color and brightness of the source image are analyzed and applied to your 

target image.

3 Adjust the Color and Brightness parameters to your liking.

4 Click the Done icon to apply the filter to your image.

See the Match filter for more information.
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Mist
Mist creates atmosphere by reducing contrast while creating a glow around 

highlights. A more subtle version of Mist, the Black Mist preset creates 

atmosphere by reducing contrast, but with minimal glow around highlights.The 

Warm Mist’s add a warming filter while Cool Mist adds a cooling filter.

1 Apply Mist from the Diffusion category.

2 Try out some of the presets.

At the top left of the Presets window, the presets are categorized into various 

groups located inside a pop-up menu.

3 In the Presets window, choose a new preset group from the pop-up menu to see 
a different set of filter presets.

4 If the Parameters window is not showing, click the Parameters tab at the bottom 
of the Presets window.

5 Adjust the Mist > Brightness, Blur and Color settings to your liking.

In some of the filters, a matte is generated to create the desired effect--in this 

case, mist.

6 Change your View to Matte to see the matte values. 

The areas that are white in the matte are the areas where glow will be 

introduced. The location of the glow within the scene can be adjusted by 

modifying the Matte > Position and Range parameters.

7 Change the Matte > Position parameter if you want to select different values to 
be used for the matte.

8 Increase the Matte > Range control to add more values to the matte. Decrease for 
less values.

9 Increase the Matte > Blur parameter to soften the transition areas of the matte.

10 Change your View to Output to see the filtered image.

11 If you applied one of the Warm or Cool Mist presets, adjust the Color Correct > 
Temperature slider to your liking.
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12 Click the Done icon to apply the filter to your image.

See the Mist filter for more information.
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Multi-Star
User definable multi-point star patterns are generated on highlights in the 

image.

1 Apply Multi-Star from the Light category.

2 Try out some of the presets.

3 If the Parameters window is not showing, click the Parameters tab at the bottom 
of the Presets window.

4 Adjust the Star > Brightness, Spokes, Size and Color settings to your liking.

In some of the filters, a matte is generated to create the desired effect--in this 

case, a star filter.

5 Change your View to Matte to see the matte values.

The matte has been preset to a highlight matte to generate the stars. Different 

luminance values can be selected with the Matte > Position parameter and the 

range of matte values can be adjusted using Matte > Range.

6 Change the Matte > Position parameter if you want to select different luminance 
values to be used for the matte.

Stars will be generated wherever there are white values in the matte.

7 Change your View to Stars to see the generated stars.

8 Increase the Matte > Range value to add more stars into the scene. Decrease for 
less stars.

9 Change your View to Output to see the filtered image.

10 Click the Done icon to apply the filter to your image.

See the Multi-Star filter for more information.
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ND Gradient
ND (Neutral Density) Gradient darkens only a portion of the image using a 

graduated transition between the darkened portion and the original image. It 

selectively adjusts brightness without affecting color balance. The most likely 

use for ND Gradient would be to balance the difference between the sky and 

ground in a landscape.

1 Apply ND Gradient from the Grads/Tints category.

2 Try out some of the presets.

3 If the Parameters window is not showing, click the Parameters tab at the bottom 
of the Presets window.

4 Adjust the Exposure slider to vary the amount of neutral density being applied 
to the image.

5 Adjust the Grad > Type, Corner Points, Size and Angle.

To adjust the Corner Points, just click and drag them to the desired location. 

Go to the Grad section of Common Filter Controls to see how the Grad controls 

work.

6 If you are curious, you can see what the Grad looks like by changing your View 
to Grad. Change your View to Output when done.

7 If you want less darkening of the image in the area of the Grad, adjust F-Stop > 
Exposure.

8 Click the Done icon to apply the filter to your image.

See the ND Gradient filter for more information.
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Net
Softens and minimizes facial imperfections while retaining image clarity. Warm 

Net adds a warming filter.

1 Apply Net from the Diffusion category.

2 Try out some of the presets.

At the top left of the Presets window, the presets are categorized into various 

groups located inside a pop-up menu.

3 In the Presets window, choose a new preset group from the pop-up menu to see 
a different set of filter presets.

4 If the Parameters window is not showing, click the Parameters tab at the bottom 
of the Presets window.

5 Adjust the Blur and Opacity parameters to your liking.

6 If using a Warm Net preset, adjust the Color Correct > Temperature control to 
your liking.

7 Click the Done icon to apply the filter to your image.

See the Net filter for more information.
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Night Vision
Night Vision creates the effect of a Night Vision lens by tinting the image green, 

blooming highlights and adding grain.

1 Apply Night Vision from the Special Effects category.

2 Select the Magnifier tool in the Viewer. 

When the Magnifier is selected, a portion of the image is displayed at a 1:1 pixel 

ratio in the Magnifier window and shows the actual pixels of the image with the 

Night Vision filter applied. The Magnifier will accurately represent what the 

Night Vision filter will look like when applied to the full size image.

3 Try out some of the presets.

At the top left of the Presets window, the presets are categorized into various 

groups located inside a pop-up menu.

4 In the Presets window, choose a new preset group from the pop-up menu to see 
a different set of filter presets.

5 If the Parameters window is not showing, click the Parameters tab at the bottom 
of the Presets window.

6 Choose the type of black and white filter to be applied to your color image from 
the Black and White pop-up menu.

The type of Black and White filter that you choose can dramatically change the 

look of your image.

7 Adjust the Glow > Brightness and Blur as well as the Grain > Size and Amount 
settings to your liking.

8 If you want, you can use the Color Correct controls to modify the color of the 
image.

In some of the filters, a matte is generated to create the desired effect--in this 

case, glow.

9 Change your View to Matte to see the matte values. 
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The areas that are white in the matte are the areas where glow will be 

introduced. The location of the glow within the scene can be adjusted by 

modifying the Matte > Position and Range parameters.

10 Change the Matte > Position parameter if you want to select different values to 
be used for the matte.

11 Increase the Matte > Range control to add more values to the matte. Decrease for 
less values.

12 Increase the Matte > Blur parameter to soften the transition areas of the matte.

13 Change your View to Output to see the filtered image.

14 Click the Done icon to apply the filter to your image.

See the Night Vision filter for more information.
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Overexpose
Overexpose simulates the overexposure that occurs when a film camera is 

stopped.

1 Apply Overexpose from the Film Lab category.

2 Try out some of the presets.

3 If the Parameters window is not showing, click the Parameters tab at the bottom 
of the Presets window.

4 Adjust the Amount, Intensity and Blur controls to achieve the desired effect.

5 Click the Done icon to apply the filter to your image.

See the Overexpose filter for more information.
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Ozone
The Ozone filter allows you to manipulate the color of an image with incredible 

flexibility and accuracy. The spectrum of image values is divided into 11 

discrete zones using proprietary image slicing algorithms. When using 

Luminance as the method for slicing up the image, the Position and Range 

sliders are preset so that each zone is twice as bright as the previous zone, 

proceeding from black towards white. The color values of each zone can then 

be independently adjusted until you’ve painted a new picture. Your adjustments 

occur on a zone by zone basis, but you view the result of all color corrections 

simultaneously.

1 Apply Ozone from the Color category.

2 Look at Zones 0-10 by setting the View to Zone and clicking on the various zones 
in the Zone menu.

Note: Once you click in the Zone selector, you can use the left and right arrow keys to 
cycle through the zones.

The selected zone is represented as a black and white image. The values 

shown as white in the selected zone are the portions of the image that will be 

modified when using the color adjustments. As the values drop-off to black, so 

does the strength of whatever adjustments you’ll make. Although the zone’s 

Position and Range parameters are preset according to the Digital Zone 

system, they can be changed if you want.

3 If you’d like, change the Position and Range parameters for the selected zone.

The Position value pinpoints the color values to be used in the selected zone. 

For instance, if the zones are created using Luminance, a high Position value 

shows the brightest image values as white values in the zone. A low Position 

value shows the darkest image values as white values in the zone. The Range 

value increases or decreases the range of values in the selected zone.

4 Make sure that the View is set to Output.

The Viewer now shows the full color image.

5 To modify your image, adjust any combination of the Hue, Saturation, 
Brightness, Contrast, Gamma, Red, Green, Blue, Temperature, and 
Cyan/Magenta sliders for each zone.
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Your adjustments occur on a zone by zone basis, but you view the result of all 

color corrections simultaneously.

6 Click the Done icon to apply the filter to your image.

See the Ozone filter for more information.
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Paint
Paints your image using Black/White, Blur, Clone, Color, Eraser, Mosaic, Red-

Eye, Repair and Scatter brushes.

Color Brush
Paints the image with the current color.

1 Apply Paint from the Image category.

When Paint is selected in the Filter window, it’s controls appear in the Toolbar.

2 Select the Color brush from the Toolbar.

3 To set the brush size, click on the Brush Size icon in the Toolbar, and drag the 
slider that appears.

or

4 Resize the brush in the Viewer by holding Ctrl(Win)/Cmd(Mac) and dragging in or 
out.

The Brush Softness and Opacity can also be adjusted by clicking their 

respective icons in the Toolbar.

5 Choose a color to paint with by clicking the Color icon and picking a color.

or
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6 Select the eyedropper icon and click on a color within the image.

7 Use your pen and tablet or mouse to paint with the Color brush.

To erase previously painted brush strokes, use the Eraser brush.

8 Pick the Eraser brush and erase any unwanted strokes.

The Eraser brush can be accessed immediately using the right-mouse button 

or the equivalent button using a pen and tablet.

Clone Brush
Paints the image using another part of the image.

1 Apply Paint from the Image category.

When Paint is selected in the Filter window, it’s controls appear in the Toolbar.

2 Select the Clone brush from the Toolbar.

3 Press and hold down the Shift key.

4 Click, drag and release to set the clone offset.

The first click sets the clone source and where you drag and release is the 

clone destination.

5 Paint with the Clone brush.

The Clone source can be nudged using the Arrow keys. One press of the Arrow 

key moves the Clone source 1 pixel. Using the Shift key in conjunction with the 

Arrow keys moves the Clone source 10 pixels. 

6 To quickly reset the clone offset, press Shift and without moving the cursor, click 
your mouse or tap your pen on the screen once.

Red-Eye Brush
Removes red-eye.

1 Apply Paint from the Image category.

When Paint is selected in the Filter window, it’s controls appear in the Toolbar.
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2 Select the Red-Eye brush from the Toolbar.

3 Use Ctrl(Win) or Cmd(Mac) and drag in or out to size the brush to roughly match 
the size of the red pupil.

4 Paint in the area of the red pupil being careful not to paint on any skin areas.

Use the Eraser brush if you mistakenly paint on any skin areas.

See the Paint filter for more information.
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Pastel
Converts the image into pastel artwork.

1 Apply Pastel from the Special Effects category.

2 Try out some of the presets.

3 If the Parameters window is not showing, click the Parameters tab at the bottom 
of the Presets window.

4 Adjust the Amount to the desired level.

5 Set the Detail. Increasing the value shows more detail while decreasing the value 
shows less detail.

6 Click the Done icon to apply the filter to your image.

See the Pastel filter for more information.
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Pencil
Pencil converts your image to a pencil sketch.

1 Apply Pencil from the Special Effects category.

2 Try out some of the presets.

3 If the Parameters window is not showing, click the Parameters tab at the bottom 
of the Presets window.

4 Vary your result by adjusting both the Amount and Color controls.

5 Click the Done icon to apply the filter to your image.

See the Pencil filter for more information.
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Photographic
The most complete line of Kodak® filters for photographic uses is available in 

the form of gelatin films and are known as Wratten® Gelatin Filters. Our 

Photographic filter is a digital equivalent of the Wratten set and were created 

using the spectral transmission curves for each optical filter. The Color 

Conversion, Light Balancing and Color Compensating preset groups are 

subsets of the Photographic filters.

1 Apply Photographic from the Grads/Tints category.

2 Try out some of the presets.

At the top left of the Presets window, the presets are categorized into various 

groups located inside a pop-up menu.

3 In the Presets window, choose a new preset group from the pop-up menu to see 
a different set of filter presets.

4 If the Parameters window is not showing, click the Parameters tab at the bottom 
of the Presets window.

5 If you want less coloring of the image, turn down the Color > Opacity.

6 Image highlights can be retained by adjusting the Filters > Preserve Highlights 
control to a value of 100.

The selected filter can be applied through a gradient creating a graduated 

transition between the colored portion and the original image.

7 Click on the Grad > Enable checkbox to activate the Grad.

8 Adjust the Grad > Type, Corner Points, Size and Angle.

To adjust the Corner Points, just click and drag them to the desired location.

Go to the Grad section of Common Filter Controls to see how the Grad controls 

work.

9 If you are curious, you can see what the Grad looks like by changing your View 
to Grad. Change your View to Output when done.
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10 Click the Done icon to apply the filter to your image.

See the Photographic filter for more information.
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Polarizer
The Polarizer creates a darkened, deep blue sky. Through the use of a matte 

and a gradient, the color of the sky can be adjusted. Warm Polarizer adds a 

warming filter.

1 Apply Polarizer or Warm Polarizer from the Color category.

2 Try out some of the presets.

At the top left of the Presets window, the presets are categorized into various 

groups located inside a pop-up menu.

3 In the Presets window, choose a new preset group from the pop-up menu to see 
a different set of filter presets.

4 If the Parameters window is not showing, click the Parameters tab at the bottom 
of the Presets window.

5 Change your View to Matte to see the matte values. 

In some of the filters, a matte is generated to create the desired effect--in this 

case, polarization.

6 Change the Matte > Hue parameter if you want to select different blue values to 
be used for the sky matte.

A matte is generated based on the blue values in the sky. Skies vary in their 

color of blue, so you can adjust the matte to accommodate your sky. The blue 

that is used to create the matte can be modified by using Matte > Hue to select 

the exact blue value and Matte > Range to select the amount of blue values to 

be used for the matte.

7 Increase the Matte > Range control to add more values to the sky matte. 
Decrease for less values.

8 Increase the Matte > Blur parameter to soften the transition areas of the matte.

Remember, the areas that are white in the matte are the areas that will be 

polarized.

9 Change your View to Output to see the filtered image.

10 Adjust the Sky color settings to make the sky look polarized--usually Brightness 
and Saturation.
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11 If the polarization is affecting areas other than they sky, enable the Grad and 
adjust it to limit the areas of polarization.

To adjust the Corner Points, just click and drag them to the desired location. 

Go to the Grad section of Common Filter Controls to see how the Grad controls 

work.

12 If you applied Warm Polarizer, adjust the Warming > Color and Opacity sliders to 
your liking.

13 Click the Done icon to apply the filter to your image.

See the Polarizer filter for more information.
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Rack Focus
Rack Focus replicates a true camera defocus by introducing lens Bokeh 

effects. Bokeh is the Japanese term that describes the quality of out-of-focus 

points of light. In defocused areas, each point of light becomes a shape--either 

a circle or a polygon. The shape grows in size as the amount of defocusing is 

increased.

1 Apply Rack Focus from the Lens category.

2 Try out some of the presets.

3 If the Parameters window is not showing, click the Parameters tab at the bottom 
of the Presets window.

4 Adjust the Blur to your liking.

5 Set the Aperture > Brightness and Color settings.

6 Change the Aperture > Facets to control the polygon’s shape and use Angle to 
rotate the Bokeh.

7 Set the Aperture > Curvature to 100 if you prefer the Bokeh to be circular in 
shape.

In some of the filters, a matte is generated to create the desired effect--in this 

case, Bokeh effects.

8 Set your View to Matte to see the matte values. 

The matte has been preset to a highlight matte to generate the Bokeh effect. 

The areas that are white in the matte are the areas where Bokeh will be 

introduced. The location of the Bokeh within the scene can be adjusted by 

modifying the Matte > Position and Range controls.

9 Change the Matte > Position parameter if you want to select different luminance 
values to be used for the matte.

Bokeh will be generated wherever there are white values in the matte.

10 Change your View to Aperture to see the Bokeh.

11 Increase the Matte > Range value to add more Bokeh into the scene. Decrease 
for less Bokeh.

12 Change your View to Output to see the filtered image.
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13 Click the Done icon to apply the filter to your image.

See the Rack Focus filter for more information.
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Radial Exposure
Lightens and/or darkens the center or edges of an image to correct lens 

vignetting.

1 Apply Radial Exposure from the Lens category.

2 Adjust the Exposure > Edges or Center parameters.

The radial gradient used to lighten or darken the edges or center of the image 

can be adjusted to suit your image.

3 Adjust the Spot > Position, Radius, Falloff Radius and Falloff.

4 If you are curious, you can see what the Spot looks like by changing your View 
to Spot. Change your View to Output when done.

5 Click the Done icon to apply the filter to your image.

See the Radial Exposure filter for more information.
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Radial Streaks
Short radial streaks emanating from the center point.

1 Apply Radial Streaks from the Light category.

2 Try out some of the presets.

3 If the Parameters window is not showing, click the Parameters tab at the bottom 
of the Presets window.

4 Click and drag the point control to move the Radial Streaks and use Scale to 
change the size.

5 Adjust the Brightness and Color.

6 Use Element Count to set the amount of rays.

7 Change Randomize to vary the look of the rays.

8 Click the Done icon to apply the filter to your image.

See the Radial Streaks filter for more information.
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Radial Tint
Tints the image using multi-color, radially graduated filters.

1 Apply Radial Tint from the Grads/Tints category.

2 Try out some of the presets.

3 If the Parameters window is not showing, click the Parameters tab at the bottom 
of the Presets window.

4 Adjust the Radial Grad > Position, Size, Rotation and Aspect.

5 To set your own radial gradient colors, click on the Color 1, 2, 3 or 4 > Color 
boxes and select colors.

Color 1 is the top left quadrant of the image, Color 2 is the top right quadrant, 

Color 3 is the bottom right quadrant and Color 4 is the bottom left quadrant.

6 If you want less coloring of the image, turn down Color 1, Color 2, Color 3 or 
Color 4 > Opacity.

7 Image highlights can be retained by adjusting the Preserve Highlights control to 
a value of 100.

8 Change your View to Gradient to see the color gradient being applied to the 
image.

9 Change your View back to Output to see the filtered image.

You can also mask out a portion of the Radial Tint effect using a Spot mask.

10 To use a Spot mask with the Radial Tint, click on Spot > Enable.

11 Set the Spot > Radius, Falloff Radius and Falloff.

12 Click the Done icon to apply the filter to your image.

See the Radial Tint filter for more information.
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Rainbow
Recreates arced rainbows of spectral colors, usually identified as red, orange, 

yellow, green, blue, indigo, and violet, that appear in the sky as a result of the 

refractive dispersion of sunlight in drops of rain or mist.

1 Apply Rainbow from the Light category.

2 Choose Light > Blend > Add, Screen or Normal blend mode.

Add will burn out highlights while Screen will retain them. Normal uses a normal 

composite function to add the rainbow.

3 In the Light menu, adjust the Brightness, and if you’d like, set the Displacement 
and Blur of the rainbow.

4 Set the base of the rainbow using Crop > Offset, Angle and Softness.

5 Adjust the position of the rainbow by clicking and dragging the center image 
point to the desired location.

6 Set the Rainbow > Radius, Aspect, and Thickness as desired.

7 Combine the rainbow with a matte by changing Rainbow > Blend from Rainbow 
Only to Matte.

Matte only adds the rainbow in the areas of the matte. If you are not seeing 

enough of the rainbow, your matte should be adjusted.

8 Change your View selector to Matte to see the matte values.

The default matte settings are preset to a highlight matte. The areas that are 

white in the matte are the areas where the rainbow will be added into the image. 

The location of the rainbow within the scene can be adjusted by changing the 

Matte > Position and Range parameters.

9 Change the View selector from Matte to Output.

10 Change the Matte > Position parameter if you want to change where you see the 
rainbow.

11 Increase the Matte > Range value to add more of the rainbow to the scene. 
Decrease to see less of the rainbow.

12 Increase the Matte > Blur parameter to soften the matte.
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13 Click the Done icon to apply the filter to your image.

See the Rainbow filter for more information.
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Random Spikes
Generates asymmetric radial rays.

1 Apply Random Spikes from the Light category.

2 Try out some of the presets.

3 If the Parameters window is not showing, click the Parameters tab at the bottom 
of the Presets window.

4 Click and drag the point control to move the Random Spikes and use Scale to 
change the size.

5 Adjust the Brightness and Color.

6 Use Element Count to set the amount of rays.

7 Change Randomize to vary the look of the rays.

8 Click the Done icon to apply the filter to your image.

See the Random Spikes filter for more information.
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Rays
Create stunning and realistic light ray effects quickly and easily.

1 Apply Rays from the Light category.

2 Move the point control in the center of the screen to change the source point 
from which the rays will emanate.

3 Adjust the Rays > Length, Brightness, Color and Blur as desired.

4 To limit the amount of rays, increase the Rays > Threshold parameter.

Threshold controls the amount of rays based on a brightness threshold. Fewer 

rays with more definition are generated at higher threshold values.

5 Use the Shimmer > Amount and Phase to randomize the rays.

If you are working with an image that lacks prominent highlight areas, you can 

use the Light Source parameters to generate rays.

6 Adjust Light Source > Brightness and Size to add an additional light source to 
create rays.

7 Set the Texture controls to breakup the rays with a noise pattern.

8 Click the Done icon to apply the filter to your image.

See the Rays filter for more information.
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Reflector
Silver and gold reflectors allow you to add white or gold light into shadow areas.

1 Apply Reflector from the Light category.

2 Try out some of the presets.

At the top left of the Presets window, the presets are categorized into various 

groups located inside a pop-up menu.

3 In the Presets window, choose a new preset group from the pop-up menu to see 
a different set of filter presets.

4 If the Parameters window is not showing, click the Parameters tab at the bottom 
of the Presets window.

5 Adjust the Brightness and Color settings to your liking.

In some of the filters, a matte is generated to create the desired effect--in this 

case, light reflecting into the shadow areas.

6 Change your View to Matte to see the matte values. 

The areas that are white in the matte are the areas where light will be 

introduced. The location of the light within the scene can be adjusted by 

modifying the Position and Range parameters.

7 Change the Position parameter if you want to select different values to be used 
for the matte.

8 Increase the Range controls to add more values to the matte. Decrease for less 
values.

9 Change your View to Output to see the filtered image.

10 Click the Done icon to apply the filter to your image.

See the Reflector filter for more information.
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ReLight
Light can be added to a scene where none existed before. A complete set of 

light source controls allow you to adjust the light just as you would at the time 

of shooting.

1 Apply Relight from the Light category.

2 Using the Light Source > Transform controls, you can transform the light source.

To adjust the light source position, drag the point control in the center of the 

Viewer and to adjust the Corner Points, just click and drag to the desired 

location. 

3 In the Light menu, adjust the Brightness, Displacement, and Blur of the light. 

Adding blur to the light makes the light glow.

4 To apply a custom light color to the image, click on the Light > Color box and 
select a color.

5 To choose one of the Gels, select one from the Light > Gels pop-up menu.

6 Combine the light source with a matte by changing Shape > Blend from Shape 
Only to Multiply.

I like the Multiply blend mode because it only adds the light source in the areas 

of the matte.

7 Change your View selector to Matte to see the matte values. 

The default Matte settings are preset to a highlight matte to create the light 

effect. If you are not seeing sufficient light, your matte should be adjusted. The 

areas that are white in the matte are the areas where light will be added into the 

image. The location of the light within the scene can be adjusted by changing 

the Matte > Position and Range parameters.

8 Change the Matte > Position parameter if you want to select different values to 
be used for the matte.

9 Increase the Matte > Range control to add more values to the matte. Decrease for 
less values.

10 Change the View selector from Matte to Output.

11 Increase the Matte > Blur parameter to soften the transition areas of the matte.
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12 Click the Done icon to apply the filter to your image.

See the ReLight filter for more information.
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Selective Color Correct
Colors can be selectively isolated through the use of a matte and adjusted 

using hue, saturation, brightness, gamma, contrast, temperature, 

cyan/magenta, red, green, and blue controls.

1 Apply Selective Color Correct from the Color category.

2 Change your View to Matte to see the matte values. 

In some of the filters, a matte is generated to create the desired effect--in this 

case, selective color correction.

3 Adjust the matte controls so that the areas that you want to color correct are 
white in the matte.

Go to the Matte parameters to see how they work.

4 Change your View to Output to see the image.

5 Adjust the color correct parameters to your liking.

6 Click the Done icon to apply the filter to your image.

See the Selective Color Correct filter for more information.
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Selective Saturation
The saturation of the image can be adjusted independently in the shadows, 

midtones and highlights.

1 Apply Selective Saturation from the Color category.

2 Try out some of the presets.

3 If the Parameters window is not showing, click the Parameters tab at the bottom 
of the Presets window.

4 Adjust the Saturation in the Shadows, Midtones or Highlights.

In some of the filters, a matte is generated to create the desired effect--in this 

case, selective saturation. Shadow, midtone and highlight mattes have been 

preset for you to adjust the saturation selectively in those areas.

5 Change your View to Shadows, Midtones or Highlights to see the matte values. 

The areas that are white in the matte are the areas that will be adjusted by the 

Saturation sliders. The areas defined as shadows, midtones or highlights can 

be adjusted by modifying the Position and Range parameters.

6 Use the Shadows, Midtones or Highlights Position parameters if you want to 
select different values to be used for the matte.

7 Increase the Shadows, Midtones or Highlights Range controls to add more 
values to the matte. Decrease for less values.

8 Change your View to Output to see the image.

9 Click the Done icon to apply the filter to your image.

See the Selective Saturation filter for more information.
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Sepia
Sepia creates a warm brown tone for a nostalgic feeling.

1 Apply Sepia from the Grads/Tints category.

2 Try out some of the presets.

3 If the Parameters window is not showing, click the Parameters tab at the bottom 
of the Presets window.

4 Adjust the Color > Amount, Opacity, Preserve Highlights and Exposure 
Compensation sliders to your liking.

Sepia can be applied through a gradient creating a graduated transition 

between the colored portion and the original image.

5 Click on the Grad > Enable checkbox to activate the Grad.

6 Adjust the Grad > Type, Corner Points, Size and Angle.

To adjust the Corner Points, just click and drag them to the desired location. 

Go to the Grad section of Common Filter Controls to see how the Grad controls 

work.

7 Click the Done icon to apply the filter to your image.

See the Sepia filters for more information.
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Shadows/Highlights
Shadows/Highlights lowers contrast evenly throughout the image by 

brightening shadow areas and darkening highlights. It is useful for correcting 

dark foreground subjects due to strong backlighting as well as highlights that 

are slightly washed out.

1 Apply Shadows/Highlights from the Color category.

2 Try out some of the presets.

3 If the Parameters window is not showing, click the Parameters tab at the bottom 
of the Presets window.

4 Adjust the Shadows > Shadows slider to brighten shadow areas.

5 Adjust the Highlights > Highlights slider to darken highlight areas.

In some of the filters, a matte is generated to create the desired effect--in this 

case, lowering contrast. 

6 Change your View to Shadows or Highlights to see the matte values. 

The areas that are white in the matte are the areas that will be adjusted by 

either the Shadows or Highlights sliders. The areas defined as Shadows or 

Highlights can be adjusted by modifying the Position and Range parameters.

7 Use the Shadows or Highlights > Position parameters if you want to select 
different values to be used for the matte.

8 Increase the Shadows or Highlights > Range controls to add more values to the 
matte. Decrease for less values.

9 Change your View to Output to see the image.

10 Click the Done icon to apply the filter to your image.

See the Shadows/Highlights filter for more information.
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Sharpen
Enhances the sharpness or focus by selectively increasing the contrast 

between adjacent pixels along edges in an image.

1 Apply Sharpen from the Image category.

2 Select the Magnifier tool in the Viewer. 

When the Magnifier is selected, a portion of the image is displayed at a 1:1 pixel 

ratio in the Magnifier window and shows the actual pixels of the image with the 

Sharpen filter applied. The Magnifier will accurately represent what the 

Sharpen filter will look like when applied to the full size image.

3 Try out some of the presets.

4 If the Parameters window is not showing, click the Parameters tab at the bottom 
of the Presets window.

Note: If you are applying multiple filters, it is best to apply the Sharpen filter first.

5 Adjust the Radius to determine the size of the edges you wish to sharpen.

6 Drag the Amount slider to control how much contrast is added at the edges.

The Threshold control determines how different the sharpened pixels must be 

from surrounding areas before they are considered edge pixels and sharpened.

7 Move the Threshold slider if necessary.

Low values sharpen more image areas while higher threshold values sharpen 

less.

See the Sharpen filter for more information.
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Silk
Black Silk softens wrinkles, blemishes and fine detail to produce smooth skin 

textures while retaining detail in coarse features such as the eyes, nose and 

mouth. Warm Silk offers all the benefits of the Black Silk filter while adding a 

diffuse warm tint to the shadows.

1 Apply Silk from the Diffusion category.

2 Select the Magnifier tool in the Viewer. 

When the Magnifier is selected, a portion of the image is displayed at a 1:1 pixel 

ratio in the Magnifier window and shows the actual pixels of the image with the 

Silk filter applied. The Magnifier will accurately represent what the Silk filter will 

look like when applied to the full size image.

3 Try out some of the presets.

At the top left of the Presets window, the presets are categorized into various 

groups located inside a pop-up menu.

4 In the Presets window, choose a new preset group from the pop-up menu to see 
a different set of filter presets.

5 If the Parameters window is not showing, click the Parameters tab at the bottom 
of the Presets window.

6 Adjust Detail > Smoothing to smooth out fine detail.

Smoothing uses an edge aware smoothing algorithm to minimize fine image 

detail so that areas with courser detail are unaffected. However, if there are 

unwanted areas of the image that are being affected, you can optionally use a 

matte to isolate the effect.

7 Activate Matte > Enable.

8 Change your View to Matte to see the matte values.
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The idea here is to generate a matte that isolates the areas of the image that 

need to be smoothed. For instance, you might be trying to isolate and smooth 

the skin on a person’s face. The white areas of the matte are the areas that will 

be smoothed. The matte has been preset to a highlight luminance matte, but 

this can be easily changed.

9 Select the appropriate Matte > Extract On option for your image.

10 If needed, change the Matte > Position parameter so that the image areas you are 
trying to smooth are as white as possible in the matte.

11 Adjust the Matte > Range value so that the white values of the matte are limited 
as much as possible to the image areas that you are trying to isolate.

12 Increase the Matte > Blur parameter if you want to soften the transition areas of 
the matte.

13 Change your View to Output to see the filtered image.

14 If using a Warm Silk preset, adjust the Color Correct > Temperature control to 
your liking.

15 Click the Done icon to apply the filter to your image.

See the Silk filter for more information.
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Skin Tone
A set of colorization filters to enhance skin tones.

1 Apply Skin Tone from the Grads/Tints category.

2 Try out some of the presets.

3 If the Parameters window is not showing, click the Parameters tab at the bottom 
of the Presets window.

4 Adjust the Color > Opacity, Preserve Highlights and Exposure Compensation 
sliders to your liking.

The selected color can be applied through a gradient creating a graduated 

transition between the colored portion and the original image.

5 Click on the Grad > Enable checkbox to activate the Grad.

6 Adjust the Grad > Type, Corner Points, Size and Angle.

To adjust the Corner Points, just click and drag them to the desired location. 

Go to the Grad section of Common Filter Controls to see how the Grad controls 

work.

7 Click the Done icon to apply the filter to your image.

See the Skin Tone filter for more information.
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Soft Light
Provides soft, digitally diffused and virtually shadowless light.

1 Apply Soft Light from the Light category.

2 Try out some of the presets.

3 If the Parameters window is not showing, click the Parameters tab at the bottom 
of the Presets window.

4 Select either the Blend > Add or Screen Blend mode. 

Add will burn out highlights while the Screen Mode will retain them.

5 Adjust the Brightness to set the intensity of the light. 

6 Use the Blur sliders to control the softness of the light.

7 To apply a custom light color to the image, click on the Color box and select a 
color.

8 To apply a colored gel to the light, select one from the Gels pop-up menu.

9 Click the Done icon to apply the filter to your image.

See the Soft Light filter for more information.
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Spikes
Long radial rays emanating from the center point.

1 Apply Spikes from the Light category.

2 Try out some of the presets.

3 If the Parameters window is not showing, click the Parameters tab at the bottom 
of the Presets window.

4 Click and drag the point control to move the Spikes and use Scale to change the 
size.

5 Adjust the Brightness and Color.

6 Use Element Count to set the amount of rays.

7 Change Randomize to vary the look of the rays.

8 Click the Done icon to apply the filter to your image.

See the Spikes filter for more information.
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Spiral Rays
Creates spiral rays.

1 Apply Spiral Rays from the Light category.

2 Try out some of the presets.

3 If the Parameters window is not showing, click the Parameters tab at the bottom 
of the Presets window.

4 Click and drag the point control to move the Spiral Rays and use Scale to change 
the size.

5 Adjust the Brightness and Color.

6 Use Element Count to set the amount of rays.

7 Change Randomize to vary the look of the rays.

8 Click the Done icon to apply the filter to your image.

See the Spiral Rays filter for more information.
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Split Field
Split Field splits the image with a line that can be positioned, rotated and 

blurred. On one side of the line, the image is blurred and on the other, it is in 

focus.

1 Apply Split Field from the Lens category.

2 Try out some of the presets.

3 If the Parameters window is not showing, click the Parameters tab at the bottom 
of the Presets window.

4 Adjust the Blur controls.

5 Position, Rotate and Blur the split line using the Split controls.

6 Click the Done icon to apply the filter to your image.

See the Split Field filter for more information.
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Split Tone
Shadows, midtones and highlights can be individually tinted with the Split tone 

filter.

1 Apply Split Tone from the Grads/Tints category.

2 Turn up the Opacity slider in the Shadows, Midtones or Highlights.

3 Change the Split Tone colors by clicking on the Color boxes.

In some of the filters, a matte is generated to create the desired effect--in this 

case, split toning.

4 Change your View to Shadows, Midtones or Highlights to see the matte values. 

The areas that are white in the matte are the areas that will be tinted by the 

selected tint color. The areas defined as Shadows, Midtones or Highlights can 

be adjusted by modifying the Position and Range parameters.

5 Adjust the Shadows, Midtones or Highlights > Position and Range controls to 
change what is considered to be Shadows, Midtones or Highlights.

6 Change your View to Output to see the image.

7 Click the Done icon to apply the filter to your image.

See the Split Tone filter for more information.
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Star
A star pattern similar to those created by lens flares.

1 Apply Star from the Light category.

2 Try out some of the presets.

3 If the Parameters window is not showing, click the Parameters tab at the bottom 
of the Presets window.

4 Click and drag the point control to move the Star and use Scale to change the 
size.

5 Adjust the Brightness and Color.

6 Use Element Count to set the amount of spikes.

7 Create a more organic random star with Noise and Noise Density.

8 Change Randomize to vary the brightness within the star.

9 Click the Done icon to apply the filter to your image.

See the Star filter for more information.
DFT User Guide    
• 
• 
•
•
•



• 

Filter Tutorials  200 

• 
• 
• 
•
•
•

Streaks
The Streaks filter creates horizontal or vertical streaks around highlights in the 

image.

1 Apply Streaks from the Light category.

2 Try out some of the presets.

At the top left of the Presets window, the presets are categorized into various 

groups located inside a pop-up menu.

3 In the Presets window, choose a new preset group from the pop-up menu to see 
a different set of filter presets.

4 If the Parameters window is not showing, click the Parameters tab at the bottom 
of the Presets window.

5 Adjust either the Vertical or Horizontal Streaks controls.

Note: If you adjust both the Vertical and Horizontal Streak controls at the same time, 
the Streak effect will be lost.

6 Select either the Add or Screen Blend mode. Add will burn out highlights while 
the Screen mode will retain them.

7 Adjust the Streak > Brightness and Color settings to your liking.

In some of the filters, a matte is generated to create the desired effect--in this 

case, streaks.

8 Change your View to Matte to see the matte values.

The areas that are white in the matte are the areas where streaks will be 

introduced. The location of the streaks within the scene can be adjusted by 

modifying the Matte > Position and Range parameters.

9 Change the Matte > Position parameter if you want to select different values to 
be used for the matte.

10 Increase the Matte > Range control to add more values to the matte. Decrease for 
less values.

11 Change your View to Output to see the filtered image.
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12 Click the Done icon to apply the filter to your image.

See the Streaks filter for more information.
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Sunset
Sunset applies three photographic filters to the image which are blended 

together with a gradient.

1 Apply Sunset from the Grads/Tints category.

2 Try out some of the presets.

3 If the Parameters window is not showing, click the Parameters tab at the bottom 
of the Presets window.

4 Adjust the Grad > Type, Corner Points, Size and Angle.

To adjust the Corner Points, just click and drag them to the desired location. 

Go to the Grad section of Common Filter Controls to see how the Grad controls 

work.

5 To change the Sunset colors, click on the Color 1, 2 or 3 > Color box and select 
a color.

6 If you want less coloring of the image, turn down Color 1, Color 2 or Color 3 > 
Opacity.

7 Image highlights can be retained by adjusting the Preserve Highlights control to 
a value of 100.

8 Change your View to Grad to see the color gradient being applied to the image.

9 Change your View back to Output to see the filtered image.

10 Click the Done icon to apply the filter to your image.

See the Sunset filter for more information.
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Texture
Applies textures to an image for a stylized look.

1 Apply Texture from the Special Effects category.

2 Try out some of the presets.

3 If the Parameters window is not showing, click the Parameters tab at the bottom 
of the Presets window.

4 Adjust the Amount slider to control how much texture is applied to the image.

5 Increase the Complexity to generate a more detailed, repetitive texture.

6 Use Randomize to change the look of the texture.

7 Adjust the position of the texture by clicking and dragging the center image point 
to the desired location.

8 You can also use the Transform controls to transform the texture.

9 Click the Done icon to apply the filter to your image.

See the Texture filter for more information.
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Three Strip / Two Strip

Three Strip
Known and celebrated for it ultra-realistic, saturated levels of color, the 

Technicolor® Three Strip process was commonly used for musicals, costume 

pictures and animated films. It was created by photographing three black and 

white strips of film each passing through red, green and blue filters on the 

camera lens and then recombining them in the printing process. Our Three 

Strip filter was created under the direction of Academy Award Winning Visual 

Effects Supervisor Rob Legato.

Two Strip
The Technicolor® Two Strip process was the first stab at producing color 

motion pictures and consisted of simultaneously photographing two black and 

white images using red and green filters. This look creates an odd but pleasing 

hand-painted look where faces appear normal and green takes on a blue-green 

quality, while the sky and all things blue appear cyan. Our Two Strip filter was 

created under the direction of Academy Award Winning Visual Effects 

Supervisor Rob Legato.

1 Apply Three Strip or Two Strip from the Film Lab category.

2 Try out some of the presets.

3 If the Parameters window is not showing, click the Parameters tab at the bottom 
of the Presets window.

4 Change your View to Red, Green or Blue to see the matte values.

In some of the filters, a matte is generated to create the desired effect--in this 

case, modifying the intensity of the red, green and blue values.

Normally, the areas that are white in the matte are the areas that will be 

adjusted by a particular filter or control. The Red, Green and Blue Intensities, 

on the other hand, make adjustments where you see black in the matte.

5 Adjust the Intensity of whatever color channel you are viewing and you will see 
that certain values become darker. These are the values that will be intensified in 
the color image.
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6 Change your View to Output to see the color image.

7 Adjust the Red, Green and Blue Intensities until you have the desired levels of 
red, green and blue in the image. 

Note: When using the Two Strip filter, adjusting the Blue Intensity will darken image 
areas that were blue in the source image.

8 You may need to use the Red, Green and Blue Smooth controls to smooth out 
any noise that may have appeared if the intensities were turned up to high 
values. 

The Smooth controls are set to a low value by default.

9 Set the Opacity to a lower level if the strength of the effect looks too strong.

Color Correct controls are also provided for additional control.

10 Click the Done icon to apply the filter to your image.

See the Three Strip / Two Strip filters for more information.
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Tint
Tints the entire image with a selected color using a variety of colorization 

modes.

1 Apply Tint from the Grads/Tints category.

2 Try out some of the presets.

At the top left of the Presets window, the tints are categorized into various 

groups located inside a pop-up menu.

3 In the Presets window, choose a new preset group from the pop-up menu to see 
a different set of tint presets.

4 If the Parameters window is not showing, click the Parameters tab at the bottom 
of the Presets window.

5 To apply a different color to the image, click on the Tint > Color box and select a 
new color.

6 Try out the different colorization methods in the Color > Color Mode pop-up 
menu.

7 If you want less tinting of the image, turn down the Tint > Opacity.

If you want, the image can be converted to black and white before the tint is 

applied.

8 From the Black and White > Filter pop-up menu, select the type of black and 
white filter to be applied to your color image.

Your choice of filter can dramatically change the black and white result.

Use the Brightness, Contrast and Gamma controls to further adjust the image.

You can also use a gradient in combination with the Tint.

9 To use a gradient with the Tint, click on Grad > Enable.

10 Adjust the Grad > Type, Corner Points, Size and Angle.

To adjust the Corner Points, just click and drag them to the desired location.

Go to the Grad section of Common Filter Controls to see how the Grad controls 

work.
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11 If you are curious, you can see what the Grad looks like by changing your View 
to Grad. Change your View to Output when done.

12 Click the Done icon to apply the filter to your image.

See the Tint filter for more information.
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Tone Adjust
Tone Adjust approximates the appearance of high dynamic range images by 

adjusting the tonal values. Specifically, detail is recovered from the darker 

portions of the images and can optionally be denoised.

1 Apply Tone Adjust from the Color category.

2 Try out some of the presets.

3 If the Parameters window is not showing, click the Parameters tab at the bottom 
of the Presets window.

4 Adjust the Amount slider to brighten shadow areas.

5 If image noise becomes more prominent as a result of the Amount adjustment, 
use the DeNoise slider to minimize the noise in those areas.

In some of the filters, a matte is generated to create the desired effect--in this 

case, brightening shadow areas. 

6 Change your View to Matte to see the matte values. 

The areas that are white in the matte are the areas that will be adjusted. The 

shadow areas to be brightened can be adjusted by modifying the Position and 

Range parameters.

7 Use the Position parameter if you want to select different values to be used for 
the matte.

8 Increase the Range control to add more values to the matte. Decrease for less 
values.

9 Change your View to Output to see the image.

10 Click the Done icon to apply the filter to your image.

See the Tone Adjust filter for more information.
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Vignette
A vignette, or soft fade, is a popular photographic effect where the photo 

gradually fades into the background, usually in a circular or rectangular shape. 

The vignette can be any color as well as thrown out of focus.

1 Apply Vignette from the Lens category.

2 Try out some of the presets.

3 If the Parameters window is not showing, click the Parameters tab at the bottom 
of the Presets window.

4 Adjust the Shape > Roundness to make the vignette either circular or rectangular 
and use Shape > Softness to control the softness of the vignette’s edge.

5 To give the vignette’s edge a random shape, use the Distortion, Distortion Size 
and Randomize controls.

6 Set the Vignette > Color and Opacity.

The vignette can be either colored or defocused or a combination of the two.

7 Turn down the Vignette > Opacity if you would like to see only a blurred vignette.

8 Turn up the Vignette > Horizontal and Vertical Blur to your liking.

9 Click the Done icon to apply the filter to your image.

See the Vignette filter for more information.
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Water Droplets
Simulates the circular, rainbow colored optical effects produced by tiny water 

droplets in clouds, mist and fog.

1 Apply Water Droplets from the Light category.

2 Try out some of the presets.

3 If the Parameters window is not showing, click the Parameters tab at the bottom 
of the Presets window.

4 Choose Light > Blend > Add or Screen blend mode.

Add will burn out highlights while Screen will retain them.

5 In the Light menu, adjust the Brightness as well as the Displacement and Blur of 
the rainbow if you’d like. 

6 Adjust the position of the rainbow by clicking and dragging the center image 
point to the desired location.

7 You can also use the Rainbow > Scale control to transform the rainbow.

8 Combine the rainbow with a matte by changing Rainbow > Blend from Rainbow 
Only to Matte.

Matte only adds the rainbow in the areas of the matte. If you are not seeing 

enough of the rainbow, your matte should be adjusted.

9 Change your View selector to Matte to see the matte values.

The default matte settings are preset to a highlight matte. The areas that are 

white in the matte are the areas where the rainbow will be added into the image. 

The location of the rainbow within the scene can be adjusted by changing the 

Matte > Position and Range parameters.

10 Change the View selector from Matte to Output.

11 Change the Matte > Position parameter if you want to change where you see the 
rainbow.

12 Increase the Matte > Range value to add more of the rainbow to the scene. 
Decrease to see less of the rainbow.

13 Increase the Matte > Blur parameter to soften the matte.
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14 Click the Done icon to apply the filter to your image.

See the Water Droplets filter for more information.
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Wide Angle Lens
Simulates the effect of a wide angle lens.

1 Apply Wide Angle Lens from the Lens category.

2 Start by adjusting the Distortion control to add the desired wide angle look.

You may need to also adjust the X and Y Correction parameters which 

compensate for the deformation introduced with the Distortion parameter.

3 Click the Done icon to apply the filter to your image.

Note: Wide Angle Lens must be applied as the first layer (bottom of the layer stack) 
when multiple layers are used. Otherwise, all filters below will not be rendered.

See the Wide Angle Lens filter for more information.
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X-Ray
Simulates the look of X-Ray images.

1 Apply X-Ray from the Special Effects category.

2 Try out some of the presets.

3 If the Parameters window is not showing, click the Parameters tab at the bottom 
of the Presets window.

4 From the Black and White > Filter pop-up menu, select the type of black and 
white filter to be applied to your color image.

Your choice of filter can dramatically change the black and white result.

5 Use the Brightness, Contrast and Gamma controls to further adjust the image.

6 Adjust the Color if you would like to tint the image to something other than blue.

7 Click the Done icon to apply the filter to your image.

See the X-Ray filter for more information.
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 DFT USER INTERFACE

DFT is comprised of 4 main components: Viewer, Filters, Presets/Parameters, 

and Effect. 

Effect

Viewer

Filters

Presets & Parameters
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Viewer
The Viewer is where images are viewed, edited and manipulated.

Filters
The Filters window at the bottom of the screen is categorized by filter function 

and displays a thumbnail for each filter.
DFT User Guide    
• 
• 
•
•
•



• 

DFT User Interface  216 

• 
• 
• 
•
•
•

Presets and Parameters
Presets and Parameters share the same window space on the right side of the 

screen.

Presets
The Presets window allows you to select from existing filter presets.
DFT User Guide    
• 
• 
•
•
•



• 

DFT User Interface  217 

• 
• 
• 
•
•
•

Parameters
The Parameters window displays the current filter’s parameters. Adjusting the 

parameters will update and change the image in the Viewer.
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Variations
The Variations window allows you to create your own filter variations and 

becomes visible when a parameter name is selected in the Parameters 

window.
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Effect
The Effect window shows all filters that have been applied to your image.
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Histogram
A histogram is a specialized graph that plots the number of pixels at each color 

intensity level. It is very useful in seeing how an image’s pixels are distributed.
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Magnifier
When the Magnifier is selected, a portion of the image is displayed at a 1:1 pixel 

ratio in the Magnifier window and shows the actual pixels of the image with the 

current filter applied.

Toolbar
The Toolbar contains various tools to manipulate your image.

Windows and Adjustments
The DFT interface contains multiple windows. Windows can be closed, torn off 

to be a floating window, or moved to a new location.
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Opening and Closing1 Windows:

• Double-click on a window’s title bar to make it a floating window.

• A floating window can be re-docked by double-clicking it’s title bar.

• Click the Close (X) icon to close a window. 

• Once a window has been closed, it can be reopened by selecting it from the View 
> Window pull-down menu.

Moving Windows:

• Click and drag a docked window’s title bar and place it in a new location in the user 
interface. Note how the interface adjusts to accommodate the moved window.

• Click and drag a floating window’s title bar and place it in a new location.

• If you drop the window in the center of an existing window, a tab will be created 
so that both windows will share the same space.

Title Bar
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Sashes
By clicking and dragging the sashes, dividing lines between areas of the 

screen, you can customize the DFT interface.

Tool Tips
Hovering the cursor over an icon will pop up a tool tip that displays its function.
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Value Field Length
You can resize the Value field by clicking and dragging the dividing line between 

Parameter and Value at the top of the Parameters window. This is useful if the 

Parameter names are getting cut off.

Parameter Groups
Parameter groups in the Parameters window can be expanded and collapsed 

using the plus and minus icons located to the left of the group.

Slider Precision
You can adjust any slider with finer precision by pressing Ctrl(Win)/Cmd(Mac) 

while dragging the slider.
DFT User Guide    
• 
• 
•
•
•



• 

DFT User Interface  225 

• 
• 
• 
•
•
•

Combo Box Adjustment
Combo boxes allow you to adjust a parameter in various ways.

Number Field
Highlight the numbers, type in a new number and hit Enter.

Spin Controls
Click on the up and down triangles of the Spin controls to adjust the value.

Slider Pop-Up
The slider is hidden but can be accessed by clicking either the parameter icon 

or on the greater than character “>” to the right of the Spin controls.

Image Info
Located at the bottom-right of the DFT interface, the Image Info displays the 

image size and bit depth.

Number Field

Spin Controls

Slider Pop-Up
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 PULL-DOWN MENUS

File

Setups
A Setup takes a snapshot of the filters and masks applied to your image in the 

Effect window. Setups can be saved and loaded and are independent of the 

image they were originally applied to.

Open Setup
Opens a previously saved Setup.

Save Setup
Takes a snapshot of all filters and masks applied to your image in the Effect 

window and saves it as a Setup file. This Setup file can later be loaded to the 

same or a different image.

Recent Setups
The last five recently opened or saved Setups can be selected and opened 

here.

Preferences
Preferences allow you to customize default settings.

Thumbnail Size
You can select whether the DFT interface uses either a small or large thumbnail 

size. Medium thumbnails are the default.

Small
Small thumbnails are used in the DFT interface.

Medium
Medium thumbnails are used in the DFT interface.

Large
Large thumbnails are used in the DFT interface.
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Preview Size
DFT works at a maximum resolution as defined by the Preview Size--the 

default being 2048 by 2048 pixels. Never fear, when your image is saved, DFT 

always processes at the resolution of the original image.

1024
DFT works at a maximum resolution of 1024 x 1024 pixels.

2048
DFT works at a maximum resolution of 2048 x 2048 pixels.

4096
DFT works at a maximum resolution of 4096 x 4096 pixels.

Downsampling
At large preview sizes, interaction may slow down when adjusting filter 

parameters. To maintain fast processing during adjustments, you can enable 

Downsampling.

Adaptive
Automatically downsamples the image if required.

2:1
Automatically downsamples the image by a factor of 2.

4:1
Automatically downsamples the image by a factor of 4.

8:1
Automatically downsamples the image by a factor of 8.

Preview Scaling

Point
Uses a lower quality scaling method when displaying the image in the Viewer. 

Point is more accurate when applying filters such as grain and sharpen, but 

when zooming in, the image will display “chunky” artifacts.
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Bicubic
Uses a smooth scaling method when displaying the image in the Viewer. 

Bicubic can mask the effect of grain and sharpen filters because of its inherent 

smoothing, but doesn’t suffer from the Point methods chunkiness when 

zooming in.

GPU Rendering
Enables or disables GPU rendering.

Save Setup With Image

Lightroom
Lightroom can now retrieve your DFT setup information consisting of filters, 

layers and masks. To do this, you need to use “Edit Copy with Lightroom 

Adjustments” and render the result. If you then apply DFT to the newly 

rendered version and use “Edit Original”, your previous DFT setup will be 

shown and can be modified.

Photoshop
By default, Photoshop remembers your previous DFT setup consisting of filters, layers 

and masks will all be displayed when you reapply DFT and they can all be modified.

Edit

Undo/Redo
Undo or redo operations. 

Undo/Redo History
Undo/Redo has a history, so you can jump to any item in the history by picking 

it from the menu.

Delete
Deletes the selected filter.
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View

Window
The DFT user interface is broken up into individual windows which can be 

opened or closed by selecting or deselecting them from the View menu. The 

following windows can be opened or closed:

Color Wheels
Open or closes the Color Correct Wheels window.

Console
Displays diagnostic information.

Copy to Clipboard
Copies the contents of the Console to the Clipboard.

Options
OpenGL
Displays the OpenGL version information.

Rendering Statistics
Displays rendering times.

Effect
Opens or closes the Effect window. See Effect for more information.

Filters
Opens or closes the Filters window. See Filters for more information.

Histogram
Opens or closes the Histogram window. See Histogram for more information.

Magnifier
Opens or closes the Magnifier window. See Magnifier for more information.

Parameters
Opens or closes the Parameters window. See Parameters for more 

information.
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Presets
Opens or closes the Presets window. See Presets for more information.

Variations
Opens or closes the Variations window. See Variations for more information.

Reset
Resets the window layout the next time DFT is started. This is useful if you have 

tweaked your windows beyond recognition.

Zoom In
Zooms the image in.

Zoom Out
Zooms the image out.

Fit Image to Window
Fits the image to the window.

Layouts
There are 4 preset layouts that automatically arrange the interface windows 

into different configurations.

Default Layout
The interface is configured with the default DFT layout where all windows are 

shown.

Edit Layout
The Edit Layout shows the Viewer, Presets and Parameters windows.

View Layout
The View Layout shows only the Viewer.

Dual Monitor Layout
The Dual Monitor Layout shows the Viewer on the left monitor and all other 

windows on the right monitor.
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Layout Shortcuts

Help

User Guide
Opens the DFT User Guide.

Help Shortcuts

About
Shows the DFT version.

License
Opens the Deactivation Options window which has two choices: Internet 

Deactivate (Recommended) and Advanced Options.

Shortcut Action

F2 Selects the Default Layout

F3 Selects the Edit Layout

F4 Selects the View Layout

F5 Selects the Dual Monitor Layout

Shortcut Action

F1 Opens the DFT User Guide
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 VIEWER

The Viewer is where images are viewed, edited and manipulated.

Zoom and Pan

Zoom In
Zooms the image in.

Zoom Level
Displays the zoom level as a percentage. 
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Zoom Out
Zooms the image out.

Zoom to Fit
Fits the entire image inside the Viewer.

Zoom
Select the Zoom Region icon and drag select a square region in the Viewer to 

zoom in on that area.

Pan
Pans the image left, right, up and down.

See the Viewer Keyboard Shortcuts for more zooming and panning options.

Compare
Compares images using Side-by-Side, Vertical Split, Horizontal Split, A/B or 

Snapshot comparison modes. By default, the current filter and original image 

are selected for comparison. Choose one of the comparison modes using the 

icons above the Viewer.

The View/Compare icon in the Effect window determines which layers are used 

in the comparison.
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Side-by-Side Comparison
Compares images side by side in the Viewer.
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Vertical Split Comparison
Compares images using a vertical split. Move your cursor into the image area 

over the split line and when the cursor changes to a double-arrow, click and 

drag to move the split. Depending on the filter used, the split line may not be 

obvious, so triangular sashes on the outside of the image help you find it. If you 

drag the sash all the way around, it will swap directions.
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Horizontal Split Comparison
Compares images using a horizontal split. Move your cursor into the image 

area over the split line and when the cursor changes to a double-arrow, click 

and drag to move the split. Depending on the filter used, the split line may not 

be obvious, so triangular sashes on the outside of the image help you find it. If 

you drag the sash all the way around, it will swap directions.

A/B Comparison
When the A/B Comparison button is selected, 

a Show Other View icon appears. Clicking it cycles through the images.
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Snapshot
When the Snapshot icon is enabled, a snapshot of the image in the Viewer is 

taken as well as the layer’s mask, if there is one.

A View Snapshot icon then appears and allows the use of the various 

comparison modes to compare the snapshot to the other layers or different filter 

settings.

Viewer Options

Show Mask
Cycles the display between the full color image and the Mask channel.

Histogram
A histogram is a specialized graph that plots the number of pixels at each color 

intensity level. It is very useful in seeing how an image’s pixels are distributed.
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Viewer Keyboard Shortcuts

Shortcut Action

Middle-mouse drag Pans the image

Space Bar+drag Pans the image

I Key Zooms the image in

O Key Zooms the image out

Zoom icon+Drag a square Zooms into the defined area

Scroll wheel over image Zooms the image in and out

Middle-mouse double click Fits the image to the window

Ctrl(Win)/Cmd(Mac)+click 
A/B Comparison

Turns off A/B Comparison mode, if enabled,

F Fits the image to the window

M Cycles the display between the full color image and the Mask 
channel 

H Opens the Histogram window

1 Opens the Magnifier window
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 FILTERS 

The Filters window at the bottom of the screen is categorized by filter function 

and displays a thumbnail for each filter. The following filter categories are listed: 

Color, Diffusion, Film Lab, Grads/Tints, Image, Lens, Light and Special Effects.

You can find detailed information on each filter later in this guide.
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Wrap Filters
Certain filter categories have a lot of filters and depending on the size of the 

window, there may be a horizontal scroll bar so that you can navigate to any 

filter not currently shown on the screen. To change to a vertical scroll bar, click 

the Wrap Filters icon at the far right of the Filters window.
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 PRESETS AND PARAMETERS

Presets and Parameters share the same window space on the right side of the 

screen, with Presets shown as the default. Either Presets or Parameters is 

selectable in a tab at the bottom of the window.

Presets
The Presets window allows you to select from a set of pre-defined presets. 

When the Presets tab is selected at the bottom of the Presets and Parameters 

window (the default), the Presets window is visible and displays the current 

filter’s available presets. 
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Presets for most filters have been created so that you can easily click through 

the various choices.

Most filters contain multiple preset groups which are selectable at the top of the 

window.
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Clicking once on a preset modifies the image in the Viewer. As you click on 

different presets, the image in the Viewer will update. This allows you to quickly 

try out several different presets.

Once you have found a preset that you like, click on the Add Layer icon at the 

top left of the Effect window to add the filter as a layer. Additional filters can then 

be added.

Note: Double-clicking on a thumbnail in the Presets window automatically adds the 
filter to the image in the Viewer as well as a layer in the Effect window.

Preset Searching
Presets can be searched for by entering text in the search field located at the 

top of the Presets window. The pattern remains in effect when you switch filters, 

but it will clear automatically when you switch layers in the Effect window or 

apply a preset. Clear the search text to return the Presets window to it’s normal 

state.

To search for a preset:

1 Select a filter, for instance Grads/Tints > Gels.

2 In the Presets window search field, type red.

All presets with red in the name are shown.

3 In the search field, type sun|blue.

Any preset with sun or blue in the name is shown.
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Favorites
Presets can be tagged as a Favorite allowing them to be sorted separately in 

the Presets window as well as in the Favorites tab of the Filters window.

You can tag a preset as a Favorite by selecting the preset and pressing the 

Toggle Favorite icon located at the top right of the Presets window.

Presets tagged as a favorite display a yellow star at the top right of the preset.

To sort the Presets window by Favorites, select Favorites in the Presets pop-

up menu.

Presets Right-Click Menu
Right-click over a preset to open Preset options.

Rename
Right-click on a preset, select Rename and type in the new name.
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Delete
Right-click on a preset and select Delete.

Make Default
Right-click on a preset and select Make Default. The default preset is the one 

that is applied to the image when a filter is selected and the one shown in the 

Filter window. Changing the default will take effect the next time you start DFT.

Restore

Default Presets
Restores the Default preset for each filter. The restore happens the next time 

you select the filter.

Deleted Presets
Restores deleted presets.

Renamed Presets
Restores renamed presets. The restore happens the next time you select the 

filter.

To Factory Default
Restores all presets to the default factory settings.

Parameters
When the Parameters tab is selected at the bottom of the Presets and 

Parameters window, the Parameters window is visible and displays the current 

filter’s parameters.
DFT User Guide    
• 
• 
•
•
•



• 

Presets and Parameters  246 

• 
• 
• 
•
•
•

Adjusting the parameters will update and change the image in the Viewer.

Slider controls can be adjusted in the following ways:

• Clicking and dragging the slider.

• You can adjust with finer precision by pressing Ctrl(Win)/Cmd(Mac) while 
dragging the slider.

• Clicking on the number to the right of the slider, typing in the desired value and 
hitting Enter.

• Hover the cursor over a slider and use the mouse scroll wheel to make the 
adjustment. Scrolling up raises the value while scrolling down lowers it.

Pop-up menus can be adjusted in the following ways:

• Click on the pop-up menu and make a selection.

• Hover the cursor over a pop-up menu and use the mouse scroll wheel to change 
the selection.
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Create Custom Preset
Creates a custom preset in the Presets window based on the current parameter 

settings. You must name the preset prior to creating it by using the name field 

to the left of the Add Preset icon.

Reset to Defaults
Resets all of the parameters for the currently selected preset to the built-in 

defaults.
DFT User Guide    
• 
• 
•
•
•



• 

Variations  248 

• 
• 
• 
•
•
•

 VARIATIONS

Variations based on either one or two parameters can be created and are 

displayed as thumbnails in a window below the Parameters and Presets 

window.

To display the Variations window and create variations, pick a filter and click on 

a parameter name in the Parameters window.
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Ranges, Toggles, and Color parameters are available for creating variations. 

When you select a parameter, the Variations window appears and you'll see the 

variations being generated on that parameter. Click on a second parameter and 

it will generate variations between the two.

The first parameter you click on will be the dominant parameter - it'll go across 

the top of the Variations tab. So, you can get different results depending on the 

order you select the parameters. Click on a selected parameter to toggle it back 

off again.

Note: You can only have one or two parameters selected at a time. If you click on a 
third parameter, the last parameter you clicked on will deselect itself. If you deselect 
both of the parameters or switch effects, the Variations window will disappear because 
the variations are no longer being generated.

Variations are generated based on the current effect parameters. So, you can 

pick some parameters for your variation, then go back to the Presets window 

and pick a different Preset, and the variations will regenerate.

Variation Controls

Maximum Number of Variations
Sets the number of variations.

Parameter Value Spread
Determines the difference from one variation to another.
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Auto Generate
Variations are constantly being generated every time you select a parameter or 

click on a variation thumbnail.

Generate
When Auto Generate is off, you must click the Generate icon to update the 

variations after new parameters are selected.
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 EFFECT

The Effect window shows all filters that have been applied to your image. The 

most recently applied filter is at the top of the stack, while the earlier 

applications are at the bottom. When you click on a thumbnail, the Viewer 

displays that layer.

Layer Controls

Layer Name
Displays the Layer name. Just type in this field to rename the layer.
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Layer Opacity
Sets the Layer’s opacity.

Layer Blend Mode
Layers can be combined with the layer below using a variety of Blend modes.

The following layer blend modes are available: Normal, Darken, Multiply, Color 

Burn, Linear Burn, Darker Color, Lighten, Screen, Color Dodge, Linear Dodge 

(Add), Lighter Color, Overlay, Soft Light, Hard Light, Vivid Light, Linear Light, 

Pin Light, Difference, Exclusion, Subtract, Hue, Saturation, and Color.

Go to Blend Modes for explanations of the various modes.

Add Layer
When a filter has been selected, pressing Add Layer applies the current filter to 

the image and creates a new layer.

Add Layer can also be used even if no filter is applied. This way Layer Blend 

Modes can be used to create effects between layers.

Edit
Clicking the Edit icon for a particular layer makes it active. Once active, you can 

adjust the filter settings or replace the current filter with a different one.
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View/Compare
The View/Compare icon indicates which layer is shown in the Viewer and when 

enabled for multiple layers, the Viewer’s Side-by-Side, Vertical Split, Horizontal 

Split or A/B Comparison viewing modes become active. See the Compare 

section of the Viewer for more information.

Clicking on the image thumbnail in the Effect window automatically activates 

the View/Compare icon only for that layer and displays it in the Viewer.

Enable Filter
Deactivate the filter by clicking the Enable Filter icon.

Enable Mask
Enables masks attached to the layer. Masks can be used to limit where a filter 

is applied to an image and are displayed to the right of the filter thumbnail.

See Masks for more information.

Using Layers, Filters and Masks

Adding Filters
There are two ways to add layers.

Click
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1 Click the Add Layer icon at the top left of the Effect window.

2 Double-click on a thumbnail in the Presets window.

Replacing Effects
Double-click on an image thumbnail to make it the active layer or click the Edit 

icon. Once active, you can replace the current filter with a different one.

Note: You can tell visually which layer is active by the active layer’s lighter gray 
background.

Deleting Filters
There are a number of ways to delete a filter.

1 Double-click an image thumbnail in the Effect window and hit the Delete key.

2 Click on the X at the top right of an image thumbnail.

3 Right-click on an image thumbnail and select Delete Filter.

Deleting Masks
There are a number of ways to delete a mask.

1 Double-click a mask thumbnail in the Effect window and hit the Delete key.

2 Click on the X at the top right of a mask thumbnail.

3 Right-click on a mask thumbnail and select Delete Mask.

4 Right-click on an image thumbnail and select Delete Masks to delete all masks 
for the selected layer.

Deleting Layers
Right-click on an image thumbnail and select Delete Layer. Delete Layer is only 

available when a layer has been added in the Effect window.
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Drag and Drop Layers
The ordering of layers in the Effect window can be changed by dragging and 

dropping them to a new location. To do so, click and drag on the layer’s title bar 

to the right of the filter name and release in the new location. 

When the mouse button is released, the layer is moved to the new location.

Before After
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Drag and Drop Filters and Masks
Drag and Drop Filters
Filters from one layer can be copied to another layer using drag and drop. Click 

and drag on the layer’s image thumbnail and release the mouse on the layer’s 

image thumbnail where you want to copy the filter. When the cursor hovers over 

the image thumbnail of another layer, the cursor changes to a + sign indicating 

that it is OK to release the mouse.

When the mouse button is released, the destination filter is replaced with the 

source filter. 

Before After
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Drag and Drop Masks
Masks can be copied using drag and drop. Click and drag on one of the layer’s 

mask thumbnails and release the mouse on the layer’s mask thumbnail where 

you want to copy the mask. When the cursor hovers over the mask thumbnail 

of another mask, the cursor changes to a + sign indicating that it is OK to 

release the mouse.

When the mouse button is released, the destination mask is replaced with the 

source mask. If you release the mouse over a layer without a mask, the mask 

will be added to the layer.

Before After
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 TOOLBAR

The Toolbar contains Done, Cancel, Reset and Add Mask buttons. When Add 

Mask is clicked on and a mask type is chosen, it’s controls also appear in the 

Toolbar.

Done
The values of the parameter adjustments in the DFT user interface are 

transferred to your host application.

Cancel
Closes  without making any changes.

Reset All
Resets DFT back to the original image with nothing applied to it.

Add Mask
Adds a Mask to the current layer. Masks can be used to limit where a filter is 

applied to an image and are displayed to the right of the filter thumbnail.

See Add Mask in the Masks section for more information.
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Adjusting Toolbar Controls
When certain tools are selected, for instance the masking tools, their controls 

appear in the Toolbar. Adjusting the controls is pretty straightforward except in 

the case of tools with numeric values where the slider is hidden, but can be 

accessed by clicking either the parameter icon or on the greater than character 

“>” to the right of the Spin controls.

As with the numeric controls in the Parameters window, you can also click 

directly on the numbers, type in a new number and hit Enter.
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 MASKS

Masks allow you to limit the effect of a filter by revealing it only in white areas 

of the mask. White is on, black is off and gray areas in between represent a 

level of transparency. 

Masks are displayed to the right of the image thumbnail in the Effect window.

General Mask Controls
The various mask types consist of a combination of on-screen and toolbar 

controls.

Photo by Joshua Earle on Unsplash
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Add Mask
Using the Add Mask icon in the Toolbar, one of seven mask types can be 

applied to a layer: Gradient, Spot, Path, Snap, EZ Mask, Selection and Paint. 

Masks can be used to limit where a filter is applied to an image and are 

displayed to the right of the layer’s image thumbnail in the Effect window.

Mask Blend Mode
The Blend mode controls how the current mask is combined with the previous 

mask and is only active when more than one mask has been applied.

Normal
Normal blends masks based on each mask’s transparency.
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Subtract
The pixels of one mask are subtracted from another mask.

Multiply
Produces a result where there is a union of pixels from two masks.

Invert Mask
Inverts the current mask.

Mask Opacity
Sets the opacity of the current mask.

Mask Blur
Sets the blur level of the EZ Mask, Path, Selection and Snap masks.

Inner Blur
The mask is blurred inward from the edge of the mask.

Centered Blur
The blur is centered on the edge of the mask, equally blurring inward and 

outward.
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Outer Blur
The mask is blurred outward from the edge of the mask.
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Gradient Mask
Creates a linear top to bottom or left to right gradient and is adjusted using the 

four points around the corners of the image as well as controls in the Toolbar.

Go to the Gradient Mask Tutorial to see how it works.

The Gradient Mask consists of a combination of on-screen and toolbar controls.

Photo by Joshua Earle on Unsplash
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On-Screen Controls
Corner Points
There are four points around the four corners of the image. By clicking and 

dragging any of the four points, the Gradient mask can be adjusted.

Toolbar Controls
Top-to-bottom
The direction of the Gradient mask is from top to bottom.

Bottom-to-top
The direction of the Gradient mask is from bottom to top.

Left-to-right
The direction of the Gradient mask is from left to right.

Right-to-left
The direction of the Gradient mask is from right to left.

Gradient Size
The size of the Gradient mask.
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Spot Mask
Creates a circular spot mask and is adjusted using the two circular on-screen 

controls as well as parameters in the Toolbar.

Spot Mask consists of a combination of on-screen and toolbar controls.

On-Screen Controls
Radius
The un-blurred radius of the spot is controlled using the inner on-screen circle.

Photo by Ariel Lustre on Unsplash
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Falloff Radius
The blurred edge radius is controlled using the outer on-screen circle.

Toolbar Controls
Aspect Ratio
The aspect ratio of the spot.

Falloff
Moves the falloff towards the spot centerpoint.
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Path Mask
A Path is an outline created by placing sequential points along an object. Think 

of it as connecting the dots if you will. Although paths can be open or closed, 

DFT only makes use of closed paths. Drawing a path is often a good solution 

for objects that can’t be masked in any other way.

Go to the Path Mask Tutorial to see how it works.

Photo by Patrick Fore on Unsplash
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Create a Path
Create a path by clicking on the image in the Viewer. With each click of the 

mouse, a point is created. When done, click on the first point that was added to 

close the shape.

Note: If shapes overlap, a hole in the path is created.

Closing Open Paths
If you neglect to close a path and would later like to close it, select one of the 

end points and then select the other end point. The path will then close.

Selecting Points
Individual or multiple points can be selected. Once selected, various point 

editing operations are available.
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Point Selecting Shortcuts

Point Editing
Significant modification to the path is made possible by point editing controls 

available through pop-up menus or keyboard shortcuts.

Point Editing Shortcuts

Shortcut Action

Click a point Selects one point

Click and drag over multiple points Selects multiple points

Ctrl+click on a point Toggles the selection on or off

Shift+click a point Adds the point to the current selection

Shortcut Action

Alt+click on a path Inserts a new point along the path

Delete key Delete all selected points

Click and drag selected points All selected points move

Click and drag an unselected point Moves one point

Alt+click+drag on a point Opens a slider to adjust the point’s tension. Left of center 
forces the path to curve through the point (Cardinal 
spline). The center position creates a corner point while 
the right position moves the curve towards the center of 
the path (B-Spline). If multiple points have been selected, 
they will all be set to the same tension.

Alt+click+drag+Shift on a point Snaps the point tension to Cardinal, Corner or B-Spline 
positions
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Point Editing Pop-up Menu
Right-click over a path point or set of path points to open the Point pop-up 

menu.

Show Control Points
It is sometimes helpful to turn off the display of path points to see the accuracy 

of your path. When turned off, you can still adjust the hidden points by 

click+dragging on the path and the nearest point will be adjusted.

Menu Option Action

Cardinal Creates a path that passes smoothly through each point

Corner Creates a corner point

B-Spline Creates a path that is determined by the surrounding points
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Snap Mask
Snap is an easy to use interactive image masking tool. Snap provides instant 

visual feedback by snapping an editable curve to an object's boundary even if 

it has vague or low contrast edges.

Go to the Snap Mask Tutorial to see how it works.

Snap consists of a combination of on-screen and toolbar controls.

Photo © THINKSTOCK LLC--www.thinkstock.com
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Workflow
Using a coarse to fine editing approach, an area of the image is selected by first 

marking the object and then refining the boundary. Object marking occurs at a 

coarse level, which roughly defines an object by marking a few lines. Next, 

boundary editing works at a finer scale by either clicking and dragging polygon 

points to edit the object boundary or drawing a stroke along the object’s edge.
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Object Marking
Instead of tracing the boundary of an object, Snap uses lines and curves to 

define the object.

FG Mark

Boundary BG Mark

BG Mark
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Mark Foreground
Click the Mark Foreground icon and draw lines to mark the foreground area--

the region to be isolated. With each click and drag of the mouse, a green line 

is drawn.
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Mark Background
Click the Mark Background icon and draw lines to mark the background area. 

With each click and drag of the mouse, a red line is drawn.

Note: You can automatically draw background lines by clicking the right mouse button 
and dragging.

As soon as the first background line is drawn, Snap calculates a boundary 

curve that is displayed as a black and white dashed line around the object.
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Add additional FG and BG lines as needed so that your object is surrounded 

by the boundary. Don't be concerned at this point if the boundary is not exactly 

following your object. The curve can be refined further using the boundary 

editing tools.

Boundary Editing
Even though object marking does a pretty good job of creating an accurate 

boundary, there can still be some errors, especially around vague or low 

contrast edges. To remedy these errors, there are simple polygon point editing 

tools to refine the object's boundary. Two tools are provided for polygon editing: 

Edit Points and Override Edge. When either of these tools is selected, the 

boundary created in the object marking step is converted into editable polygons 

and you will see a noticeable refinement in the boundary.
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Edit Points
Click the Edit Points icon and drag points to adjust the shape of the polygon. 

Compared with a simple polygon where you need to modify many points, Snap 

uses far fewer points to define the object shape. You should see variation in the 

boundary even though there are no points directly over the variations.

Note: The Edit Points icon can also be used to display and edit control points after the 
boundary is converted to a path.

Point Editing Shortcuts

Override Edge 
Click the Override Edge icon and draw a stroke along the edge of your object 

where the boundary doesn’t correctly follow the edge.

Before After

Shortcut Action

Alt+click between two points Add points 

Hover over point + Delete Key Delete points

Alt+drag a point Uses magnetism to snap a point to an object’s boundary
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Once a stroke has been drawn, Snap optimizes the object boundary. The 

optimized boundary automatically snaps to the object boundary even though 

the polygon points may not be on it.

An entire segment of the polygon is replaced by drawing a single stroke and is 

much easier than dragging individual points.

Clear Foreground / Background Marks
Clears all foreground ad background marks.

Before Mark

After
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Convert Curve to a Path
When happy with the boundary you have created, click the Convert Curve to a 

Path icon to apply it to the layer and convert it to an editable path. Additional 

boundaries can be created and applied to the layer. When boundaries overlap, 

a hole in the mask is created.

Show Control Points
It is sometimes helpful to turn off the display of path points to see the accuracy 

of your path. When turned off, you can still adjust the hidden points by 

click+dragging on the path and the nearest point will be adjusted.
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EZ Mask
EZ Mask is an easy to use interactive image masking tool capable of isolating 

almost any object in an image--even if you are dealing with fine hair detail, 

smoke, or reflections. 

To work this magic, EZ Mask iteratively estimates the transparency value for 

every pixel in the image, based on a small sample of foreground (what you want 

to isolate) and background pixels marked by simple strokes on the image.

Results show that compared with previous approaches, our method is more 

efficient and requires minimal effort to extract high quality masks for 

foregrounds with significant semi-transparent regions.

Go to the EZ Mask Tutorial to see how it works.

EZ Mask consists of a combination of on-screen and toolbar controls.

User Input Mask
DFT User Guide    
• 
• 
•
•
•



• 

Masks  282 

• 
• 
• 
•
•
•

Mask Creation
Trimaps
EZ Mask creates masks by using a trimap--a pre-segmented image consisting 

of three regions of foreground (what you want to isolate), background and 

unknown. Partial opacity values are then computed only for pixels inside the 

unknown region. Two trimap methods can be used: Stroke and Filled. When 

creating masks, start with the Stroke method and move on to the Filled method 

if the results are not satisfying.

Stroke
Unlike previous approaches, our trimaps can be relatively sparse consisting of 

individual foreground and background brush strokes. All pixels left unmarked 

will be treated as unknown. After processing, if any fine foreground details are 

missing from the mask, the Unknown brush can be used in these areas to help 

recover lost detail.

Stroke trimaps require little user input, but when color ambiguity exists between 

the foreground and background, a Filled trimap may create a more accurate 

mask. In addition, Stroke trimaps will also take longer to render as they require 

an extra calculation step.

Stroke Trimap Creation Tips & Tricks
• Make sure you place enough foreground and background strokes. A good stroke 

technique is to draw an inner outline around the object you are extracting using 
the Paint Foreground brush and an outer outline using the Paint Background 
brush.

Strokes Mask
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• The strokes should be near the boundary of the object, but not right up against the 
edge. 

• Strokes that are closer to the boundary will dominate the creation of the mask. 

• If the foreground or background has varying colors, the strokes should cover 
these colors.

• After processing the mask, if you see gray areas in the foreground object that 
should be completely white, make additional foreground marks in those areas.

• If you see gray mask areas in the background that should be completely black, 
make additional background marks.

• If any fine foreground details are missing from the mask, click on the Unknown 
brush and draw over them with the left mouse button. This instructs EZ Mask to 
pay special attention to these areas and will help recover lost detail.

• The general rule is don’t put different stroke types too close together unless you 
need to.

Warning: If you only provide a few sparse strokes, a Stroke trimap will take longer to 
process than a filled trimap.

Good Stroke Example Bad Stroke Example
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Filled
Foreground and background brush strokes are used to mark definite 

foreground and background pixels while the Unknown brush is used to mark 

unknown, or mixed regions. Using this method, the entire image is painted/filled 

with one of the three brushes.

Filled trimaps process faster than Stroke trimaps and can result in extracting a 

more accurate mask, most notably when color ambiguity exists between the 

foreground and background. However, they can be tedious to create and tend 

to fail for images with large portions of semi-transparent foreground where the 

trimap is difficult to create manually.

Filled Trimap Creation Tips & Tricks
• First, define unknown areas by selecting the Paint Unknown brush and drawing 

around the edges of the foreground (what you want to isolate) with the left mouse 
button. Include as little solid foreground areas as possible.

• Ideally, the unknown region in the trimap should only cover transparent pixels 
whose actual values are not completely foreground or background. In other 
words, the unknown region in the trimap should be as thin as possible to achieve 
the best masking result.

• Next, fill in the solid foreground area by selecting the Paint Foreground brush and 
the Fill tool. Click inside the area defined by the blue, Unknown brush. The 
foreground area automatically fills in with the green foreground color.

• Last, mark background areas by using the Paint Background brush and the Fill 
tool. Since the Fill tool is already enabled, you don’t need to select it again. Click 
outside of the area defined by the blue, Unknown brush. The background area 
automatically fills in with the red background color.

Note: Large foreground objects take longer to process than small ones.

Filled Mask
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Brushes
Paint Foreground
Click the Paint Foreground icon and draw to mark the foreground area--the 

region to be isolated. With each click and drag of the mouse, a green line is 

drawn.

Note: If you click with the left mouse button, press Shift and then click in a different 
location, a straight line is drawn. This will work with any brush type. If you keep Shift 
depressed while clicking, you will create interconnected straight lines. This is very 
useful when using a mouse.

Paint Background
Click the Paint Background icon and draw to mark the background area. With 

each click and drag of the mouse, a red line is drawn.

Note: You can quickly create background strokes without selecting the Paint 
Background brush by painting with the right-mouse button. This temporarily draws with 
the Paint Background brush and when the right-mouse button is released, the 
previously selected brush becomes active.

Paint Unknown
Click the Paint Unknown icon and draw to mark the unknown area. With each 

click and drag of the mouse, a blue line is drawn.

When drawing a stroke trimap, certain foreground details may be missing after 

the mask is generated. Using the Paint Unknown brush in these areas can 

sometimes help recover lost detail.
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Paint Missing
The Paint Missing brush is used to mark missing foreground areas--fine details 

such as strands of hair that may be missing after the mask is generated. Using 

the Paint Missing brush in these areas can sometimes help recover lost detail. 

With each click and drag of the mouse, a purple line is drawn.

Note: The Paint Missing brush has a Sensitivity parameter located in Settings (Wrench 
icon) > Process Options. It’s preset value will work for most images. However, the 
higher the value, the more details are brought out.

Eraser
Erases existing brush strokes.

Fill
Using the current brush, the Fill tool fills a region defined by a brush stroke or 

the edges of the screen.

Brush Parameters

Size
Sets the size of the brush. 
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To set the brush size:

1 Click on the Brush Size icon, and drag the slider that appears.

or

2 Enter a value in the number field next to the Brush Size icon and hit Enter.

or

3 Resize the brush in the Viewer by holding Ctrl(Win)/Cmd(Mac) and dragging in or 
out.

Paint Overlay Opacity
Sets the opacity of the foreground, background and unknown brush strokes.

To set the paint overlay opacity:

1 Click on the Paint Overlay Opacity icon, and drag the slider that appears.
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or

2 Enter a value in the number field next to the Paint Overlay Opacity icon and hit 
Enter.

Settings
Various EZ Mask preferences can be set by clicking the Settings icon.

Foreground Color
Sets the color of the Paint Foreground brush.

Background Color
Sets the color of the Paint Background brush.

Unknown Color
Sets the color of the Paint Unknown brush.

Missing Color
Sets the color of the Paint Missing brush.

Process Options

Deartifact
Blurry artifacts can be generated while attempting to extract objects that have 

drop shadows, similar colors to the background or out of focus edges. 

Deartifact can be used to limit these artifacts.

Deartifact
Turns deartifact on or off.

Amount
Sets the amount of deartifacting.

Missing Brush
Sensitivity
Sets the sensitivity of the Missing Brush. The higher the value, the more details are 
brought out.
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Reset
Clears all brush strokes.

Mask Processing (Enter)
Generate Mask
Generates the mask. Click this after creating either foreground and background 

strokes or a filled trimap. You can use the Enter key to trigger the mask 

processing.
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Selection Mask
Selection masks, also known as mattes, can be used to manipulate, isolate and 

protect specific parts of an image when making adjustments or applying filters.

Using advanced image slicing algorithms, masks are created using luminance, 

hue, saturation, average, red, green, blue, cyan, magenta, and yellow values.

Go to the Selection Mask Tutorial to see how it works.

The Selection Mask consists of a combination of on-screen and toolbar 

controls.

 Original                                                         Mask
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Extract On
Extract On selects the type of mask. Select whichever type isolates the desired 

values.

A mask is created based on one of the following:

Luminance
A mask is created based on the luminance of the image.

Hue
A mask is created based on the hue of the image. When adjusting the Position 

parameter, you are selecting different hues.

Saturation
A mask is created based on the saturation of the image.

Average
A mask is created based on the average of the image’s RGB values.

Red
A mask is created based on the image’s red values.

Green
A mask is created based on the image’s green values.

Blue
A mask is created based on the image’s blue values.

Hue Mask
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Cyan
A mask is created based on the image’s cyan values.

Magenta
A mask is created based on the image’s magenta values.

Yellow
A mask is created based on the image’s yellow values.

Position
The Position value pinpoints the color values to be used in the mask. For a 

luminance mask, a Position value of 100 would make a white mask of the 

highlights and a value of 0 would make a white mask of the shadows. In our 

flower image, look at how the mask varies for different Position values in a red 

extraction. When the Position is at a value of 100, the red flowers are shown as 

white in the mask.

When the Position is moved to 50, the red flowers turn black.

Position=100, Range=25

Position=50, Range=25
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Range
Increases or decreases the range of values in the mask. A low Range value 

indicates a narrow range of values. A high Range value indicates a large range 

of values included in the mask.

Radius
When the Radius control is increased, a soft, circular mask is created to limit 

the mask. 

On-Screen Controls
When using the Selection Mask, the Position, Range and Radius parameters 

can be set using on-screen controls. Click on the image to place the on-screen 

control which consists of a center point and a solid circle. The Position value is 

Position=100, Range=50

Radius=50
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set by the location of the center point, while the Range is set by sizing the circle. 

The larger the circle, the larger the range. If Radius is used, a dashed circle will 

also appear.

Black Clip
Blacks in the mask are made blacker by increasing this value. As the value 

increases, more values are clipped to black. This is helpful for getting rid of 

unwanted gray areas in what should be the black part of the mask. 

Radius

Range

Position

 Mask with No Black Clip                                 Black Clip=50
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White Clip
Whites in the mask are made whiter by increasing this value. As the value 

increases, more values are clipped to white. This is helpful for getting rid of 

unwanted gray areas in what should be the white part of the mask. 

 Mask with No White Clip                                  White Clip=50
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Paint Mask
Organic masks are created using a paint brush and the filter appears only in the 

area of the paint stroke. 

Go to the Paint Mask Tutorial to see how it works.

Paint Mask consists of a combination of on-screen brushes and toolbar 

controls.

Note: If you have a large area that needs to be masked out, it may be more efficient to 
first use the Path Mask since Paint’s brush size does not exceed 500 pixels.

Brush Size
Sets the size of the brush.

To set the brush size:

1 Click on the Brush Size icon in the Toolbar, and drag the slider that appears.
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or

2 Enter a value in the number field next to the Brush Size icon and hit Enter.

or

3 Resize the brush in the Viewer by holding Ctrl(Win)/Cmd(Mac) and dragging in or 
out.
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Brush Softness
Sets the brush softness.

To set the brush softness:

1 Click on the Brush Softness icon in the Toolbar, and drag the slider that appears.

or

2 Enter a value in the number field next to the Brush Softness icon and hit Enter.
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Brush Opacity
Sets the brush opacity. Painting with the right-mouse button automatically 

paints with O opacity or black.

To set the brush opacity:

1 Click on the Brush Opacity icon in the Toolbar, and drag the slider that appears.

or

2 Enter a value in the number field next to the Brush Opacity icon and hit Enter.
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 COMMON FILTER CONTROLS

There are a number of common filter controls that appear in DFT. For simplicity 

they are listed here.

Blur
Horizontal
The image is blurred by a quality blur along the X-axis.

Vertical
The image is blurred by a quality blur along the Y-axis.

Gang
The horizontal and vertical slider values can be ganged together. When 

ganged, moving the slider affects both values.

Black and White
Selects the type of black and white filter to be applied to your color image.

Normal
Converts the color image to a monochrome image.

Red
Simulates a red filter in black and white photography.

Green
Simulates a green filter in black and white photography.

Blue
Simulates a blue filter in black and white photography.

Yellow
Simulates a yellow filter in black and white photography.
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Orange
Simulates an orange filter in black and white photography.

Grad
Grad is the gradient transition area between the filtered image and the original. 

Its direction, corners, size and angle can be adjusted.

Enable
Turns the grad on and off.

ND Brightness
Darkens the colored portion of the grad.

Type
Controls the direction of the grad.

Top-to-bottom
The direction of the grad is from top to bottom.

Bottom-to-top
The direction of the grad is from bottom to top.

Left-to-right
The direction of the grad is from left to right.

Right-to-left
The direction of the grad is from right to left.

Horizontal Strip
Horizontal strip grad.

Vertical Strip
Vertical strip grad.

Size
The size of the grad.
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Angle
The angle of the grad.

Corner Pin
There are four points around the four corners of the image. By clicking and 

dragging any of the four points, the Grad can be adjusted.

Matte
In some of the filters, a matte is generated to create the desired effect. The 

Matte controls consist of Position, Range and Blur parameters, and they work 

the same in all of the filters. The white areas of the matte are the areas that will 

be affected by the filter, while the black areas remain unaffected. The matte is 

extracted based on luminance, in most cases, and is created using the Position 

and Range parameters.

Photo © THINKSTOCK LLC--www.thinkstock.com
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Position
Selects the values to be included in the matte. A higher Position value shows 

more white values from the original image as white values in the matte. A lower 

Position value shows more black values from the original image as white values 

in the matte.

Position 0, Range 25 Position 100, Range 25Original

Photo © THINKSTOCK LLC--www.thinkstock.com
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Range
Controls the range of values to be used for the matte. Once you’ve selected the 

“Position”, you can then add or subtract the “Range” of values to be included in 

the matte. A higher Range value includes more white values in the matte while 

a lower Range value includes less values in the matte. 

Blur
The matte is blurred by a quality blur.

Spot
A spot in the form of a radial gradient is used to limit the effect of the filter.

Position
There is an on-screen control in the center of the image. By clicking and 

dragging the on-screen control, the position of the spot can be adjusted.

Aspect
The aspect ratio of the spot.

Radius
The un-blurred radius of the spot.

Falloff Radius
The blurred edge radius.

Position 100, Range 25 Position 100, Range 75Original
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Falloff
Moves the falloff towards the spot center point.

Invert
Inverts the spot.

Temperature

Color
Sets the color through the use of a standard color picker.

Opacity
Sets the opacity of the warming or cooling.

Preserve Highlights
Preserves the white areas of the image.

Exposure Compensation
Exposure Compensation adds back the brightness loss as a result of the 

warming or cooling.

Transform
Transform your image using Position, Scale, Rotation, Corner-Pin, Shear and 

Crop controls.

Crop
Top
Crops the image from the top down.

Bottom
Crops the image from the bottom up.

Left 
Crops the image from left to right.
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Right
Crops the image from right to left.

Corner Pin
There are four points around the four corners of the image. By clicking and 

dragging any of the four points, the image can be adjusted.

Position
Position can be adjusted by clicking and dragging an on-screen control in the 

center of the image.

Scale
Scale X
The horizontal scale.

Scale Y
The vertical scale.

Gang Scale
The Scale X and Scale Y slider values can be ganged together.

Rotate
In addition to the standard position and scale controls, you can rotate. Positive 

values rotate clockwise and negative values rotate counter-clockwise.

Shear
Shear X
Skews left and right.

Shear Y
Skews up and down.

Anchor
Anchor X
Defines the point on the X axis around which position, rotation, scaling or 

shearing takes place.
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Anchor Y
Defines the point on the Y axis around which position, rotation, scaling or 

shearing takes place.

Filter
Chooses the filtering method when transforming the image. Mitchell is the 

default.

Triangle
The Triangle filter is not the highest quality, but fine for scaled images.

Quadratic
Quadratic is like triangle, but more blur with fewer artifacts. It offers a good 

compromise between speed and quality.

Cubic
Cubic is the default filter in Photoshop. It produces better results with 

continuous tone images, but is slower than Quadratic. If the image contains fine 

details, the result may be blurrier than desired.

Catmull-Rom
This produces good results with continuous tone images which are scaled 

down, producing sharp results with fine detailed images.

Gaussian
Gaussian lacks in sharpness, but is good with ringing and aliasing.

Mitchell
A good balance between sharpness and ringing, Mitchell is a good choice when 

scaling up.

Sinc
Keeps small details when scaling down with good aliasing.

View
Chooses what to view. The choices in this menu will change depending on the 

filter.
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 AMBIENT LIGHT

Description
Ambient creates light without a defined source and contributes to the overall 

brightness of a scene without casting shadows.

Go to the Ambient Light Tutorial to see how the filter works.

Category
Light.

Controls

Presets
To select a preset, pick one from the Presets window.

Brightness
Sets the intensity of the light.

Gels
Photographers, cinematographers and lighting designers use colored filters or 

gels in front of lights. Whatever mood you wish to create, we have the colors 

needed to achieve the effect. Select one of the Gels presets from the pop-up 

menu.

Before After

Photo by Ryan Lum on Unsplash 
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Color
Sets the color of the light through the use of a standard color picker.
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 AUTO ADJUST

Description
Automatically adjusts the image using Auto Color, Auto Contrast and Auto 

Levels processes.

Go to the Auto Adjust Tutorial to see how the filter works.

Category
Color.

Controls

Presets
To select a preset, pick one from the Presets window.

Type
Selects from one of the three automatic adjustment processes.

Auto Color
Auto Color adjusts the contrast and color of an image and is good for 

neutralizing color casts.

Auto Contrast
Auto Contrast automatically adjusts image contrast.

Before After

Photo by Tadas Mikuckis on Unsplash 
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Auto Levels
Auto Levels automatically adjusts the white point and black point in an image. 

Since each color channel is adjusted individually, it may remove or introduce 

color casts.

Opacity
Sets the amount of auto adjustment.
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 BLACK AND WHITE

Description
Black and White converts color images to black and white simulating the look 

of Black and White photographic filters.

Go to the Black and White Tutorial to see how the filter works.

Category
Color.

Controls

Presets
To select a preset, pick one from the Presets window.

Filter
The Filter pop-up selects the type of black and white filter to be applied to your 

color image. Go to the Black and White section of Common Filter Controls to 

see how the Black and White controls work.

Brightness
Adjusts the brightness of the image. Positive values brighten, negative values 

darken.

Before After

Photo by Anthony Delanoix on Unsplash
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Contrast
Adjusts the contrast of the image. Positive values increase contrast, negative 

values decrease contrast.

Gamma
Adjusts the gamma of the image. The gamma adjustment leaves the white and 

black points the same and only modifies the values in-between. Positive values 

lighten the midtones, negative values darken the midtones.
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 BLEACH BYPASS

Description
Bleach Bypass is a film laboratory technique where, by skipping the bleach 

stage in the color processing sequence, silver is retained in the image along 

with the color dyes. The result is effectively a black and white image 

superimposed on a color image. Bleach Bypass images have increased 

contrast, reduced saturation, often giving a pastel effect.

Go to the Bleach Bypass Tutorial to see how the filter works.

Category
Film Lab.

Controls

Presets
To select a preset, pick one from the Presets window.

Amount
Sets the intensity of the bleach effect.

Saturation
Adjusts the saturation of the image. Positive values saturate, negative values 

desaturate.

Before After

Photo by Chris Barbalis on Unsplash
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Contrast
Adjusts the contrast of the image. Positive values increase contrast, negative 

values decrease contrast.

Temperature
Sets the color temperature of the image. Dragging the slider to the right makes 

the image cooler (bluer) and dragging the slider to the left makes the image 

warmer (redder).
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 BLUR

Description
Blurs the image with individual horizontal and vertical controls. It’s fast, high 

quality and blurs outside the frame which removes the dark inward bleeding 

edges of most blurs.

Go to the Blur Tutorial to see how the filter works.

Category
Lens.

Controls

Blur
Horizontal
The image is blurred by a fast, quality blur along the X-axis.

Vertical
The image is blurred by a fast, quality blur along the Y-axis.

Gang
The horizontal and vertical slider values can be ganged together. When 

ganged, moving the slider affects both values.

Before After

Photo by Michal Grosicki on Unsplash
DFT User Guide    
• 
• 
•
•
•



• 

Borders  317 

• 
• 
• 
•
•
•

 BORDERS

Description
Select from a variety of different pre-made borders or create your own.

Go to the Borders Tutorial to see how the filter works.

Category
Special Effects.

Controls

Presets
To select a preset, pick one from the Presets window.

Border
Type
Choose from 11 different borders or Custom to create variable colored, 

softened borders.

Orientation
The orientation of border.

Before After

Photo by Tradd Harter on Unsplash
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O degrees
The default orientation of the border.

90 degrees
Rotates the border 90 degrees.

180 degrees
Rotates the border 180 degrees.

270 degrees
Rotates the border 270 degrees.

Invert
Inverts the color of the border.

Note: Orientation and Invert are only used for the pre-made Border’s 1-11.

Size
The size of the border.

Color
The border color.

Softness
The softness of the border.

Roughness
The roughness of the border.

Randomize
Randomizes the roughness of the border.

Transform
Transform the border using Scale and Rotate controls. Go to the Transform 

section of Common Filter Controls to see how the Transform Controls work.
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 CARTOON

Description
Converts the image into a cartoon.

Go to the Cartoon Tutorial to see how the filter works.

Category
Special Effects.

Controls

Amount
Adjusts the amount of the cartoon effect.

Detail
Adjusts the detail. If the slider is increased, you will see more detail while 

decreasing the slider will have an overall smoothing effect.

Line
Adjusts the size of the cartoon’s outline.

Note: It is important to view the line strength in the Magnifier as there will be a 
difference in what you see in the Viewer. What you see in the Magnifier is what will be 
rendered.

Before After

Photo by Ilya Yakover on Unsplash
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 CENTER SPOT

Description

Center Spot
Diffuses and blurs distracting backgrounds while keeping a center spot in 

focus. The center spot can be moved, sized and the amount of blur can be 

controlled.

Warm Center Spot
Combines the benefits of Center Spot with a warming filter making it ideal for 

portraits and skintones.

Go to the Center Spot Tutorial to see how the filter works.

Before After

Photo by Samuel Scrimshaw on Unsplash

Before After

Photo by Samuel Scrimshaw on Unsplash
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Category
Diffusion.

Controls

Presets
To select a preset, pick one from the Presets window. If you would like to view 

presets from a different category, use the pop-up menu at the top left of the 

Presets window.

Blur
Sets how much the image is blurred.

Spot
A spot in the form of a radial gradient is used to control where blur is added to 

the image. Go to the Spot section of Common Filter Controls to see how the 

Spot controls work.

Temperature
Applies a warming filter to the image. Go to the Temperature section of 

Common Filter Controls to see how the Temperature controls work.
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 CHROMA BANDS

Description
Creates rainbow diffraction patterns.

Go to the Chroma Bands Tutorial to see how the filter works.

Category
Light.

Controls

Blend
Determines the blend mode used to create the rainbow effect.

Add
The rainbow is added to your image.

Screen
The rainbow is combined with the image using a Screen blend mode. This 

looks kind of like the Add blend mode, but highlights are retained.
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Brightness
Adjusts the brightness.

Color
Sets the color.

Scale
Changes the size.

Aspect
Sets the aspect ratio.

Softness
Blurs the bands.

Chroma
Controls the saturation.

Angle
Changes the angle.

Cycles
Sets the number of bands.

Density
Determines the amount of rays.

Taper
Tapers the band’s edges.

Spread
Changes the distribution of the bands.

Offset
Determines the band’s inner diameter.

Noise
Controls the amount of noise in the bands.
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 CHROMATIC ABERRATION

Description
Chromatic aberration is caused by a lens having a different refractive index for 

different wavelengths of light and is seen as fringes of color around the edges 

of the image. This fringing is removed by un-distorting the individual color 

channels.

Go to the Chromatic Aberration Tutorial to see how the filter works.

There are some new types of color fringes that are not chromatic aberration. 

These effects might be visible as purple or blue fringes and are visible around 

overexposed areas in most cases. If the following conditions apply, your image 

most likely has true chromatic aberration as opposed to color fringing caused 

by sensor overloading:

• Corners should show most color fringes whereas the center should show none.

• Color fringes should be not only at the edges of overexposed areas but at lower 
contrast edges, too.

• Color fringes should be of complementary color (red-cyan, green/magenta, and 
blue-yellow) on opposite sides of a dark or bright area.

Before After

Photo by Joel Filipe on Unsplash
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• Color fringes should be in all corners with the same direction and pointing out 
from the center.

Note: Chromatic Aberration must be applied as the first layer (bottom of the layer stack) 
when multiple layers are used. Otherwise, all filters below will not be rendered.

Category
Lens.

Controls

Red/Cyan, Green/Magenta, Blue/Yellow
Use the appropriate color group to remove the chromatic aberration. For 

instance, if you see red/cyan fringing, use the Red/Cyan group. Start by 

adjusting the Distortion parameter.

Warning: The Viewer does not show an accurate representation of what the filter will 
look like when rendered. To visualize the final render, you must use the Magnifier at a 
1:1 pixel ratio.

Distortion
Pulls the corners of the image in or out. Negative values pull the corners of the 

image inward while positive values pull the corners of the image outward.

Anamorphic Squeeze
Anamorphic Squeeze corrects for the squeeze found in anamorphic motion 

picture lenses.

Curvature X and Y
Curvature X and Y correct for non-radial, asymmetric distortions found in 

anamorphic motion picture lenses.

Note: Anamorphic Squeeze and Curvature X and Y only work once the Distortion 
parameter has been adjusted.

Center X and Y
Determines the center point for the distortion.
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 COLOR

Description
Generates a solid field of color.

Category
Color.

Controls

Color
The color can be set through the use of a standard color picker.
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 COLOR CORRECTORS

Description
DFT includes a number of different color correctors that are handy for adjusting 

an image’s color. They include: Color Correct, F-Stop, Printer Points, Telecine 

and Temperature.

Color Correct
Color Correct manipulates hue, saturation, brightness, contrast, gamma, 

temperature, cyan/magenta, red, green and blue values of the overall image 

and separately in user definable shadow, midtone and highlight areas. In 

addition to traditional slider controls, a visual Color Wheels interface can be 

used to make adjustments. 

F-Stop
F-Stop manipulates red, green and blue values of the overall image and 

separately in user definable shadow, midtone and highlight areas using F-Stops 

as the unit of measure. In camera terminology, F-Stops measure the size of the 

lens opening, otherwise known as aperture. Each F-Stop is twice as bright as 

the next. 

Before After

Photo by Sean Afnan on Unsplash
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Printer Points
Printer Points manipulate the red, green and blue values of the overall image 

and separately in user definable shadow, midtone and highlight areas using 

motion picture laboratory printer points as the unit of measure. When creating 

color prints for motion pictures, a contact printer performs scene-to-scene color 

corrections. The most popular printing method is additive printing that uses 

three separate colored sources - red, green, and blue which are combined to 

form the light source that exposes the film. The red, green, and blue light valves 

in the printer are adjusted in values of 1, 2, 3... up to 60 for each primary color 

and are called printer points or printer lights. 

Telecine
Telecine emulates the method of color correction done in a telecine film to tape 

transfer suite. Hue, saturation, brightness, contrast, gamma and pedestal 

values of the overall image can be adjusted as well as separately in user 

definable shadow, midtone and highlight areas.

Temperature
Temperature manipulates the temperature, cyan/magenta and brightness 

values of the overall image and separately in user definable shadow, midtone 

and highlight areas.

Go to the Color Correctors Tutorial to see how the filters work.

Category
Color.

Master, Shadows, Midtones, Highlights
All of the color correctors can adjust an image by using it’s master, shadows, 

midtones and highlight groups. The Telecine filter uses the following 

terminology: Lift (shadows), Gamma (midtones) and Gain (highlights). The 

master settings affect the entire image while adjusting parameters within the 

shadows, midtones and highlights will only affect those specific areas.
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If you are unsure about what values are included in the shadows, midtones and 

highlights, you can use the View pop-up menu. It will allow you to view the 

shadows, midtones and highlights as a black and white matte. The white areas 

are the areas that will be adjusted by that particular group. For instance, if you 

see white areas while viewing the midtones, then midtone color adjustments 

will affect only those white areas. If you want to change the default areas 

defined by the shadows, midtones and highlights, you would use the Position 

and Range sliders.

Position
The Position slider pinpoints the values to be considered as shadows, 

midtones, or highlights. A low Position value uses the darkest image values, 

while a high Position value uses the brightest.

Range
Increases or decreases the range of values considered as shadows, midtones 

or highlights. A low Range value indicates a narrow range of values, while a 

high Range value indicates a large range of values.

Go to the Matte section of Common Filter Controls to see how the Position and 

Range controls work.

Color Correct

Presets
To select a preset, pick one from the Presets window.

Hue
Rotates the hue of the image.

Original Shadows Midtones Highlights
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Saturation
Adjusts the saturation of the image. Positive values saturate, negative values 

desaturate.

Brightness
Adjusts the brightness of the image. Positive values brighten, negative values 

darken.

Contrast
Adjusts the contrast of the image. Positive values increase contrast, negative 

values decrease contrast.

Gamma 
Adjusts the gamma of the image. The gamma adjustment leaves the white and 

black points the same and only modifies the values in-between. Positive values 

lighten the midtones, negative values darken the midtones.

Temperature
Sets the color of the image to be either warmer or cooler. Dragging the slider to 

the right makes the image cooler (bluer) and dragging the slider to the left 

makes the image warmer (redder).

Cyan/Magenta
Adds either Cyan or Magenta to the image. Dragging the slider to the right 

makes the image more magenta and dragging the slider to the left makes the 

image more cyan.

Red
Adds or subtracts red from the image.

Green
Adds or subtracts green from the image.

Blue
Adds or subtracts blue from the image.
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Flashing
The Flash parameters mix a color into the image through the use of a standard 

color picker. The default color is white. What in the world is this for? It is a great 

way to add atmosphere to an element. Flash comes from the film term 

“flashing”, which describes the optical process of lowering the contrast of an 

image by flashing it with light.

Flash Amount 
Sets the opacity of the Flash Color. 

Flash Color
The Flash Color can be set through the use of a standard color picker.

Color Wheels
The Color Wheel window allows you to adjust the color of the brightness, hue 

and saturation of the master, shadows, midtones and highlights.
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The color wheels have the following controls:

Hue/Saturation (Center Point)
As the center point is moved, both Hue and Saturation are adjusted.

Hue Rotate
Dragging the colored dash on the outside of the wheel rotates the hue.

Saturation
Increases or decreases the selected color’s saturation.

Brightness
Adjusts the brightness.

Note: The Hue and Saturation adjustments are achieved by simultaneously changing 
the Red, Green and Blue parameters in the respective group: Master, Shadows, 
Midtones, or Highlights. The current Red, Green and Blue values are displayed below 
the Color Wheel.

Reset
Right-clicking on any color wheel will open a context menu that contains Reset 

> All, Shadows, Midtones, and Highlights options.

F-Stop

Input is Linear
Enable this if your image is in true linear color space. Gamma corrected images 

should have this parameter disabled.

Saturation Offset

Brightness
Hue/Saturation

Hue Rotate

Red, Green, Blue Value Display
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Red Exposure
Adds or subtracts red from the image.

Green Exposure
Adds or subtracts green from the image.

Blue Exposure
Adds or subtracts blue from the image.

Gang
The Red, Blue and Green Exposure slider values can be ganged together. 

When ganged, drag any exposure slider to affect all three values.

Printer Points
The Red, Green and Blue Exposure are set to a value of 25 which represent no 

adjustment. Printer “lights” or points set to 25, 25, 25 are considered to be the 

normal or standard printer setup at most motion picture labs.

Input is Linear
Enable this if your image is in true linear color space. Gamma corrected images 

should have this parameter disabled by default.

Red Exposure
Adds or subtracts red from the image. As in motion picture printing, higher 

values subtract and lower values add.

Green Exposure
Adds or subtracts green from the image. As in motion picture printing, higher 

values subtract and lower values add.

Blue Exposure
Adds or subtracts blue from the image. As in motion picture printing, higher 

values subtract and lower values add.

Gang
The Red, Blue and Green Exposure slider values can be ganged together. 

When ganged, drag any Exposure slider to affect all three values.
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Telecine

Hue
Rotates the hue of the image.

Saturation
Adjusts the saturation of the image. Positive values saturate, negative values 

desaturate.

Brightness
Adjusts the brightness of the image. Positive values brighten, negative values 

darken.

Contrast
Adjusts the contrast of the image. Positive values increase contrast, negative 

values decrease contrast.

Gamma 
Adjusts the gamma of the image. The gamma adjustment leaves the white and 

black points the same and only modifies the values in-between. Positive values 

lighten the midtones, negative values darken the midtones.

Pedestal
Adjusts the black level of the image.

Temperature

Presets
To select a preset, pick one from the Presets window.

Temperature
Sets the color of the image to be either warmer or cooler. Dragging the slider to 

the right makes the image cooler (bluer) and dragging the slider to the left 

makes the image warmer (redder).
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Cyan/Magenta
Adds either Cyan or Magenta to the image. Dragging the slider to the right 

makes the image more magenta and dragging the slider to the left makes the 

image more cyan.

Brightness
Adjusts the brightness of the image.
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 COLOR GRADIENT

Description
Color Gradient colors and or darkens only a portion of the image giving you the 

ability to simulate any Color Gradient filter. Presets for your favorite color 

gradient filters are provided as well as the ability to create custom colors. There 

is a graduated transition for a smooth color blend between the 

colored/darkened portion and the original image. Color Gradient is especially 

useful for changing and enhancing the color of the sky.

Go to the Color Gradient Tutorial to see how the filter works.

Category
Grads/Tints.

Filters

Presets
To select a preset, pick one from the Presets window.

Color
The Color parameter sets the color of the grad through the use of a standard 

color picker.

Before After

Photo by Joshua Earle on Unsplash
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Opacity
Sets the opacity of the color filter.

Preserve Highlights
Preserves the white areas of the image.

Exposure Compensation
Exposure Compensation adds back the brightness loss as a result of the filter 

application.

Grad
Grad is the transition area that goes from the tinted image to the original image. 

Its direction, corners and size can be adjusted. Go to the Grad section of 

Common Filter Controls to see how the Grad controls work.
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 COLOR INFRARED

Description
Color Infrared simulates infrared filters used in conjunction with infrared 

sensitive film or sensors to produce very interesting false-color images with a 

dreamlike or sometimes lurid appearance.

Go to the Color Infrared Tutorial to see how the filter works.

Category
Special Effects.

Controls

Presets
To select a preset, pick one from the Presets window.

Magenta
Adjusts the amount of magenta.

Blue
Adjusts the amount of blue.

Hue
Adjusts the hue in any non-blue areas.

Before After

Photo by Karsten Wurth on Unsplash
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Contrast
Adjusts the contrast of the image.
DFT User Guide    
• 
• 
•
•
•



• 

Color Shadow  340 

• 
• 
• 
•
•
•

 COLOR SHADOW

Description
Creates a high contrast image overlayed with a gradient.

Go to the Color Shadow Tutorial to see how the filter works.

Category
Special Effects

Controls

Presets
To select a preset, pick one from the Presets window.

Threshold
Sets the amount of image detail.

Invert
Changes whether the gradient is in the background or foreground. 

Before After

Photo by Emre Karatas on Unsplash
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Background Color
Sets the color of the background. Select the desired color using the color 

picker.

Color 1
Sets the color for the top half of the image. Select the desired color using the 

color picker.

Color 2
Sets the color for the bottom half of the image. Select the desired color using 

the color picker.

Grad 
Grad is the transition area between the two colors. Its direction, corners and 

size can be adjusted. Go to the Grad section of Common Filter Controls to see 

how the Grad controls work.
DFT User Guide    
• 
• 
•
•
•



• 

Color Spot  342 

• 
• 
• 
•
•
•

 COLOR SPOT

Description
Tints the image using presets for common photographic filters except for a 

center spot which retains normal color. The center spot can be moved, sized 

and the amount of blur can be controlled.

Go to the Color Spot Tutorial to see how the filter works.

Category
Grads/Tints.

Controls

Presets
To select a preset, pick one from the Presets window.

Color
Color
The Color parameter sets the color through the use of a standard color picker.

Opacity
Sets the opacity of the color filter.

Preserve Highlights
Preserves the white areas of the image.

Before After

Photo by Bill Williams on Unsplash
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Exposure Compensation
Exposure Compensation adds back the brightness loss as a result of the filter 

application.

Spot
A spot in the form of a radial gradient is used to control where color is added to 

the image. Go to the Spot section of Common Filter Controls to see how the 

Spot controls work.
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 COLORIZE GRADIENT

Description
Using multiple colors, Colorize Gradient colorizes the image according to the 

image’s brightness values. 

Go to the Colorize Gradient Tutorial to see how the filter works.

Category
Grads/Tints.

Controls

Presets
To select a preset, pick one from the Presets window.

Opacity
Sets the overall opacity of the colorization.

Shadows
Enable
Determines whether or not the color contributes to the gradient.

Before After

Photo by David Marcu on Unsplash
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Color
Picks the color that the image will be colorized with. Select the desired color 

using the color picker.

Position
Determines where the colorization is applied to the image. By default, Shadows 

are set to 0, which is the shadow areas. A value of 50 would be the midtones, 

while 100 would be highlights.

Midtones
The Midtones controls are the same as the controls for the Shadows, except by 

default, the colorization is applied to the midtones of the image.

Highlights
The Highlights controls are the same as the controls for the Shadows, except 

by default, the colorization is applied to the highlights of the image.

Grad
You can optionally use a gradient that limits where the filter is applied. Grad is 

the transition area that goes from the colorized image to the original image. Its 

direction, corners and size can be adjusted. Go to the Grad section of Common 

Filter Controls to see how the Grad controls work.
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 CROSS PROCESSING

Description
Cross-processing is a photographic technique where print film (C41) is 

processed in the set of chemicals usually used to process slide film (E6) or vice 

versa. The final result yields images with oddly skewed colors and increased 

contrast and saturation. Different film stocks produce different results, so we 

have created what we feel is a representative look.

Go to the Cross Processing Tutorial to see how the filter works.

Category
Film Lab.

Controls

Presets
To select a preset, pick one from the Presets window.

Amount
Sets the intensity of the cross process effect.

Mode
Print to Slide
Simulates the effect of print film (C41) being processed in slide (E6) chemicals.

Before After

Photo by Jesse Collins on Unsplash
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Slide to Print
Simulates the effect of slide film (E6) being processed in print (C41) chemicals.
DFT User Guide    
• 
• 
•
•
•



• 

Curves  348 

• 
• 
• 
•
•
•

 CURVES

Description
Curves adjusts the entire tonal range of an image by changing the shape of 

RGB, Red, Green or Blue curves. Curve points can be adjusted throughout the 

range of shadows to highlights.

Category
Color.

Go to the Curves Tutorial to see how the filter works.

Before After

Photo by Annie Spratt on Unsplash
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Controls

Curves

RGB
Adjusts the RGB values and has the effect of brightening or darkening the 

image.

Red
Adjusts the red values in the image.

Green
Adjusts the green values in the image.

Blue
Adjusts the blue values in the image.

Adjust Black

Adjust White

Adjust Gray

Curve Type
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Selecting Curves

• Select RGB, Red, Green or Blue from the Curve Type pop-up menu.

• Click directly on an existing curve in the graph to select it.

Adding and Deleting Points:

• Click directly on the curve to add a new point. Up to five points can be added.

• Points can be deleted by clicking and dragging a point to the edge of the graph.

Adjusting Points:

• Moving a point in the top portion of the curve adjusts the shadows.

• Moving a point in the center of the curve adjusts the midtones.

• Moving a point in the top portion of the curve adjusts the highlights.

• Moving the curve upward or downward lightens or darkens the image. The steeper 
sections of the curve represent areas of higher contrast; flatter sections represent 
areas of lower contrast.

• To darken highlights, move a point near the top of the curve downward. Moving a 
point either down or to the right maps the input value to a lower output value, and 
the image darkens. 

• To lighten the shadows, move a point near the bottom of the curve upward. Moving 
a point either up or to the left maps a lower input value to a higher output value, 
and the image lightens.

Sliders

RGB
Globally adjusts the RGB curve.

Red
Globally adjusts the Red curve.

Green
Globally adjusts the Green curve.
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Blue
Globally adjusts the Blue curve.
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 DAY FOR NIGHT

Description
Day for Night simulates a technique used for shooting exteriors in daylight 

made to look like they were photographed at night. Typically, it involves 

underexposing by two to two-and-a-half stops and using a filter to provide a tint, 

that is often a lavender-blue, as it mimics twilight and appears to emulate the 

mood of moonlight.

Go to the Day for Night Tutorial to see how the filter works.

Category
Special Effects.

Controls

Presets
To select a preset, pick one from the Presets window.

Diffusion
Blur
Sets how much the image is diffused.

Before After

Photo by Daniel Bowman on Unsplash
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Opacity
Sets the amount of diffusion mixed into the original image. The higher the 

setting, the more the image is blurred.

Moonlight
Color
The Color parameter sets the color of the moonlight through the use of a 

standard color picker. The default color is blue.

Opacity
Sets the opacity of the moonlight color.

Preserve Highlights
Preserves the white areas of the image.

Exposure Compensation
Exposure Compensation adds back the brightness loss as a result of the color 

application.

Color Correct
Go to the Color Correct filter to see how the Color Correct controls work.
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 DEBAND

Description
DeBand removes banding artifacts from an image by smoothing pixels in 

banded areas while retaining detail.

Category
Image.

Controls

Presets
To select a preset, pick one from the Presets window.

Amount
Sets the amount of debanding.

Before After

Photo by Frantzou Fleurine on Unsplash
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 DEBLOCK

Description
Blocking artifacts created as a result of high compression factors can be 

removed with the DeBlock filter.

Category
Image.

Controls
There are no controls for the DeBlock filter since it automatically finds blocks 

and removes them.

Before After

Photo by Nolan Issac on Unsplash
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 DEFOG

Description
Using advanced deweathering algorithms, Defog restores clear day contrasts 

and colors of a scene taken in bad weather such as fog and mist. It is also 

successful in removing the effects of optical Fog and Diffusion filters.

Go to the Defog Tutorial to see how the filter works.

Category
Special Effects.

Controls

Presets
To select a preset, pick one from the Presets window.

Defog
Color
The Color parameter sets the color of the fog to be removed through the use of 

a standard color picker. The default color is white.

Before After

Photo by Matt Hoffman on Unsplash
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Vanishing Point
A vanishing point along the direction of increasing distance in the image is used 

to remove fog. By default, the vanishing point is set to the center of the screen. 

Essentially, the fog is removed in a radial pattern emanating from the vanishing 

point. So at the default center position, fog is removed in a circular pattern with 

a greater amount of fog being removed from the center while falling off at the 

edges. For instance, if your fog moves in the direction of top right to bottom left, 

set your vanishing point towards the top right corner and the fog removal will 

be more intense at the upper right and fall off at the bottom left. However, in 

most cases, the vanishing point can be left in the center of the screen and you 

will obtain acceptable results.

There is an on-screen control in the center of the image. By clicking and 

dragging the on-screen control, the position of the vanishing point can be 

adjusted.

Defog
Sets the amount of fog to be removed from the scene.

Min Depth
Controls how much fog is removed from the darker areas of the image.

Max Depth
Controls how much fog is removed from the brighter areas of the image.

Color Correct
Go to the Color Correct filter to see how the Color Correct controls work.
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 DEFRINGE

Description
Purple or blue fringing around overexposed areas is a result of sensor 

overloading in video as well as digital still cameras. DeFringe isolates and 

removes the various types of color fringing.

Go to the DeFringe Tutorial to see how the filter works.

Category
Lens.

Controls

Presets
To select a preset, pick one from the Presets window.

Red
Red
Adjusts the saturation of red values in areas defined by the Position and Range 

controls. Positive values saturate, negative values desaturate.

Position
A matte is generated to isolate red fringing. The areas that are white in the red 

matte are the areas that will be defringed. Moving the Position slider will change 

the hue that is used for the red matte.

Before After
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Range
Increases or decreases the range of values considered as red fringing. A low 

Range value indicates a narrow range of values, while a high Range value 

indicates a large range of values.

Go to the Matte section of Common Filter Controls to see how the Position and 

Range controls work.

Green, Blue, Cyan, Magenta, and Yellow
The Green, Blue, Cyan, Magenta and Yellow groups work in a similar fashion 

to the Red group.
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 DENOISE

Description
Removes film grain and noise.

Category
Image.

Controls

Presets
To select a preset, pick one from the Presets window.

Amount
Sets the amount of denoising.

Warning: You may not see an accurate representation of the grain and noise removal 
in the Viewer unless you use the Magnifier with this filter.

Before After
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 DEPTH OF FIELD

Description
Depth of Field can be added to a scene by isolating and blurring only a portion 

of the image. The amount of blurring is directly proportionate to the luminance 

of the matte settings, a gradient or an input image.

Go to the Depth of Field Tutorial to see how the filter works.

Category
Lens.

Controls

Presets
To select a preset, pick one from the Presets window.

Depth
Selects the source for the selective blur effect.

Matte
Use a matte for the depth source.

Grad
Use a gradient for the depth source.

Before After

Photo by Ethan Robertson on Unsplash
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Input
Use an image as the depth source. This is useful for 3D programs which render 

out depth mattes.

To use an image as the depth source:

• Change Depth > Depth to Input. 

• Click the Depth > Input > Browse button.

• Select a file.

Blur
Sets how much the image is blurred.

Grad 
Depth of Field can optionally use a gradient that limits where the filter is applied. 

Grad is the transition area that goes from the blurred portion to the original 

image. Its direction, corners and size can be adjusted. Go to the Grad section 

of Common Filter Controls to see how the Grad controls work.

Matte
A matte can be used to create the depth of field effect. Go to the Matte section 

of Common Filter Controls to see how the Matte controls work.
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 DETAIL

Description
Detail presents a new technique for performing selective sharpening, detail 

enhancement and edge aware smoothing. Our approach decomposes the 

image into three detail layers: Coarse, medium and fine. Each of the detail 

layers can be manipulated separately in various ways, for instance, sharpening 

or smoothing. Add to that sophisticated, but easy to use masking and you have 

quick isolation of image features for selective filtering.

Go to the Detail Tutorial to see how the filter works.

Category
Image.

Smooth Sharpen

Photo by Chris Lawton on Unsplash
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Controls

Coarse
Adjusts the Coarse detail layer. Increasing the value sharpens while decreasing 

the value smooths.

Medium
Adjusts the medium detail layer. Increasing the value sharpens while 
decreasing the value smooths.

Fine
Adjusts the fine detail layer. Increasing the value sharpens while decreasing the 
value smooths.

Gang
The Coarse, Medium and Fine slider values can be ganged together so that 

they all move simultaneously. This will generate an overall sharpening effect if 

the sliders are increased and an overall smoothing effect if decreased.

Note: Since Detail works at a proxy resolution, you will need to view the result of Detail 
at a 1:1 pixel ratio using the Magnifier window to determine what the final output will 
look like.

Matte
A matte can be used to limit the detail effect. Wherever there is white in the 

matte is where the detail adjustment will occur. Go to the Matte parameters to 

see how they work.
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 DEVELOP

Description
Provides useful developing controls for globally adjusting the color and tonal 

scale of your images.

Category
Color.

Controls

Auto-Equalize
Auto-Equalize uses the calculated white point for camera RAW images. This is 

disabled when Develop is applied to non camera RAW images, since adjusting 

the white point does nothing in this case.

Temperature
Sets the color of the image to be either warmer or cooler. Dragging the slider to 

the right makes the image cooler (bluer) and dragging the slider to the left 

makes image warmer (redder).

Before After

Photo by Mahir Uysal on Unsplash
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Tint
Adds either Green or Magenta to the image. Dragging the slider to the right 

makes the image more magenta and dragging the slider to the left makes the 

image more green.

Exposure
Sets the overall image brightness, with a greater effect in the high values. 

Adjust the slider until the image looks good and the whites are at the right level. 

Use Recovery to bring highlight values down. Exposure values are in 

increments equivalent to f-stops. An adjustment of +1.00 is similar to increasing 

the aperture 1 stop. Similarly, an adjustment of –1.00 is similar to reducing the 

aperture 1 stop.

Recovery
Reduces the tones of extreme highlights and attempts to recover highlight 

detail lost because of overexposure.

Fill Light
Lightens shadows to reveal more detail while maintaining blacks. Take care not 

to over apply the setting and reveal image noise.

Blacks
Specifies which image values map to black. Moving the slider to the right 

increases the areas that become black, sometimes creating the impression of 

increased image contrast. The greatest effect is in the shadows, with much less 

change in the midtones and highlights.

Brightness
Adjusts image brightness, mainly affecting midtones. Set the overall tonal scale 

by setting Exposure, Recovery, and Blacks. Then set the overall image 

brightness. Large brightness adjustments can affect shadow or highlight 

clipping, so you may want to readjust the Exposure, Recovery, or Blacks slider 

after adjusting brightness.
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Contrast
Increases or decreases image contrast, mainly affecting midtones. When you 

increase contrast, the middle-to-dark image areas become darker, and the 

middle-to-light image areas become lighter. The image tones are inversely 

affected as you decrease contrast.

Vibrance
Adjusts the saturation so that clipping is minimized as colors approach full 

saturation, changing the saturation of all lower-saturated colors with less effect 

on the higher-saturated colors. Vibrance also prevents skin tones from 

becoming over saturated.

Saturation
Adjusts the saturation of all image colors equally.
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 DIFFUSION

Description
Diffusion creates atmosphere by reducing contrast while creating a glow 

around highlights or shadows using an extensive texture library.

Go to the Diffusion Tutorial to see how the filter works.

Category
Diffusion.

Controls

Presets
To select a preset, pick one from the Presets window.

Diffusion
Blend
Determines the blend mode to be used to create the diffusion effect.

Add
The diffusion is added to your image.
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Screen
The diffusion is combined with the image using a Screen blend mode. This 

looks kind of like the Add blend mode, but highlights are retained.

Brightness
Sets the intensity of the diffusion.

Blur
Sets the softness of the diffusion.

Color
The Color parameter sets the color of the diffusion through the use of a 

standard color picker. The default color is white.

Color Correct
Go to the Color Correct filter to see how the Color Correct controls work.

Texture
Texture
Selects the texture which will be used to add diffusion to the image.

Blend
Textures can be used as the source of the diffusion as well as combined with a 

matte using a variety of Blend modes. Go to Blend Modes for explanations of 

the various modes.

I like the Multiply blend mode for combining textures with the matte because it 

only puts the texture within the areas of the generated matte.

Transform
Transform the texture using Position, Scale, Rotate, Corner-Pin, Shear and 

Crop controls. Go to the Transform section of Common Filter Controls to see 

how the Transform Controls work.

Matte
A matte can be used to create the diffusion effect. Go to the Matte section of 

Common Filter Controls to see how the Matte controls work.
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 DOUBLE FOG

Description
The Double Fog filter creates a soft, misty atmosphere over the image by first 

applying fog using a vanishing point along the direction of increasing distance 

in the image. Then, a second pass blooms image highlights. 

Go to the Double Fog Tutorial to see how the filter works.

Category
Diffusion.

Controls

Presets
To select a preset, pick one from the Presets window.

Fog
Color
The Color parameter sets the color of the fog to be added through the use of a 

standard color picker. The default color is white.

Before After
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Vanishing Point
A vanishing point along the direction of increasing distance in the image is used 

to add fog. By default, the vanishing point is set to the center of the screen. 

Essentially, the fog is added in a radial pattern emanating from the vanishing 

point. So at the default center position, fog is added in a circular pattern with a 

greater amount of fog being added in the center while falling off at the edges. 

For instance, if you would like your fog to move in the direction of top right to 

bottom left, set your vanishing point towards the top right corner and the fog will 

be more intense at the upper right and fall off at the bottom left. However, in 

most cases, the vanishing point can be left in the center of the screen and you 

will obtain acceptable results. 

There is an on-screen control in the center of the image. By clicking and 

dragging the on-screen control, the position of the vanishing point can be 

adjusted.

Fog
Sets the amount of fog to be added to the scene.

Min Depth
Controls how much fog is added in the darker areas of the image.

Max Depth
Controls how much fog is added in the brighter areas of the image.

Glow
The Glow controls are used to add additional atmosphere and are useful in 

adding glow to highlights. By default, a wide matte of highlights are glowed in 

the image and blended with the Screen blend mode. This works well for adding 

additional fog. To add glow around highlights such as light sources, it is best to 

set the Blend mode to Add and lower the Matte > Range parameter to limit the 

areas of glow to only include the light sources.

Blend
Determines the blend mode to be used to create the glow effect.
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Add
The glow is added to your image.

Screen
The glow is combined with the image using a Screen blend mode. This looks 

kind of like the Add blend mode, but highlights are retained.

Brightness
Sets the intensity of the glow.

Blur
Sets the softness of the glow.

Color
The Color parameter sets the color of the glow through the use of a standard 

color picker. The default color is white.

Matte
A matte is used to create the glow effect. Go to the Matte section of Common 

Filter Controls to see how the Matte controls work.
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 DUAL GRADIENT

Description
Dual Gradient applies two photographic filters to the image which are blended 

together with a gradient. Presets for your favorite Color Gradient filters are 

provided as well as the ability to create custom colors.

Go to the Dual Gradient Tutorial to see how the filter works.

Category
Grads/Tints.

Controls

Presets
To select a preset, pick one from the Presets window.

Color 1
Sets the color for the top half of the image. Select the desired color using the 

color picker or choose a filter preset.

Presets
Select one of the filters from the pop-up menu.
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Color
The Color parameter sets the color of the grad through the use of a standard 

color picker.

Opacity
Sets the opacity of the color filter.

Color 2
The Color 2 controls are the same as the controls for Color 1 except it is applied 

to the bottom half of the image.

Preserve Highlights
Preserves the white areas of the image.

Exposure Compensation
Exposure Compensation adds back the brightness loss as a result of the filter 

application.

Grad 
Grad is the transition area between the two tints. Its direction, corners and size 

can be adjusted. Go to the Grad section of Common Filter Controls to see how 

the Grad controls work.
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 ENHANCING

Description
Selectively enhance any color to make it pop with little to no effect on other 

colors.

Go to the Enhancing Tutorial to see how the filter works.

Category
Color.

Controls

Presets
To select a preset, pick one from the Presets window.

Enhancing
Adjusts the saturation of red, green or blue hues.

Matte
Presets
A matte is created based on the hue of the image to create the enhancement 

effect. Select from Red, Green or Blue preset hue mattes from the pop-up 

menu or use the Hue eyedropper to pick a color off of the screen.
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Hue
When adjusting the Hue parameter, you are selecting the hue of the image 

which will be enhanced.

Range
Increases or decreases the range of values in the hue matte. A low Range 

value indicates a narrow range of values. A high Range value indicates a large 

range of values included in the matte.

Blur
Sets the softness of the matte by using a fast, quality blur.

Go to the Matte parameters to see how they work.
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 EYE LIGHT

Description
Creates a targeted light to be placed around a person's eyes.

Go to the Eye Light Tutorial to see how the filter works.

Category
Light.

Controls

Light
Blend
Determines the blend mode to be used to add the light.

Add
The light is added to your image.

Screen
The light is combined with the image using a Screen blend mode. This looks 

kind of like the Add blend mode, but highlights are retained.

Brightness
Sets the intensity of the light.
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Blur
Sets the softness of the light.

Gels
Photographers, cinematographers and lighting designers use colored filters or 

gels in front of lights. Whatever mood you wish to create, we have the colors 

needed to achieve the effect. Select one of the Gels presets from the pop-up 

menu.

Color
Sets the color of the light through the use of a standard color picker.

Shadow
Brightness
Sets the intensity of the shadows. The Brightness parameter will darken only 

those areas that are not being brightened by the Light settings. 

Transform
Transform the eye light pattern using Scale and Rotate controls. Go to the 

Transform section of Common Filter Controls to see how the Transform 

Controls work.
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 FAN RAYS

Description
Generates asymmetric fanned rays.

Go to the Fan Rays Tutorial to see how the filter works.

Category
Light.

Controls

Blend
Determines the blend mode used to create the rays effect.

Add
The rays are added to your image.

Screen
The rays are combined with the image using a Screen blend mode. This looks 

kind of like the Add blend mode, but highlights are retained.
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Brightness
Controls the brightness.

Color
Sets the color.

Scale
Changes the size.

Aspect
Sets the aspect ratio.

Angle
Sets the angle.

Element Count
Determines the number of rays.

Softness
Blurs the rays.

Randomize 
Randomizes the size and position.

Jitter
Randomizes the angle.
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 FILM STOCKS

Description
Film Stocks is a unique filter that simulates 294 different color and black 

and white still photographic film stocks, motion picture films stocks and 

historical photographic processes.

Go to the Film Stocks Tutorial to see how the filter works.

Category
Film Lab.

Controls

Presets
To select a preset, pick one from the Presets window. If you would like to view 

presets from a different category, use the pop-up menu at the top left of the 

Presets window.

Amount
Sets the amount of the selected preset.

Black and White
Red, Green and Blue controls allow you to determine the contribution of each 

color channel in the black and white conversion.
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Enable
Enables the Black and White conversion.

Red
Sets the amount of the red channel that contributes to the black and white 

conversion.

Green
Sets the amount of the green channel that contributes to the black and white 

conversion.

Blue
Sets the amount of the blue channel that contributes to the black and white 

conversion.

Film Response
To mimic the characteristics of a particular film stock, a combination of settings 

for the RGB channels have been set.
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Curves
You can use Curves to adjust the entire tonal range of an image by changing 

the shape of the curve in the Curves adjustment. The Curves adjustment lets 

you adjust points throughout the tonal range of an image (from shadows to 

highlights).

Note: Curves are only available in the DFT interface.

Selecting Curves

• Select RGB, Red, Green or Blue from the Curve Type pop-up menu.

• Click directly on an existing curve in the graph to select it.

Adding and Deleting Points:

• Click directly on the curve to add a new point. Up to five points can be added.

• Points can be deleted by clicking and dragging a point to the edge of the graph.

Adjusting Points:

• Moving a point in the top portion of the curve adjusts the shadows.

• Moving a point in the center of the curve adjusts the midtones.

Adjust Black

Adjust White

Adjust Gray

Curve Type
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• Moving a point in the top portion of the curve adjusts the highlights.

• Moving the curve upward or downward lightens or darkens the image. The steeper 
sections of the curve represent areas of higher contrast; flatter sections represent 
areas of lower contrast.

• To darken highlights, move a point near the top of the curve downward. Moving a 
point either down or to the right maps the input value to a lower output value, and 
the image darkens. 

• To lighten the shadows, move a point near the bottom of the curve upward. Moving 
a point either up or to the left maps a lower input value to a higher output value, 
and the image lightens.

RGB
Controls the RGB film response curve. If you are using a black and white 

preset, the grayscale film response curve will be adjusted.

Red
Controls the Red film response curve.

Green
Controls the Green film response curve.

Blue
Controls the Blue film response curve.

Color Correct
Color Correct manipulates the Temperature, Cyan/Magenta, Brightness, 

Contrast, Shadow, Midtone, Highlight, and Saturation values of the image. Go 

to the Color Corrector filters to see how it works.

Filter
Adds a color filter to the image.

Presets
Select one of the filters from the pop-up menu.

Color
Sets the color through the use of a standard color picker.
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Opacity
Sets the opacity of the color filter.

Highlights
Preserves the white areas of the image.

Sharpen
Amount
Determines how much contrast is added at the edges.

Radius
Controls the size of the edges you wish to sharpen.

Threshold
The threshold setting is used to sharpen more pronounced edges, while 

leaving more subtle edges untouched. Low values sharpen more image areas 

while higher threshold values sharpen less.

Diffusion
Blend
Determines the blend mode to be used to create the diffusion/glow effect.

Add
The diffusion/glow is added to your image.

Normal
The diffusion is mixed with the original image. In this mode, the Amount slider 

only shows changes up to a value of 100.

Screen
The diffusion/glow is combined with the image using a Screen blend mode. 

This looks kind of like the Add blend mode, but highlights are retained.

Amount
Sets the amount of diffusion.

Blur
Sets the softness of the image.
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Color
The Color parameter sets the color of the diffusion/glow through the use of a 

standard color picker or eyedropper. The default color is white.

Position
When using the Add and Screen blend modes, Position selects the values used 

to create the glow effect. A higher Position value uses the brightest image 

values to create the glow. A lower Position value uses the darkest image values 

to create the glow.

Range
When using the Add and Screen blend modes, Range controls the range of 

values to be used for the glow. Once you’ve selected the “Position”, you can 

then add or subtract the “Range” of values to be used in the glow source. A 

higher Range value includes more values in the glow source while a lower 

Range value includes less values.

Vignette
A vignette is a popular photographic effect where the photo gradually fades into 

a color. Go to the Vignette filter to see how it works.

Grain
Grain simulates film grain with control of the size, softness and intensity. In 

addition, a Film Response parameter controls where you will see grain in the 

image. Go to the Grain filter to see how it works. 

Warning: You may not see the grain size change in the Viewer unless you use 

the Magnifier with this filter.
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 FLAG / DOT

Description
Flags and Dots are rectangular and circular lighting control devices used to 

create shadow areas on a motion picture or photographic set. This concept has 

been extended to digital so that areas of the image can be selectively 

darkened.

Go to the Flag / Dot Tutorial to see how the filters work.

Category
Light.

Controls

Flag / Dot
Brightness
Sets the intensity of the flag or dot.

Blur
Sets the softness of the flag or dot.
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Transform
Transform the flag or dot shape using Scale and Rotate controls. Go to the 
Transform section of Common Filter Controls to see how the Transform 
Controls work.
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 FLASHING

Description
Flashing allows you to use photographic filters to lower the contrast of your 

shadows or highlights. The motion picture lab can expose a small amount of 

light to the film at various stages of the developing and printing process. For 

example, Negative plus Dupe Negative flashing lifts blacks, while Print plus 

Master Positive flashing softens whites.

Go to the Flashing Tutorial to see how the filter works.

Category
Film Lab.

Controls

Presets
To select a preset, pick one from the Presets window.

Shadows
Brightness
Raises the brightness of the shadows using either the Shadow > Color or 

Shadow > Presets.

Presets
Select one of the filters from the pop-up menu.
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Color
The Color parameter sets the color of the flashing through the use of a standard 

color picker.

Position
Selects the shadow values to be adjusted.

Range
Controls the range of values to be used for the shadows. A higher Range value 

considers more values as shadows. 

Highlights
Brightness
Lowers the brightness of the highlights using either the Highlights > Color or 

Highlights > Presets.

Presets
Select one of the filters from the pop-up menu.

Color
The Color parameter sets the color of the flashing through the use of a standard 

color picker.

Position
Selects the highlight values to be adjusted.

Range
Controls the range of values to be used for the highlights. A higher Range value 

considers more values as highlights.

Go to the Matte section of Common Filter Controls to see how the Position and 

Range controls work.
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 FLUORESCENT

Description
Removes the green cast caused by fluorescent bulbs.

Go to the Fluorescent Tutorial to see how the filter works.

Category
Color.

Controls

Presets
To select a preset, pick one from the Presets window.

Temperature
Removes the greenish tone caused by photographing under fluorescent lights.
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 FOG

Description
The Fog filter creates a soft, misty atmosphere over the image and glows 

highlights.

Go to the Fog Tutorial to see how the filter works.

Category
Diffusion.

Controls

Presets
To select a preset, pick one from the Presets window.

Fog
Blend
Determines the blend mode to be used to create the fog effect.

Add
The fog is added to your image.

Screen
The fog is combined with the image using a Screen blend mode. This looks kind 

of like the Add blend mode, but highlights are retained.
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Brightness
Sets the intensity of the fog.

Blur
Sets the softness of the fog.

Color
The Color parameter sets the color of the fog through the use of a standard 

color picker. The default color is white.

Matte
A matte is used to create the fog effect. Go to the Matte section of Common 

Filter Controls to see how the Matte controls work.
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 FROST

Description

Frost
Frost glows highlights and reduces contrast while softening facial blemishes 

and wrinkles.

Black Frost
Black Frost offers all the benefits of the Frost filter in a more subtle form. This 

filter subtly controls highlights, reduces contrast and provides a harder look 

than the Frost filter, while suppressing facial blemishes and wrinkles.

Go to the Frost Tutorial to see how the filters work.

Category
Diffusion.
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Controls

Presets
To select a preset, pick one from the Presets window. If you would like to view 

presets from a different category, use the pop-up menu at the top left of the 

Presets window.

Detail
Smoothing
Fine image details, such as facial wrinkles and blemishes, are minimized using 

edge aware smoothing.

Mist
The Mist controls add a mild glow to image highlights.

Blend
Determines the blend mode to be used to create the mist effect.

Add
The mist is added to your image.

Screen
The mist is combined with the image using a Screen blend mode. This looks 

kind of like the Add blend mode, but highlights are retained.

Brightness
Sets the intensity of the mist.

Blur
Sets the softness of the mist.

Color
Sets the color of the mist.

Color Correct
Go to the Color Correct filter to see how the Color Correct controls work.
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Matte
A matte is used to create the mist effect. Go to the Matte section of Common 

Filter Controls to see how the Matte controls work.
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 GELS

Description
Photographers, cinematographers and lighting designers use colored filters or 

gels in front of lights. Whatever mood you wish to create, we have the colors 

needed to achieve the effect.

Go to the Gels Tutorial to see how the filter works.

Category
Grads/Tints.

Controls

Presets
To select a gel, pick one from the Presets window. If you would like to view 

presets from a different category, use the pop-up menu at the top left of the 

Presets window.

Color
Color
The Color parameter sets the color through the use of a standard color picker.

Opacity
Sets the opacity of the color filter.
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Preserve Highlights
Preserves the white areas of the image.

Exposure Compensation
Exposure Compensation adds back the brightness loss as a result of the gel 

application.

Grad 
Gels can optionally use a gradient that limits where the filter is applied. Grad is 

the transition area between the colored portion and the original image. Its 

direction, corners and size can be adjusted. Go to the Grad section of Common 

Filter Controls to see how the Grad controls work.
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 GLOW

Description
The Glow filter creates glows around selected areas of the image.

Go to the Glow Tutorial to see how the filter works.

Category
Light.

Controls

Presets
To select a preset, pick one from the Presets window.

Glow
Blend
Determines the blend mode to be used to create the glow effect.

Add
The glow is added to your image.

Screen
The glow is combined with the image using a Screen blend mode. This looks 

kind of like the Add blend mode, but highlights are retained.
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Brightness
Sets the intensity of the glow.

Blur
Sets the softness of the glow.

Color
The Color parameter sets the color of the glow through the use of a standard 

color picker. The default color is white.

Color Correct
Go to the Color Correct filter to see how the Color Correct controls work.

Matte
A matte is used to create the glow effect. Go to the Matte section of Common 

Filter Controls to see how the Matte controls work.
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 GLOW DARKS

Description
Glows and grows the darks areas of the image.

Go to the Glow Darks Tutorial to see how the filter works.

Category
Light.

Controls

Presets
To select a preset, pick one from the Presets window.

Glow
Amount
Sets the intensity of the glow.

Blur
Sets the softness of the glow.

Color Correct
Go to the Color Correct filter to see how the Color Correct controls work.

Before After

Photo by Ariel Lustre on Unsplash
DFT User Guide    
• 
• 
•
•
•



• 

Glow Darks  402 

• 
• 
• 
•
•
•

Matte
A matte is used to create the glow effect. Go to the Matte section of Common 

Filter Controls to see how the Matte controls work.
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 GLOW EDGES

Description
Glow Edges isolates lines and edges in an image and then adds glow only to 

these areas resulting in a stylized look.

Go to the Glow Edges Tutorial to see how the filter works.

Category
Light.

Controls

Presets
To select a preset, pick one from the Presets window.

Glow
Blend
Determines the blend mode to be used to create the edge glow effect.

Add
The edge glow is added to your image.
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Screen
The edge glow is combined with the image using a Screen blend mode. This 

looks kind of like the Add blend mode, but highlights are retained.

Brightness
Sets the intensity of the edge glow.

Blur
Sets the softness of the edge glow.

Color
The Color parameter sets the color of the edge glow through the use of a 

standard color picker. The default color is white.

Edge
An edge matte is created to produce the edge glow effect.

Brightness
Determines the brightness of the edge matte.

Blur
Blurs the edge matte.
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 GRAIN

Description
Grain simulates film grain with control of size, intensity and softness. In 

addition, a Film Response parameter controls where you will see grain in the 

image. Popular film stock presets are provided as a starting point to adding 

grain.

Go to the Grain Tutorial to see how the filter works.

Category
Film Lab.

Controls

Presets
To select a preset, pick one from the Presets window.
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Monochrome
When checked, the grain is monochrome. In this mode, only the Red Size, Red 

Amount and Red Softness sliders are active. Since the grain is monochrome, 

only one slider is needed.

Size
The Size parameter controls the size of the grain. The larger the Size setting, 

the larger the grain will be.

Warning: You may not see the grain size change in the Viewer unless you use the 
Magnifier with this filter. 

Amount
The Amount parameters set the red, green and blue intensities of the grain. 

Film stocks generally have varying amounts of red, green and blue intensities 

with the blue intensity generally higher than the rest. If you turn the red, green 

and blue amount sliders to a value of 0, the grain will disappear.

Red Amount
Controls the intensity of the red grain.

Green Amount
Controls the intensity of the green grain.

Blue Amount
Controls the intensity of the blue grain.

Softness
The Softness parameter controls the softness of the grain. Normally, only minor 

softness adjustments are necessary, usually between a value of 0-1.

Film Response
The Film Response parameter allows the adjustment of where you will see 

grain in the image. In most cases, film grain is apparent over the entire image 

except the brightest whites with the black areas being the most affected.
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Position
The Position slider defines the portions of the image where grain will be added. 

A low Position value places grain in the darkest image values, while a high 

Position value places grain in the brightest areas.

Range
Increases or decreases the area where grain is added to the image based on 

the value of the Position slider. A low Range value indicates a narrow range of 

values, while a high Range value indicates a large range of values.

Minimum
Sets the minimum level of grain that is always added to the image.

Note: A Position value of 0 and a Range of 80 is typical of standard film, with grain 
applied to the entire range except the brightest whites with black being the most 
affected.
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 GRUNGE

Description
Adds film dirt, hair, scratches, stains, splotches, vignetting and grain--all to 

make your pristine image look like damaged film.

Go to the Grunge Tutorial to see how the filter works.

Category
Film Lab.

Controls

Presets
To select a preset, pick one from the Presets window.

Randomize
Randomizes the applied elements.

Dirt
Opacity
The opacity of the dirt.

Amount
The number of pieces of dirt.

Before After

Photo by Oskar Wimmerman on Unsplash
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Size
The size of the dirt.

Type

Positive
The dirt is black as it is in positive film.

Negative
The dirt is white as it is in negative film.

Hair
Opacity
The opacity of the hair.

Amount
The number of hairs.

Size
The size of the hairs.

Type

Positive
The hair is black as it is in positive film.

Negative
The hair is white as it is in negative film.

Scratches
Opacity
The opacity of the scratches.

Amount
The number of scratches.

Width
The width of the scratches.
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Length
Randomly changes the length of the scratches.

Roughness
The roughness of the scratches.

Type

Positive
The scratches are black as they are in positive film.

Negative
The scratches are white as they are in negative film.

Stains
Opacity
The opacity of the stains.

Amount
The number of stains.

Size
The size of the stains.

Type

Positive
The stains are black as they are in positive film.

Negative
The stains are white as they are in negative film.

Splotches
Opacity
The opacity of the splotches.

Amount
The number of splotches.
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Size
The size of the splotches.

Type

Positive
The splotches are black as they are in positive film.

Negative
The splotches are white as they are in negative film.

Vignette
A vignette is a popular photographic effect where the photo gradually fades into 

a color. Go to the Vignette filter to see how it works.

Grain
Grain simulates film grain with control of the size, softness and intensity. In 

addition, a Film Response parameter controls where you will see grain in the 

image. Go to the Grain filter to see how it works. 

Warning: You may not see the grain size change in the Viewer unless you use the 
Magnifier with this filter.
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 HARRIS SHUTTER

Description
Invented by Robert S. “Bob” Harris of Kodak, the Harris Shutter was originally 

a strip device with three color filters used for making color photographs with the 

different primary color layers exposed in separate time intervals in succession. 

The same frame of film was re-exposed through red, green and blue filters in 

turn, while keeping the camera steady.

Our digital version of the Harris Shutter can use separate images for the red, 

green and blue channels or offset the individual channels of a sequence in time. 

Offsetting the channels creates a rainbow of color around any object that 

moves within the frame. Some good candidates for subjects include waterfalls, 

clouds blowing over a landscape or people walking across a busy street.

Go to the Harris Shutter Tutorial to see how the filter works.

Category
Special Effects.

Before After
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Controls

Red / Green / Blue
Source
Sets the source image to be used as the Red, Green and Blue channels. If an 

image is not assigned using Source, the original image’s color channel will be 

used.

Note: Only JPG, PNG and TIFF files can be loaded.

Amount
Controls how much of the Red, Green or Blue image is contributed to the 

composite image.
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 HAZE / SKY

Description

Haze
Reduces excessive blue by absorbing UV light and eliminates haze which 

tends to wash out color and image clarity.

Sky
Reduces UV light, haze and is pink tinted for added warmth and better colors. 

It is especially useful for images shot in outdoor open shade and on overcast 

days

Go to the Haze / Sky Tutorial to see how the filter works.

Before After

Photo by Thomas Kelley on Unsplash
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Category
Color.

Controls

Presets
To select a preset, pick one from the Presets window.

Haze
Sets the amount of haze to be removed from the scene.

Temperature
Sets the color of the image to be either warmer or cooler. Dragging the slider to 

the right makes the image cooler (bluer) and dragging the slider to the left 

makes the image warmer (redder).

Cyan/Magenta
Adds either Cyan or Magenta to the image. Dragging the slider to the right 

makes the image more magenta and dragging the slider to the left makes the 

image more cyan.

Note: Cyan/Magenta is only included in the Sky filter.
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 HIGH CONTRAST

Description
Creates an extreme high contrast image.

Go to the High Contrast Tutorial to see how the filter works.

Category
Color.

Controls

Presets
To select a preset, pick one from the Presets window.

Contrast
Sets the amount of contrast to be applied to the scene.

Amount
Sets the mix amount between the original and filtered version.

Before After
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 HOT SPOT

Description
Utilized in most lens flares, Hot Spot simulates the circular glow created when 

a light source interacts with a lens.

Go to the Hot Spot Tutorial to see how the filter works.

Category
Light.

Controls

Blend
Determines the blend mode used to create the hot spot effect.

Add
The hot spot is added to your image.

Screen
The hot spot is combined with the image using a Screen blend mode. This 

looks kind of like the Add blend mode, but highlights are retained.
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Brightness
Controls the brightness.

Inner Color
Sets the inner color.

Outer Color
Sets the outer color.

Total Scale
Adjusts the size of all elements.

Aspect
Sets the aspect ratio.

Ramp Scale
Changes the Hot Spot’s size.

Ramp Gamma
Determines the Hot Spot’s black point.

Ring Brightness
Sets the brightness of the ring.

Ring Softness
Softens the ring.

Ring Size
Changes the size of the ring.
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 ICE HALOS

Description
Ice halos are created when small ice crystals in the atmosphere generate halos 

by reflecting and refracting light. Most notably, circles form around the sun or 

moon as well as rare occurrences when the entire sky is painted with a web of 

arcing halos.

Go to the Ice Halos Tutorial to see how the filter works.

Category
Light.

Controls

Presets
To select a preset, pick one from the Presets window.

Light
Blend
Determines the blend mode to be used to add the ice halo.

Add
The ice halo is added to your image.

Before After
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Screen
The ice halo is combined with the image using a Screen blend mode. This looks 

kind of like the Add blend mode, but highlights are retained.

Brightness
Sets the intensity of the ice halo.

Displacement
Displaces the ice halo by the luminance values of the image. This “fakes” the 

effect of the ice halo wrapping over objects in the image.

Blur
Sets the softness of the ice halo.

Halo
Blend
The ice halo can be added to the entire image or limited to a matte. 

Halo Only
The ice halo is added to the entire image.

Matte
The ice halo is added only in areas of the matte.

Sun Altitude
Selects the appropriate ice halo pattern based on the sun’s altitude.

Position
The ice halo position can be adjusted by clicking and dragging an on-screen 

control in the center of the image.

Scale

Scale X
The horizontal scale of the ice halo.

Scale Y
The vertical scale of the ice halo.
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Gang Scale
The Scale X and Scale Y slider values can be ganged together.

Matte
A matte can be used to limit where the ice halo will be placed. Wherever there 

is white in the matte is where the ice halo will be added. Go to the Matte 

parameters to see how they work.

Note: To use a matte to limit where the ice halo will be added, Halo > Blend must be 
set to Matte.
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 INFRARED

Description
Infrared simulates infrared filters used in conjunction with infrared sensitive film 

or sensors to produce very interesting black and white images with glow in 

highlight areas.

Go to the Infrared Tutorial to see how the filter works.

Category
Special Effects.

Controls

Presets
To select a preset, pick one from the Presets window.

Black and White
Selects the type of black and white filter to be applied to your color image. Go 

to the Black and White section of Common Filter Controls to see how the 

Black and White controls work.

Mist
Blend
Determines the blend mode to be used to create the glow effect.

Before After
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Add
The glow is added to your image.

Screen
The glow is combined with the image using a Screen blend mode. This looks 

kind of like the Add blend mode, but highlights are retained.

Brightness
Sets the intensity of the glow.

Blur
Sets the softness of the glow.

Color Correct
Go to the Color Correct filter to see how the Color Correct controls work.

Matte
A matte is used to create the glow effect. Go to the Matte section of Common 

Filter Controls to see how the Matte controls work.
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 KELVIN

Description
Degrees Kelvin is the standard unit of measure for color temperature which is 

a way to characterize the spectral properties of a light source. Low color 

temperature implies warmer (redder) light, while high color temperature implies 

a colder (bluer) light. Presets for a number of different light sources and 

conditions are provided in degrees Kelvin.

Go to the Kelvin Tutorial to see how the filter works.

Category
Color.

Controls

Presets
To select a preset, pick one from the Presets window.

Color Temperature
The Color Temperature of the image is determined by the difference of the 

Destination and Source Kelvin parameters. For instance, if your Source Kelvin 

is 3200 degrees Kelvin and you adjust the Destination Kelvin to 6500 degrees, 

Before After

Photo by Christiane Nuetzel on Unsplash
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your image would turn blue. This is the same as using tungsten indoor film 

meant to be used with lighting balanced for 3200 degrees Kelvin outside in 

daylight which is 6500 degrees Kelvin.

Destination Kelvin
Sets the destination color temperature of the image in degrees Kelvin.

Source Kelvin
Sets the source color temperature of the image in degrees Kelvin.

Opacity
Sets the opacity of the color temperature adjustment.

Preserve Highlights
Preserves the white areas of the image.

Exposure Compensation
Exposure Compensation adds back the brightness loss as a result of the color 

temperature application.

Grad 
Kelvin can optionally use a gradient that limits where the filter is applied. Grad 

is the transition area between the colored portion and the original image. Its 

direction, corners and size can be adjusted. Go to the Grad section of Common 

Filter Controls to see how the Grad controls work.
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 KEY LIGHT

Description
Using Key Light, an image can be relit by with either a directional or point light. 

The result looks natural even though the relighting is done without computing 

any scene geometry.

Go to the Key Light Tutorial to see how the filter works.

Category
Light.

Controls

Type
Parallel
A directional light source.

Point
A point light where the light either emanates from or fades into a vanishing 

point. Move the point control in the center of the screen to change the Point light 

location.

Strength
Sets the strength of the light.

Before After
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Angle
Used in conjunction with Parallel, Angle sets the direction of the light source.

Invert
Used in conjunction with Point, Invert determines whether the light source 

emanates from or fades into a vanishing point.

Note: Since Key Light works at a proxy resolution, you will need to view the result of 
Key Light at a 1:1 pixel ratio using the Magnifier window to determine what the final 
output will look like.
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 LENS DISTORTION

Description
Lens Distortion corrects for pin-cushioning and barrel distortion of camera 

lenses. It is also useful for creating the look of a wide angle lens.

Go to the Lens Distortion Tutorial to see how the filter works.

Category
Lens.

Note: Lens Distortion must be applied as the first layer (bottom of the layer stack) when 
multiple layers are used. Otherwise, all filters below will not be rendered.

Before After

Photo by Vincent Guth on Unsplash
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Controls

Distortion
Pulls the corners of the image in or out. Negative values pull the corners of the 

image outward while positive values pull the corners of the image inward.

Anamorphic Squeeze
Anamorphic Squeeze corrects for the squeeze found in anamorphic motion 

picture lenses.

Curvature X and Y
Curvature X and Y correct for non-radial, asymmetric distortions found in 

anamorphic motion picture lenses.

Note: Anamorphic Squeeze and Curvature X and Y only work once the Distortion 
parameter has been moved.

Barrel Distortion Pin Cushion Distortion

Original
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Center
Determines the center point for the distortion. There is an on-screen control in 

the center of the image. By clicking and dragging the on-screen control, the 

Center can be adjusted.
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 LENS FLARE

Description
Lens flares are produced by the scattering or flaring of light within a lens when 

pointed into a bright light. Although an image aberration, lens flares can be 

added for dramatic effect and are created by combing the following elements: 

Caustic, Chroma Bands, Chroma Ring, Circle, Circles, Disc, Edge Streak, 

Ellipse, Fan Rays, Hot Spot, Polygon, Polygons, Radial Streaks, Random 

Spikes, Ring, Spikes, Spiral Rays, Star, Star Caustic, and Stripe.

Go to the Lens Flare Tutorial to see how the filter works.

Category
Light.
DFT User Guide    
• 
• 
•
•
•



• 

Lens Flare  432 

• 
• 
• 
•
•
•

Elements

Caustic
Simulates an optical distortion created by the envelope of light rays reflected or 

refracted by a curved surface.

Chroma Bands
Creates rainbow diffraction patterns.
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Chroma Ring
Rainbow lines that emanate from the center of the light source.

Circle
An individual circle.
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Circles
Creates a specified number of random circles often seen in lens flares.

Disc
Generates a circular ramp with individual control of the inner, middle and outer 

areas.
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Ellipse
Ellipse is similar to Disc, but elliptical in shape.

Edge Streak
Caused by a light source at the edge of the frame reflecting off of the shiny lens 

aperture. It only appears when the light source is positioned outside of the 

frame.
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Fan Rays
Generates asymmetric fanned rays.

Hot Spot
Utilized in most lens flares, glow ball simulates the circular glow created when 

a light source interacts with a lens.
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Polygon
An individual polygon.

Polygons
Creates a specified number of random polygons. These are reflections caused 

by light interacting with the lens’s polygonal bladed aperture.
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Radial Streaks
Short radial streaks emanating from the center point.

Random Spikes
Generates asymmetric radial rays.
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Ring
A rainbow ring that fades as it is moved to the edges of the screen.

Spikes
Long radial rays emanating from the center point.
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Spiral Rays
Creates spiral rays.

Star
A star pattern is created when light reflects off the intersection of the lens’s 

aperture blades.
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Star Caustic
A star shaped caustic created by the envelope of light rays reflected or 

refracted by a lens’s reflective coatings.

Stripe
A tapered stripe that simulates anamorphic lens flares.
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Controls - Global

Presets
To select a preset, pick one from the Presets window. 

Edit Flare
Click the Edit Flare button to edit the current preset or to create a custom lens 

flare. The Flare Editor interface consists of a Viewer, Parameters, Global, Flare 

(currently used flare elements) and Elements (all available elements). 

User Interface

Toolbar
The Toolbar contains Done, Cancel, Reset, and Show Image icons.
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Viewer
The Viewer displays the composite of all added flare elements.
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Parameters and Global
Parameters and Global share the same window space on the right side of the 

screen, with Global shown as the default. Either Parameters or Global are 

selectable in a tab at the top of the window.
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Elements
The Elements window displays lens flare building blocks to be used in the 

creation of a flare.

Flare
The Flare window displays all elements that make up the current lens flare.

Enable (E)
Enables and disables the element.

Solo (S)
Displays only the soloed element.
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Working With Elements
Select Elements
Select elements using the Shift or Ctrl(Win)/Cmd(Mac) keys.

Add Elements
• Double-click an element in the Elements window and it is added to the end of the 

stack in the Flare window. If an element is selected in the Flare window prior to the 
double-click, the new element is added after the selection.

• Drag and drop from the Elements window to the Flare window or Viewer. Multiple 
selected elements can be dragged and dropped simultaneously.

Delete Elements
Delete selected elements.

• Press the Delete key.

or

• Click the Delete Element icon at the bottom of the Flare window.

Duplicate Elements
Duplicate selected elements using the Duplicate Element icon at the bottom of 

the Flare window.

Edit Elements
• Select an element in the Flare window and it’s controls are displayed in the 

Parameters window.

• When multiple elements are selected, the controls for all selected elements are 
displayed in the Parameters window.

• Click and drag the point controls in the viewer to move the flare around.

• Ctrl(Win)/Cmd(Mac)-click and drag in the viewer to move the selected elements 
along the flare line.

Moving Elements In The Flare Window
Drag the icon of an element to a new position in the stack. Multiple elements 

can be moved at once.
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Rename Elements
Click in the element text box and type to rename it.

Flare
Input is Linear
Enable this if your image is in true linear color space. Gamma corrected images 

should have this parameter disabled.

Blend
Determines the blend mode used to composite the lens flare.

Add
The lens flare is added to your image.

Screen
The lens flare is combined with the image using a Screen blend mode. This 

looks kind of like the Add blend mode, but highlights are retained.

Color
Sets the color.

Brightness
Controls the brightness.

Position
Adjusts the origin of the lens flare.

Pivot
Changes the end position of the lens flare.

Scale
Determines the size.

Aspect
Sets the aspect ratio.

Angle
Sets the angle.
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Softness
Blurs the lens flare.

Edge Flare
Flares the frame as the lens flare enters or exists the frame.

Amount
Controls the amount of the edge flare.

Size
Sets the size of the edge flare.

Noise
Adds noise to the lens flare elements. Noise can selectively be added to 

elements based on whether an element’s Lens Noise parameter is enabled. 

Alternatively, you can apply noise to all elements using the parameter below.

All Elements
Applies the noise pattern to all lens flare elements.

Amount
Sets the amount of the noise.

Scale
Determines the size of the noise.

X Offset
Moves the noise horizontally.

Y Offset
Moves the noise vertically.

Detail
Sets the detail of the noise.

Texture
Controls the complexity of the noise.
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Randomize 
Randomizes the size and position of the noise.
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Controls - Elements
Each flare element uses a subset of the parameters below.

Angle
Sets the angle.

Aspect
Sets the aspect ratio.

Blur
Blurs the element.

Brightness
Controls the brightness.

Brightness Variance
Randomizes the brightness between multiple elements.

Center
Determines the center of the Chroma Ring along the flare.

Center Brightness
Sets the brightness of the stripe’s center.

Center Offset
Pushes all the Disc edges outwards.

Chroma
Changes the saturation of the Chroma Ring.

Color
Sets the color.

Color Variance
Randomizes the color between multiple elements.

Cycles
Determines the number of Chroma Bands.
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Density
Sets the amount of rays.

Edge Fade
Fades the element as it moves towards the edge of the screen.

Element Count
Sets the number of elements.

Hotspot
Sets the size of the Star’s center hotspot.

Inside Width
Changes the size of the inner ramp.

Jitter
Randomizes the angle.

Length
Sets the length of the stripe.

Lens Noise
Determines whether the Lens Noise controls affect the enabled element.

Lock To
X Axis
Locks the element to the X axis so it will only move vertically.

Y Axis
Locks the element to the Y axis so it will only move horizontally.

Match Flare Angle
Matches the Circle and Polygon element’s angle to the flare angle. This is 

especially useful when the Aspect parameter has been adjusted.

Middle Width
Adjusts the size of the middle ramp.
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Noise
Controls the amount of noise in an element.

Noise Density
The strength of the noise.

Offset
For most elements, Offset determines the element’s inner diameter. For Circles 

and Polygons, it shifts the shapes along the flare axis.

Outside Width
Sets the size of the outer ramp.

Position
Sets the position of the element along the flare.

Position Variance
Randomizes the position between multiple elements along the flare.

Ramp Gamma
Sets the Hot Spot’s black point.

Ramp Scale
Changes the Hot Spot’s size.

Randomize 
Randomizes size and position.

Ring Brightness
Sets the brightness of the Hot Spot’s ring.

Ring Size
Changes the size of the Hot Spot’s ring.

Ring Softness
Softens the Hot Spot’s ring.

Scale
Sets the size.
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Sides
Determines the number of sides.

Size Variance
Randomizes the size between multiple elements.

Softness
Blurs the element.

Softness Variance
Randomizes the softness between multiple elements.

Spread
Determines the distribution of an element.

Taper
Tapers the Chroma Band’s edges.

Total Scale
Sets the size of all elements.

Vertical Variance
Randomizes the vertical position between multiple elements.

Weight
Polygons and Circles can be weighted to either the beginning or end of the lens 

flare.

Warp
Enables the warping of the Ellipse and Ring elements as they exit the frame.

Width
Adjusts the width.

X Offset
Offsets the element horizontally.

Y Offset
Offsets the element vertically.
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 LEVELS

Description
Levels is an image adjustment tool which can move and stretch the brightness 

levels of an image histogram. It has the power to adjust brightness, contrast, 

and tonal range by specifying the location of complete black, complete white, 

and midtones in a histogram.

Category
Color.

Go to the Levels Tutorial to see how the filter works.

Before After

Photo by Mohamed Nohassi on Unsplash
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Since every photo's histogram is unique, there is no single way to adjust the 

levels for all your photos. A proper understanding of how to adjust the levels of 

an image histogram will help you better represent tones in the final image.

Input Levels
The outer two Input Levels sliders map the black point and white point to the 

settings of the Output sliders. By default, the Output sliders are at level 0, where 

the pixels are black, and level 100, where the pixels are white. With the Output 

sliders in the default positions, moving the black Input slider maps the pixel 

value to level 0 and moving the white Input slider maps the pixel value to level 

100. The remaining levels are redistributed between levels 0 and 100. This 

redistribution increases the tonal range of the image, in effect increasing the 

overall contrast of the image.

Note: When shadows are clipped, the pixels are black, with no detail. When highlights 
are clipped, the pixels are white, with no detail.

The middle Input slider adjusts the gamma in the image. It moves the midtone 

and changes the intensity values of the middle range of gray tones without 

dramatically altering the highlights and shadows.

 A. Shadows   B. Midtones   C. Highlights

A           B       C
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Output Levels
The Output Levels decrease the contrast of the image.
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 LIGHT

Description
Light can be added to a scene where none existed before just as if you were 

adding light at the time of shooting. Realistic lighting and shadow is introduced 

using digital versions of lighting gobos.

Gobos (patterns) are widely used by designers in theatre, film, photography 

and television to create atmosphere, project scenery, and generally enhance 

the visual impact of their lighting. Normally used in front of lights during 

photography, these same exact gobos can be applied digitally to the entire 

image or inside a matte.

Go to the Light Tutorial to see how the filter works.

Category
Light.

Before After

Photo by Julia Komarova on Unsplash
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Presets
To select a gobo, pick one from the Presets window. If you would like to view 

gobos from a different category, use the pop-up menu at the top left of the 

Presets window.

Light

Blend
Determines the blend mode to be used to add the light.

Add
The light is added to your image.

Screen
The light is combined with the image using a Screen blend mode. This looks 

kind of like the Add blend mode, but highlights are retained.

Subtract
The light is subtracted from your image creating shadow instead of light.
DFT User Guide    
• 
• 
•
•
•



• 

Light  459 

• 
• 
• 
•
•
•

Brightness
Sets the intensity of the light.

Displacement
Displaces the gobo by the luminance values of the image. This “fakes” the 

effect of light wrapping over objects in the image.

Blur
Sets the softness of the light.

Gels
Photographers, cinematographers and lighting designers use colored filters or 

gels in front of lights. Whatever mood you wish to create, we have the colors 

needed to achieve the effect. Select one of the Gels presets from the pop-up 

menu.

Color
Sets the color of the light through the use of a standard color picker.

Displaced Gobo
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Shadow

Brightness
Sets the intensity of the shadows. The Brightness parameter will darken only 

those areas that are not being affected by the Light settings. 

Gobos
The gobos are organized into various categories including: Abstract, Doors, 

Elements, Foliage, Snowflakes, Textures and Windows groups.

Gobo
Clicking the Gobo > Browse button allows you to load your own image as the 

light source.

To use your own image as a light source:

• Select Gobo > Gobo > Browse.

• When the file browser opens, navigate to your image and select it.
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Blend
The gobo can be added to a matte using a variety of Blend modes. Go to Blend 

Modes for explanations of the various modes.

I like the Multiply blend mode for combining gobos with the matte because it 

only puts the gobo within the areas of the matte.

Opacity
Sets the opacity of the gobo.

Blur
Sets the softness of the gobo.

Transform
Transform your gobo using Position, Scale, Rotate, Corner-Pin, Shear and 

Crop controls. Go to the Transform section of Common Filter Controls to see 

how the Transform Controls work.

Matte GoboMultiply
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Matte
A matte can be used to create areas of light or limit where gobos will be added. 

Wherever there is white in the matte is where the light will be added. When 

using the Light and Gobo filters, it is usually helpful to blur the matte. Go to the 

Matte parameters to see how they work.

Note: To use a matte to create light, Gobo > Blend must be set to something other than 
Gobo Only for the Matte controls to be active.

Matte
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 LOOKS

Description
Looks is a unique filter meant to simulate a variety of color and black and white 

photographic/film looks, diffusion and color grad camera filters, lighting gels, 

film stocks and optical lab processes. By selecting from the available presets, 

parameters in the various modules are automatically set to achieve a variety of 

different effects.

Category
Special Effects.

Controls
The Looks filters are made up of Color Correct, Diffusion, Color Gradient, Gels, 

Lab, Grain and Post Color Correct groups. Together, they simulate a variety of 

photographic and film looks. By selecting from the available presets, 

parameters in the various groups are automatically set to achieve a variety of 

different effects.

Before After

Photo by Mickey O'neil on Unsplash
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Presets
To select a preset, pick one from the Presets window. If you would like to view 

presets from a different category, use the pop-up menu at the top left of the 

Presets window.

Color Correct
Color Correct manipulates the Black and White, Hue, Saturation, Brightness, 

Contrast, Gamma, Red, Green and Blue values of the image. Go to the Color 

Correct filter to see how it works.

Diffusion
Diffusion creates atmosphere by reducing contrast while creating a glow 

around highlights or shadows. It simulates diffusion and fog filters as well as 

glows. Go to the Diffusion section of the Film Stocks filter to see how it works.

Color Gradient
Color Gradient colors and or darkens only a portion of the image giving you the 

ability to simulate any Color Gradient filter. Presets for your favorite color 

gradient filters are provided as well as the ability to create custom colors. There 

is a graduated transition for a smooth color blend between the 

colored/darkened portion and the original image. Color Gradient is especially 

useful for changing and enhancing the color of the sky. Go to the Color 

Gradient filter to see how it works.

Gels
Photographers, cinematographers and lighting designers use colored filters or 

gels in front of lights. Whatever mood you wish to create, we have the colors 

needed to achieve the effect. Go to the Gels filter to see how it works.

Lab
The Lab group simulates a variety of different optical lab processes including 

Bleach Bypass, Cross Processing, Flashing and Overexposure. Go to the 

Bleach Bypass filter, Cross Processing filter, Flashing and the Overexpose 

filter to see how they work.
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Grain
Grain simulates film grain with individual control of red, green, and blue grain 

size, softness and intensity. In addition, a Film Response parameter controls 

where you will see grain in the image. Go to the Grain filter to see how it works.

Warning: You may not see an accurate representation of the grain in the Viewer unless 
you use the Magnifier with this filter.

Post Color Correct
Post Color Correct gives you further color correction after all other operations 

have been processed. This is often helpful as some of the operations affect the 

brightness, contrast and color of the image. In addition, Temperature controls 

allow you to make the scene warmer or cooler, and cyan or magenta. Go to the 

Color Correct filter to see how it works.
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 LOW CONTRAST

Description
Low Contrast spreads highlights into darker areas, lowers contrast and keeps 

bright areas bright.

Go to the Low Contrast Tutorial to see how the filter works.

Category
Color.

Controls

Presets
To select a preset, pick one from the Presets window.

Contrast
Light Brightness
Sets the intensity of the light that is spread into darker areas.

Before After

Photo by Len Dela Cruz on Unsplash
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Light Spread
Sets how far light is spread from bright areas to darker areas.

Shadow Brightness
Adjusts the brightness of the shadow areas.

Matte
A matte is used to create the light spread effect. Go to the Matte section of 

Common Filter Controls to see how the Matte controls work.
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 MATCH

Description
Matches the brightness and color from one image and applies it to another.

Go to the Match Tutorial to see how the filter works.

Category
Color.

Controls

Source
Selects a source image to be matched. Click the Browse button to select an 

image.

Brightness
Sets the amount of the brightness match.

Source Target After

Source/After: Photo by Paula Borowska on Unsplash
Target: Photo by Saud Sarosh on Unsplash
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Color
Sets the amount of the color match.
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Matching Clips:

1 Apply the Match filter to a target image.

2 Select the source image to be matched with the Source selector.

The color and brightness of the source image are analyzed and applied to your 

target image.

3 Adjust the Color and Brightness parameters to your liking.
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 MIST

Description

Mist
Creates atmosphere by reducing contrast while creating a glow around 

highlights.

Warm Mist
Same as Mist but combined with a warming filter.

Before After

Photo by Christopher Campbell on Unsplash

Before After

Photo by Christopher Campbell on Unsplash
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Cool Mist
Same as Mist but combined with a cooling filter.

Black Mist
A more subtle version of Mist, the Black Mist filter creates atmosphere by 

reducing contrast, but with minimal glow around highlights.

Before After

Photo by Christopher Campbell on Unsplash

Before After

Photo by Christopher Campbell on Unsplash
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Warm Black Mist
Same as Black Mist but combined with a warming filter.

Go to the Mist Tutorial to see how the filter works.

Category
Diffusion.

Controls

Presets
To select a preset, pick one from the Presets window.

Mist
The Mist controls add a mild glow to image highlights.

Blend
Determines the blend mode to be used to create the glow effect.

Add
The glow is added to your image.

Screen
The glow is combined with the image using a Screen blend mode. This looks 

kind of like the Add blend mode, but highlights are retained.

Before After

Photo by Christopher Campbell on Unsplash
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Brightness
Sets the intensity of the glow.

Blur
Sets the softness of the glow.

Color
Sets the color of the glow.

Color Correct
Go to the Color Correct filter to see how the Color Correct controls work.

Matte
A matte is used to create the mist effect. Go to the Matte section of Common 

Filter Controls to see how the Matte controls work.
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 MULTI-STAR

Description
User definable multi-point star patterns are generated on highlights in the 

image.

Go to the Multi-Star Tutorial to see how the filter works.

Category
Light.

Controls

Presets
To select a preset, pick one from the Presets window.

Star
The Star settings control the various qualities of the generated star patterns.

Blend
Determines the blend mode to be used when adding the stars.

Add
The stars are added to your image.

Before After

Photo by Pawel Bukowski on Unsplash
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Screen
The stars are combined with the image using a Screen blend mode. This looks 

kind of like the Add blend mode, but highlights are retained.

Brightness
Determines the brightness of the stars.

Spokes
Controls the number of star spokes.

Size
Sets the star size.

Angle
Rotates the stars.

Color
Sets the star color.

Matte
A matte is used to create the star effect. Go to the Matte section of Common 

Filter Controls to see how the Matte controls work.
DFT User Guide    
• 
• 
•
•
•



• 

ND Gradient  477 

• 
• 
• 
•
•
•

 ND GRADIENT

Description
ND (Neutral Density) Gradient darkens only a portion of the image using a 

graduated transition between the darkened portion and the original image. It 

selectively adjusts brightness without affecting color balance. The most likely 

use for ND Gradient would be to balance the difference between the sky and 

ground in a landscape.

Go to the ND Gradient Tutorial to see how the filter works.

Category
Grads/Tints.

Controls

Presets
To select a preset, pick one from the Presets window.

F-Stop
Presets
Select one of the ND Gradient presets from the pop-up menu.

Exposure
Darkens the image using F-Stops as the unit of measure.

Before After

Photo by Sam Ferrara on Unsplash
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Preserve Highlights
Preserves the white areas of the image.

Grad
Grad is the transition area between the darkened portion and the original 

image. Its direction, corners and size can be adjusted. Go to the Grad section 

of Common Filter Controls to see how the Grad controls work.
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 NET

Description

Net
Softens and minimizes facial imperfections while retaining image clarity. Great 

for portraits and people photography.

Warm Net
Combines all of the benefits of Net with a warming filter.

Go to the Net Tutorial to see how the filter works.

Category
Diffusion.

Before After

Photo by Rachael Crowe on Unsplash

Before After

Photo by Rachael Crowe on Unsplash
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Presets
To select a preset, pick one from the Presets window. If you would like to view 

presets from a different category, use the pop-up menu at the top left of the 

Presets window.

Blur
Sets the softness of the image.

Opacity
Sets the amount of diffusion mixed into the original image. The higher the 

setting, the more the image is blurred.

Color Correct
Go to the Color Correct filter to see how the Color Correct controls work.
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 NIGHT VISION

Description
The Night Vision filter creates the effect of a Night Vision lens--that green, 

glowy, grainy look.

Go to the Night Vision Tutorial to see how the filter works.

Category
Special Effects.

Controls

Presets
To select a preset, pick one from the Presets window.

Black and White
Selects the type of black and white filter to be applied to your color image. Go 

to the Black and White section of Common Filter Controls to see how the 

Black and White controls work.

Before After

Photo by Thomas Shellberg on Unsplash
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Tint

Color
Sets the color that the image will be tinted with. The color is preset to a night 

vision green, but feel free change it by using the color picker.

Opacity
Sets the opacity of the tint color.

Glow

Blend
Determines the blend mode to be used to create the glow effect.

Add
The glow is added to your image.

Screen
The glow is combined with the image using a Screen blend mode. This looks 

kind of like the Add blend mode, but highlights are retained.

Brightness
Sets the intensity of the glow.

Blur
Sets the softness of the glow.

Additional Controls

Grain
Grain Size
Controls the size of the grain.

Warning: You may not see the grain size change in the Viewer unless you use the 
Magnifier with this filter.

Grain Amount
Controls the intensity of the grain.
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Color Correct
Go to the Color Correct filter to see how the Color Correct controls work.

Matte
A matte is used to create the glow effect. Go to the Matte section of Common 

Filter Controls to see how the Matte controls work.
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 OVEREXPOSE

Description
Overexpose simulates the overexposure that occurs when a film camera is 

stopped.

Go to the Overexpose Tutorial to see how the filter works.

Category
Film Lab.

Controls

Presets
To select a preset, pick one from the Presets window.

Amount
Controls the amount of overexposure.

Intensity
Sets the intensity of the overexposure.

Before After

Photo by Mads Schmidt on Unsplash
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Blur
Sets the softness of the overexposure.
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 OZONE

Description
Ozone allows you to manipulate the color of an image with incredible flexibility 

and accuracy.

Inspired by Ansel Adams’ Zone System for still photography, we have created 

“The Digital Zone System”. Just what is the Digital Zone System? The world 

around us contains an infinite palette of colors, tones and brightness. To 

reproduce this vast range of brightness, the Digital Zone System takes the 

spectrum of image values and divides them into 11 discrete zones using 

proprietary image slicing algorithms.

Zones can be created using luminance, hue, saturation, average, red, green, 

blue, cyan, magenta, and yellow values. Look at how the image below is 

divided into hue zones. 

Before After

Photo by Annie Spratt on Unsplash

 Zone 0  Zone 1  Zone 2  Zone 3  Zone 4  Zone 5  Zone 6  Zone 7  Zone 8  Zone 9  Zone 10
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With Ozone, the color values of each zone can be independently adjusted until 

you’ve painted a new picture. Your adjustments occur on a zone by zone basis, 

but you view the result of all color corrections simultaneously.

Go to the Ozone Tutorial to see how the filter works.

Category
Color.

Controls

Zone
Selects one of the 11 zones. Once you click in the Zone selector, you can use 

the left and right arrow keys to cycle through the zones.

Extract On
The Extract On pop-up menu allows you to specify the image values to be used 

for dividing the image into the 11 individual zones.

Luminance
Zones are created using the image’s luminance values.

Hue
Zones are created using the image’s hue. When adjusting the Position 

parameter, you are selecting different hues.

Saturation
Zones are created using the image’s saturation values.

Average
Zones are created based on the average of the image’s RGB values.

Red
Zones are created using the image’s red values.

Green
Zones are created using the image’s green values.
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Blue
Zones are created using the image’s blue values.

Cyan
Zones are created using the image’s cyan values.

Magenta
Zones are created using the image’s magenta values.

Yellow
Zones are created using the image’s yellow values.

Zone Controls
When using Luminance as the method for slicing up the image, the Position 

and Range sliders are preset so that each zone is twice as bright as the 

previous zone, proceeding from black towards white.

Pure black is defined as Zone 0, Zone 5 as middle gray and pure white as Zone 

10. By using the View menu, you can look at the zone which is helpful in 

determining the portions of the image you are going to adjust. The values 

shown as white in the selected zone are the areas of the image that will be 

modified by the color adjustments. Alternatively, at the bottom of the Parameter 

window is a small image thumbnail of the selected zone.

Position
The Position value pinpoints the color values to be used in the selected zone. 

This value has been preset according to the Digital Zone System, but can be 

changed if you choose. If the zones are created using Luminance, a high 

Position value shows the brightest image values as white values in the zone. A 

low Position value shows the darkest image values as white values in the zone.

 Zone 0  Zone 1  Zone 2  Zone 3  Zone 4  Zone 5  Zone 6  Zone 7  Zone 8  Zone 9  Zone 10
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Range
The Range value increases or decreases the range of values in the selected 

zone. This value has been preset according to the Digital Zone System, but can 

be changed if you want.

Go to the Matte section of Common Filter Controls to see how the Position and 

Range controls work.

Hue
Rotates the hue of the zone.

Saturation
Adjusts the saturation of the zone. Positive values saturate, negative values 

desaturate.

Brightness
Adjusts the brightness of the zone. Positive values brighten, negative values 

darken.

Contrast
Adjusts the contrast of the zone. Positive values increase contrast, negative 

values decrease contrast.

Gamma 
Adjusts the gamma of the zone. The gamma adjustment leaves the white and 

black points the same and only modifies the values in-between. Positive values 

lighten the midtones, negative values darken the midtones.

Red
Adds or subtracts red from the zone.

Green
Adds or subtracts green from the zone.

Blue
Adds or subtracts blue from the zone.
DFT User Guide    
• 
• 
•
•
•



• 

Ozone  490 

• 
• 
• 
•
•
•

Temperature
Sets the color temperature of the zone. Dragging the slider to the right makes 

the image cooler (bluer) and dragging the slider to the left makes the image 

warmer (redder).

Cyan/Magenta
Adds either Cyan or Magenta to the zone. Dragging the slider to the right 

makes the image more magenta and dragging the slider to the left makes the 

image more cyan.
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Zone Thumbnail
At the bottom of the Parameter window is a thumbnail of the selected zone to 

help you see which areas of the image will be adjusted.
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 PAINT

Description
Paints your image using Black/White, Blur, Clone, Color, Eraser, Mosaic, Red-

Eye, Repair and Scatter brushes.

Go to the Paint Tutorial to see how the filter works.

Category
Image.

Brushes
When Paint is selected in the Filter window, it’s controls appear in the Toolbar.

Black/White (B)
The Black/White brush converts color images to black and white simulating the 

look of Black and White photographic filters.

Mode
Selects the method by which the color image is converted to a monochrome 

image.

Before After

Photo by Katie Hetland on Unsplash
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Luminance
Creates a monochrome image using the brightness of the image.

Average
Creates a monochrome image using the average of the red, green and blue 

channels.

Red
Simulates a red filter in black and white photography.

Green
Simulates a green filter in black and white photography.

Blue
Simulates a blue filter in black and white photography.

Yellow
Simulates a yellow filter in black and white photography.

Orange
Simulates a orange filter in black and white photography.

Blur (Shift+B)
Blurs the image.

Amount
Sets the amount of blur to be applied.

Clone (C)
Paints the image using another part of the image.

Using the Clone brush:

1 Select the Clone brush in the Toolbar.

2 Press and hold down the Shift key.
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3 Click, drag and release to set the clone offset.

The first click sets the clone source and where you drag and release is the 

clone destination.

4 Use your pen and tablet or mouse to paint with the Clone brush.

To quickly reset the clone offset:

• Press shift and without moving the cursor, click your mouse or tap your pen on 
the screen once.

The clone offset is quickly reset.

Nudging the Clone Source
The Clone source can be nudged using the Arrow keys. One press of the 

Arrow key moves the Clone source 1 pixel. Using the Shift key in conjunction 

with the Arrow keys moves the Clone source 10 pixels.

Color (Shift+C)
Paints the image with the current color.

Color
Displays the currently selected color. Clicking on the Color icon opens a 

standard color picker.

Eyedropper
Colors can be picked off of the screen using the eyedropper icon.

Mode
Selects how color is applied to the image.

Normal
The current color is added to the image.

Tint
The current color is used to tint the image by replacing hue and saturation.
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Hue
The current color is used to tint the image by only replacing hue.

Lighten
Pixels darker than the paint color are replaced, and pixels lighter than the paint 

color do not change.

Darken
Pixels lighter than the paint color are replaced, and pixels darker than the paint 

color do not change.

Eraser (E)
Erases previously painted brush strokes.

Painting with the right-mouse button automatically paints with the Eraser brush.

Mosaic (Shift+M)
Divides the picture up into square tiles.

Size
Controls the size of the square tiles. A small size value will create many square 

tiles.

Red-Eye (R)
Removes red-eye.

To remove red-eye:

1 Select the Red-Eye brush in the Toolbar.
DFT User Guide    
• 
• 
•
•
•



• 

Paint  496 

• 
• 
• 
•
•
•

2 Use Ctrl(Win) or Cmd(Mac) and drag in or out to size the brush to roughly match 
the size of the red pupil.

3 Paint in the area of the red pupil being careful not to paint on any skin areas.

Repair (Shift+R)
Paints the image with the color level sampled at the beginning of each stroke.

Scatter (S)
Scatters pixels in a random fashion.

Radius
Sets the amount of scattering.

Brush Settings
Customize your brush using the following settings:
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Profile
The profile setting controls the shape of the brush.

Circle
The brush profile is set to a circular shape.

Square
The brush profile is set to a square shape.

Size
Sets the size of the brush.

To set the brush size:

1 Click on the Brush Size icon, and drag the slider that appears.

or

2 Enter a value in the number field next to the Brush Size icon and hit Enter.

or

3 Resize the brush in the Viewer by holding Ctrl(Win)/Cmd(Mac) and dragging in or 
out.
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Softness
Sets the brush softness.

To set the brush softness:

1 Click on the Brush Softness icon, and drag the slider that appears.

or

2 Enter a value in the number field next to the Brush Softness icon and hit Enter.

Opacity
Sets the brush opacity.

To set the brush opacity:

1 Click on the Brush Opacity icon, and drag the slider that appears.
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or

2 Enter a value in the number field next to the Brush Opacity icon and hit Enter.

Paint Keyboard Shortcuts

Shortcut Action

B Selects the Black/White brush

Shift+B Selects the Blur brush

C Selects the Clone brush

Shift+C Selects the Color brush

E Selects the Eraser brush

Shift+M Selects the Mosaic brush

R Selects the Red-Eye brush

Shift+R Selects the Repair brush

S Selects the Scatter brush

Ctrl(Win)/Cmd(Mac)+drag Sizes the brush

[ ] Sizes the brush

Shift with clone brush Sets the clone offset

Shift+click or tap Resets the clone offset

Arrow keys Moves the Clone source by 1 pixel

Shift+Arrow keys Moves the Clone source by 10 pixels

Hold down Arrow keys Moves the Clone source continuously

Right-mouse drag Paints with the Eraser brush
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 PASTEL

Description
Converts the image into pastel artwork.

Go to the Pastel Tutorial to see how the filter works.

Category
Special Effects.

Controls

Amount
Adjusts the amount of the pastel effect.

Detail
Adjusts the detail. If the slider is increased, you will see more detail while 

decreasing the slider will have an overall smoothing effect.

Before After

Photo by Boris Smokrovic on Unsplash
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 PENCIL

Description
Pencil converts your image to a pencil sketch.

Go to the Pencil Tutorial to see how the filter works.

Category
Special Effects.

Controls

Presets
To select a preset, pick one from the Presets window.

Amount
Sets the intensity of the pencil effect.

Color
The Color parameter sets the color of the pencil effect through the use of a 

standard color picker.

Background
Mixes in the original image.

Before After

Photo by Ludde Lorentz on Unsplash
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 PHOTOGRAPHIC

Description
The most complete line of Kodak® filters for photographic uses is available in 

the form of gelatin films and are known as Wratten® Gelatin Filters. Our 

Photographic filter is a digital equivalent of the Wratten set and were created 

using the spectral transmission curves for each optical filter. The Color 

Conversion, Light Balancing and Color Compensating preset groups are 

subsets of the Photographic filters. 

Go to the Photographic Tutorial to see how the filter works.

Photographic
Digital versions of the complete line of Kodak® Wratten® Gelatin Filters.

Color Conversion
Color Conversion filters correct for significant differences in color temperature 

between your light source and recording media.

Light Balancing
Light Balancing filters correct for minor differences in color temperature 

between your light source and recording media.

Before After

Photo by Paul Morris on Unsplash
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Color Compensating
Color Compensating filters control color by attenuating specific parts of the 

spectrum. They can be used to make changes in color balance or compensate 

for deficiencies in the image’s spectral quality.

Category
Grads/Tints.

Controls

Presets
To select a preset, pick one from the Presets window. If you would like to view 

presets from a different category, use the pop-up menu at the top left of the 

Presets window.

Color
Color
The Color parameter sets the color of the filter through the use of a standard 

color picker.

Opacity
Sets the opacity of the color filter.

Preserve Highlights
Preserves the white areas of the image.

Exposure Compensation
Exposure Compensation adds back the brightness loss as a result of the filter 

application.

Grad 
These filters can optionally use a gradient that limits where the filter is applied. 

Grad is the transition area between the colored portion and the original image. 

Its direction, corners and size can be adjusted. Go to the Grad section of 

Common Filter Controls to see how the Grad controls work.
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 POLARIZER

Description

Polarizer
The greatest use of polarizing filters is to achieve a darkened, deep blue sky. 

Our digital version of the Polarizer is designed to do just that. Through the use 

of a matte and an adjustable gradient, the color of the sky can be adjusted.

Warm Polarizer
Combines the benefits of the Polarizer with a warming filter making it ideal for 

portraits and scenics.

Go to the Polarizer Tutorial to see how the filter works.

Before After

Photo by Takahiro Sakamoto on Unsplash
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Photo by Takahiro Sakamoto on Unsplash
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Category
Color.

Controls

Presets
To select a preset, pick one from the Presets window. If you would like to view 

presets from a different category, use the pop-up menu at the top left of the 

Presets window.

Sky
Color Correct controls are provided to adjust the sky.

Hue
Rotates the hue of the sky.

Saturation
Adjusts the saturation of the sky. Positive values saturate, negative values 

desaturate.

Brightness
Adjusts the brightness of the sky. Positive values brighten, negative values 

darken.

Contrast
Adjusts the contrast of the sky. Positive values increase contrast, negative 

values decrease contrast.

Gamma 
Adjusts the gamma of the sky. The gamma adjustment leaves the white and 

black points the same and only modifies the values in-between. Positive values 

lighten the midtones, negative values darken the midtones.

Red
Adds or subtracts red from the sky.
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Green
Adds or subtracts green from the sky.

Blue
Adds or subtracts blue from the sky.

Temperature
Sets the color temperature of the sky. Dragging the slider to the right makes the 

sky cooler (bluer) and dragging the slider to the left makes the sky warmer 

(redder).

Temperature
Applies a warming filter to the image. Go to the Temperature section of 

Common Filter Controls to see how the Temperature controls work.

Grad
The Polarizer can optionally use a gradient that limits where the filter is applied. 

For instance, if the polarization is affecting areas other than the sky, enable the 

Grad and adjust it to limit the areas of polarization. Go to the Grad section of 

Common Filter Controls to see how the Grad controls work.

Matte
Hue
The Polarizer isolates the sky using a matte based on a blue hue. Use the Hue 

eyedropper to select the exact color of the sky if you are not seeing enough 

polarization.

Range
Increases or decreases the range of values in the hue matte. A low Range 

value indicates a narrow range of values. A high Range value indicates a large 

range of values included in the matte.

Blur
Sets the softness of the matte by using a quality blur.

Go to the Matte parameters to see how they work.
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 RACK FOCUS

Description
Rack Focus replicates a true camera defocus by introducing lens Bokeh 

effects. Bokeh is the Japanese term that describes the quality of out-of-focus 

points of light. In defocused areas, each point of light becomes a shape--either 

a circle or a polygon. The shape grows in size as the amount of defocusing is 

increased.

Go to the Rack Focus Tutorial to see how the filter works.

Category
Lens.

Controls

Presets
To select a preset, pick one from the Presets window.

Blur
The image is blurred by using a quality blur.

Aperture
Blend
Determines the blend mode to be used when adding Bokeh.

Before After

Photo by Steven Hung on Unsplash
DFT User Guide    
• 
• 
•
•
•



• 

Rack Focus  508 

• 
• 
• 
•
•
•

Add
Bokeh’s are added to your image.

Screen
The Bokeh are combined with the image using a Screen blend mode. This 

looks kind of like the Add blend mode, but highlights are retained.

Brightness
Brightens the Bokeh.

Facets
Set the number of Bokeh facets when the Curvature parameter is set to 0.

Curvature
Controls the curvature of the Bokeh. When set to 100, the Bokeh are 

completely round. Set to a value of 0 to see a polygonal shape.

Angle
Rotates the Bokeh.

Color
Sets the Bokeh color.

Blur
Sets the softness of the Bokeh. This can be useful when using high threshold 

values.

Matte
A matte is used to create the Bokeh effect. Go to the Matte section of Common 

Filter Controls to see how the Matte controls work.
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 RADIAL EXPOSURE

Description
Lightens and/or darkens the center or edges of an image to correct lens 

vignetting.

Go to the Radial Exposure Tutorial to see how the filter works.

Category
Lens.

Controls

Exposure
Edges
Lightens or darkens the edges of the image.

Center
Lightens or darkens the center of the image.

Spot
A radial gradient is used to lighten or darken the edges or center of the image. 

Go to the Spot section of Common Filter Controls to see how the Spot controls 

work.

Before After

Photo by Joshua Earle on Unsplash
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 RADIAL STREAKS

Description
Short radial streaks emanating from the center point.

Go to the Radial Streaks Tutorial to see how the filter works.

Category
Light.

Controls

Blend
Determines the blend mode used to create the streaks effect.

Add
The streaks are added to your image.

Screen
The streaks are combined with the image using a Screen blend mode. This 

looks kind of like the Add blend mode, but highlights are retained.
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Brightness
Controls the brightness.

Color
Sets the color.

Scale
Changes the size.

Aspect
Sets the aspect ratio.

Angle
Sets the angle.

Element Count
Determines the number of streaks.

Randomize 
Randomizes the size and position.

Jitter
Randomizes the angle.
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 RADIAL TINT

Description
Tints the image using multi-color, radially graduated filters.

Go to the Radial Tint Tutorial to see how the filter works.

Category
Grads/Tints.

Controls

Presets
To select a preset, pick one from the Presets window.

Tint Mode
Selects how color is applied to the image.

Normal
Tints the image while retaining highlights.

Tint
The image is tinted by replacing hue and saturation.

Hue
The image is tinted by only replacing hue.

Before After

Photo by Jason Wong on Unsplash
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Lighten
Pixels darker than the color are replaced, and pixels lighter than the color do 

not change.

Darken
Pixels lighter than the color are replaced, and pixels darker than the color do 

not change.

Color 1
Sets the color for the top left quadrant of the image.

Color
Sets the color through the use of a standard color picker.

Opacity
Sets the opacity of the color.

Color 2
The Color 2 controls are the same as the controls for Color 1 except it is applied 

to the top right quadrant of the image.

Color 3
The Color 3 controls are the same as the controls for Color 1 except it is applied 

to the bottom right quadrant of the image.

Color 4
The Color 4controls are the same as the controls for Color 1 except it is applied 

to the bottom left quadrant of the image.

Radial Grad
Sets the position, rotation and aspect ratio of the radial gradient.

Position
There is an on-screen control in the center of the image. By clicking and 

dragging the on-screen control, the position of the grad can be adjusted.

Size
The size of the grad.
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Rotation
The rotation of the grad.

Aspect
The aspect ratio of the grad.

Highlights
Preserve Highlights
Preserves the white areas of the image.

Exposure Compensation
Exposure Compensation adds back the brightness loss as a result of the filter 

application.

Spot
A spot in the form of a radial gradient can optionally be used to control where 

color is added to the image. Go to the Spot section of Common Filter Controls 

to see how the Spot controls work.
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 RAINBOW

Description
Recreates arced rainbows of spectral colors, usually identified as red, orange, 

yellow, green, blue, indigo, and violet, that appear in the sky as a result of the 

refractive dispersion of sunlight in drops of rain or mist.

Go to the Rainbow Tutorial to see how the filter works.

Category
Light.

Controls

Light
Blend
Determines the blend mode to be used to add the rainbow.

Add
The rainbow is combined with the image using an Add blend mode.

Screen
The rainbow is combined with the image using a Screen blend mode. This 

looks kind of like the Add blend mode, but highlights are retained.

Before After

Photo by Jeremy Bishop on Unsplash
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Normal
The rainbow is added to the image using a normal composite function.

Amount
Sets the intensity of the rainbow.

Displacement
Displaces the rainbow by the luminance values of the image. This “fakes” the 

effect of the rainbow wrapping over objects in the image.

Blur
Sets the softness of the rainbow.

Rainbow
Blend
The rainbow can be added to the entire image or limited to a matte. 

Rainbow Only
The rainbow is added to the entire image.

Matte
The rainbow is added only in areas of the matte.

Position
The rainbow position can be adjusted by clicking and dragging an on-screen 

control in the center of the image.

Radius
The size of the rainbow.

Aspect
Sets the aspect ratio of the rainbow. Positive values stretch the rainbow 

horizontally and negative values stretch it vertically.

Thickness
Sets the thickness of the rainbow’s bands.
DFT User Guide    
• 
• 
•
•
•



• 

Rainbow  517 

• 
• 
• 
•
•
•

Crop
Offset
The rainbow is cropped based on the Offset value. The higher the value, the 

more rainbow you see. A value of -100 shows no rainbow at all while 100 

displays a complete 360 degree rainbow.

Angle
Sets the angle of the crop.

Softness
Sets the softness of the crop’s edge.

Matte
A matte can be used to limit where the rainbow will be placed. Wherever there 

is white in the matte is where the rainbow will be added. Go to the Matte 

parameters to see how they work.

Note: To use a matte to limit where the rainbow will be added, Rainbow > Blend must 
be set to Matte.
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 RANDOM SPIKES

Description
Generates asymmetric radial rays.

Go to the Random Spikes Tutorial to see how the filter works.

Category
Light.

Controls

Blend
Determines the blend mode used to create the spikes effect.

Add
The spikes are added to your image.

Screen
The spikes are combined with the image using a Screen blend mode. This 

looks kind of like the Add blend mode, but highlights are retained.
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Brightness
Controls the brightness.

Color
Sets the color.

Scale
Changes the size.

Aspect
Sets the aspect ratio.

Angle
Sets the angle.

Element Count
Determines the number of rays.

Softness
Blurs the rays.

Randomize 
Randomizes the size and position.
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 RAYS

Description
Create stunning and realistic light ray effects quickly and easily. Known as 

volumetric lighting in computer graphics or crepuscular rays in atmospheric 

optics, this dramatic effect adds polish and style. Since the rays are only added 

to highlight areas, they have the effect of passing through objects and add a 

third dimensional quality. Add shafts of light streaming through clouds, rays 

filtering through a forest canopy, beams of light on a foggy night or rays 

shooting out from text. Rays adds a striking and dramatic quality to any image.

Go to the Rays Tutorial to see how the filter works.

Note: The Magnifier controls are disabled for performance reasons when using Rays.

Category
Light.

Controls

Rays
Position
Move the point control in the center of the screen to change the source point 

from which the rays will emanate.

Before After

Photo by Filipe Dos Santos Mendes on Unsplash
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Length
Sets the ray length.

Brightness
Sets the brightness of the rays.

Color
Sets the color of the rays.

Blur
Blurs the rays.

Threshold
Controls the amount of rays based on a brightness threshold. Fewer rays with 

more definition are generated at higher threshold values.

Light Source
A circular light source can be used to enhance the generation of the light rays. 

It is particularly useful when the image does not have strong highlights.

Brightness
Sets the brightness of the light source.

Size
Sets the size of the light source.

Texture
Adds texture to the rays.

Amount
Sets the amount of texture.

Size
Sets the size of the texture.

Phase
Sets the randomness of the texture.
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Shimmer
Randomizes the rays.

Amount
Sets the amount of shimmering.

Phase
Sets the randomness of the shimmering.

Opacity
Rays
Sets the opacity of the rays.

Source
Sets the opacity of your image.
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 REFLECTOR

Description
One of the oldest and still most popular means of lighting an exterior set is by 

taking a reflective surface and redirecting sunlight or artificial light exactly 

where it is needed. Unfortunately, it is nearly impossible for actors to keep their 

eyes open when looking into a reflector, resulting in squinting eyes. Our silver 

and gold reflectors allow you to add white or gold light into shadow areas 

without the squinting.

Go to the Reflector Tutorial to see how the filter works.

Category
Light.

Controls

Presets
To select a preset, pick one from the Presets window. If you would like to view 

presets from a different category, use the pop-up menu at the top left of the 

Presets window.

Brightness
Sets the intensity of the reflector.

Before After

Photo by Alexandre Chambon on Unsplash
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Color
The Color parameter sets the color of the reflector through the use of a 

standard color picker. The default color is gold for Gold Reflector and white for 

Silver Reflector.

Position
Selects the shadow values that will be adjusted with the Brightness slider.

Range
Controls the range of shadow values that will be adjusted with the Brightness 

slider.

Go to the Matte section of Common Filter Controls to see how the Position and 

Range controls work.
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 RELIGHT

Description
Light can be added to a scene where none existed before. A complete set of 

light source controls allow you to adjust the light just as you would at the time 

of shooting.

Go to the ReLight Tutorial to see how the filter works.

Category
Light.

Light

Blend
Determines the blend mode to be used to add the light.

Add
The light is added to your image.

Before After

Photo by Blake Lisk on Unsplash
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Screen
The light is combined with the image using a Screen blend mode. This looks 

kind of like the Add blend mode, but highlights are retained.

Brightness
Sets the intensity of the light.

Displacement
Displaces the light source by the luminance values of the image. This “fakes” 

the effect of light wrapping over objects in the image.

Blur
Sets the softness of the light.

Gels
Photographers, cinematographers and lighting designers use colored filters or 

gels in front of lights. Whatever mood you wish to create, we have the colors 

needed to achieve the effect. Select one of the Gels presets from the pop-up 

menu. 

Color
Sets the color of the light through the use of a standard color picker.

Light Source

Blend
The light source can be added to the matte using a variety of Blend modes. Go 

to Blend Modes for explanations of the various modes.

I like the Multiply blend mode for combining the light source with the matte 

because it only puts the light source within the areas of the matte.

Opacity
Sets the opacity of the light source.

Aspect
The aspect ratio of the light source.
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Radius
The un-blurred radius of the light source.

Falloff Radius
The blurred edge radius.

Falloff
Moves the falloff towards the light centerpoint.

Invert
Inverts the light source.

Transform
Transform your light pattern using Position, Scale, Rotate, Corner-Pin, Shear 

and Crop controls. Go to the Transform section of Common Filter Controls to 

see how the Transform Controls work.

Matte
A matte can be used to limit the area of added light. Wherever there is white in 

the matte is where the light will be added. When using ReLight, it is usually 

helpful to blur the matte. Go to the Matte parameters to see how they work.

Note: Light Source > Blend must be set to something other than Shape Only for the 
Matte controls to be active.
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 SELECTIVE COLOR CORRECT

Description
Colors can be selectively isolated through the use of a matte and adjusted 

using hue, saturation, brightness, gamma, contrast, temperature, 

cyan/magenta, red, green, and blue controls.

Go to the Selective Color Correct Tutorial to see how the filter works.

Category
Color.

Color Correct
Certain parts of the image are isolated by the creation of a matte. Whatever is 

shown as white in the matte can be adjusted by the color controls below. 

Hue
Rotates the hue of the image.

Saturation
Adjusts the saturation of the image. Positive values saturate, negative values 

desaturate.

Before After

Photo by Pietro De Grandi on Unsplash
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Brightness
Adjusts the brightness of the image. Positive values brighten, negative values 

darken.

Contrast
Adjusts the contrast of the image. Positive values increase contrast, negative 

values decrease contrast.

Gamma 
Adjusts the gamma of the image. The gamma adjustment leaves the white and 

black points the same and only modifies the values in-between. Positive values 

lighten the midtones, negative values darken the midtones.

Temperature
Sets the color of the image to be either warmer or cooler. Dragging the slider to 

the right makes the image cooler (bluer) and dragging the slider to the left 

makes the image warmer (redder).

Cyan/Magenta
Adds either Cyan or Magenta to the image. Dragging the slider to the right 

makes the image more magenta and dragging the slider to the left makes the 

image more cyan.

Red
Adds or subtracts red from the image.

Green
Adds or subtracts green from the image.

Blue
Adds or subtracts blue from the image.

Temperature
Sets the color temperature of the image. Dragging the slider to the right makes 

the image cooler (bluer) and dragging the slider to the left makes the image 

warmer (redder).
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Matte
A matte is created to isolate areas to be color corrected. Using advanced image 

slicing algorithms, mattes are created using luminance, hue, saturation, 

average, red, green, blue, cyan, magenta, and yellow values.

Extract On
Extract On selects the type of matte. Select whichever type isolates the desired 

values.

A matte is created based on one of the following:

Luminance
A matte is created based on the luminance of the image.

Before After

Matte
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Hue
A matte is created based on the hue of the image. When adjusting the Position 

parameter, you are selecting different hues.

Saturation
A matte is created based on the saturation of the image.

Average
A matte is created based on the average of the image’s RGB values.

Red
A matte is created based on the image’s red values.

Green
A matte is created based on the image’s green values.

Blue
A matte is created based on the image’s blue values.

Cyan
A matte is created based on the image’s cyan values.

Magenta
A matte is created based on the image’s magenta values.

Yellow
A matte is created based on the image’s yellow values.

Position
The Position value pinpoints the color values to be used in the matte. For a 

luminance matte, a Position value of 100 would make a white matte of the 

highlights and a value of 0 would make a white matte of the shadows. In the 
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flower image below, look at how the matte varies for different Position values in 

a red extraction. When the Position is at a value of 100, the red flowers are 

shown as white in the matte.

When the Position is moved to 50, the red flowers turn black.

Range
Increases or decreases the range of values in the matte. A low Range value 

indicates a narrow range of values. A high Range value indicates a large range 

of values included in the matte.

Position=100, Range=25

Position=50, Range=25

Position=100, Range=50
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Black Clip
Blacks in the matte are made blacker by increasing the value of the slider. As 

the slider value increases, more values are clipped to black. This is helpful for 

getting rid of unwanted gray areas in what should be the black part of the matte. 

White Clip
Whites in the matte are made whiter by increasing the value of the slider. As 

the slider value increases, more values are clipped to white. This is helpful for 

getting rid of unwanted gray areas in what should be the white part of the matte. 

Matte with No Black Clip                                 Black Clip=50

Matte with No White Clip                               White Clip=50
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Shrink/Grow
Shrinks or grows the matte. Negative values shrink and positive values grow 

the matte.

Blur
Blurs the matte.

Invert
• Off

Does nothing to the matte.

Original

                    Shrink=-2                                              Grow=1.5

No Blur                                                   Blur=10 
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• On

Inverts the luminance values of the matte.

Invert Off                                                 Invert On
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 SELECTIVE SATURATION

Description
The saturation of the image can be adjusted independently in the shadows, 

midtones and highlights.

Go to the Selective Saturation Tutorial to see how the filter works.

Category
Color.

Controls

Presets
To select a preset, pick one from the Presets window.

Shadows
Saturation
Adjusts the saturation of the image in the shadows. Positive values saturate, 

negative values desaturate.

Position
Selects the shadow values to be adjusted.

Before After

Photo by Oswaldo Martinez on Unsplash
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Range
Controls the range of values to be used for the shadows. A higher Range value 

considers more values as shadows.

Midtones
Saturation
Adjusts the saturation of the image in the midtones. Positive values saturate, 

negative values desaturate.

Position
Selects the midtones values to be adjusted.

Range
Controls the range of values to be used for the midtones. A higher Range value 

considers more values as midtones.

Highlights
Saturation
Adjusts the saturation of the image in the highlights. Positive values saturate, 

negative values desaturate.

Position
Selects the highlight values to be adjusted.

Range
Controls the range of values to be used for the highlights. A higher Range value 

considers more values as highlights.

Go to the Matte section of Common Filter Controls to see how the Position and 

Range controls work.
DFT User Guide    
• 
• 
•
•
•



• 

Sepia  538 

• 
• 
• 
•
•
•

 SEPIA

Description

Sepia
Creates a warm brown tone for that nostalgic feeling.

Go to the Sepia Tutorial to see how the filter works.

Category
Grads/Tints.

Controls

Presets
To select a preset, pick one from the Presets window.

Color
Amount
Determines the intensity of the color added to the image.

Opacity
Sets the opacity of the filter.

Preserve Highlights
Preserves the white areas of the image.

Before After

Photo by Andrew Neel on Unsplash
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Exposure Compensation
Exposure Compensation adds back the brightness loss as a result of the filter 

application.

Grad 
Sepia can optionally use a gradient that limits where the filter is applied. Grad 

is the transition area between the colored portion and the original image. Its 

direction, corners and size can be adjusted. Go to the Grad section of Common 

Filter Controls to see how the Grad controls work.
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 SHADOWS/HIGHLIGHTS

Description
Shadows/Highlights lowers contrast evenly throughout the image by 

brightening shadow areas and darkening highlights. It is useful for correcting 

dark foreground subjects due to strong backlighting as well as highlights that 

are slightly washed out.

Go to the Shadows/Highlights Tutorial to see how the filter works.

Category
Color.

Controls

Presets
To select a preset, pick one from the Presets window.

Shadows
Shadows
Raises the brightness of the shadows.

Position
Selects the shadow values to be adjusted.

Before After

Photo by Jonatan Pie on Unsplash
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Range
Controls the range of values to be used for the shadows. A higher Range value 

considers more values as shadows. 

Highlights
Highlights
Lowers the brightness of the highlights.

Position
Selects the highlight values to be adjusted.

Range
Controls the range of values to be used for the highlights. A higher Range value 

considers more values as highlights. 

Go to the Matte section of Common Filter Controls to see how the Position and 

Range controls work.
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 SHARPEN

Description
Enhances the sharpness or focus by selectively increasing the contrast 

between adjacent pixels along edges in an image.

Go to the Sharpen Tutorial to see how the filter works.

Category
Image.

Controls

Presets
To select a preset, pick one from the Presets window.

Amount
Determines how much contrast is added at the edges.

Radius
Controls the size of the edges you wish to sharpen.

Before After

Photo by Corentin Marzin on Unsplash
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Threshold
The threshold setting is used to sharpen more pronounced edges, while 

leaving more subtle edges untouched. Low values sharpen more image areas 

while higher threshold values sharpen less.
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 SILK

Description

Silk
Silk softens wrinkles, blemishes and fine detail to produce smooth skin textures 

while retaining detail in coarse features such as the eyes, nose and mouth.

Warm Silk
Warm Silk offers all the benefits of the Silk filter while adding a diffuse warm tint 

to the shadows.

Go to the Silk Tutorial to see how the filter works.

Before After

Photo by Joe Gardner on Unsplash

Before After

Photo by Joe Gardner on Unsplash
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Category
Diffusion.

Controls

Presets
To select a preset, pick one from the Presets window. If you would like to view 

presets from a different category, use the pop-up menu at the top left of the 

Presets window.

Detail
Smoothing
Fine image details, such as facial wrinkles and blemishes, are minimized using 

edge aware smoothing.

Color Correct
Go to the Color Correct filter to see how the Color Correct controls work.

Matte
A matte can be used to limit the smoothing effect. Wherever there is white in 

the matte is where the smoothing will occur. Go to the Matte parameters to see 

how they work.
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 SKIN TONE

Description
A set of colorization filters to enhance skin tones.

Go to the Skin Tone Tutorial to see how the filter works.

Category
Grads/Tints.

Controls

Presets
To select a preset, pick one from the Presets window.

Color
Color
The Color parameter sets the color through the use of a standard color picker.

Opacity
Sets the opacity of the color filter.

Before After

Photo by Roksolana Zasiadko on Unsplash
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Preserve Highlights
Preserves the white areas of the image.

Exposure Compensation
Exposure Compensation adds back the brightness loss as a result of the filter 

application.

Grad 
The Skin Tone filters can optionally use a gradient that limits where the filter is 

applied. Grad is the transition area between the colored portion and the original 

image. Its direction, corners and size can be adjusted. Go to the Grad section 

of Common Filter Controls to see how the Grad controls work.
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 SOFT LIGHT

Description
Provides soft, digitally diffused and virtually shadowless light.

Go to the Soft Light Tutorial to see how the filter works.

Category
Light.

Controls

Presets
To select a preset, pick one from the Presets window.

Blend
Determines the blend mode to be used to add the light.

Add
The light is added to your image.

Screen
The light is combined with the image using a Screen blend mode. This looks 

kind of like the Add blend mode, but highlights are retained.

Brightness
Sets the intensity of the light.

Before After

Photo by Chris Abney on Unsplash
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Blur
Sets the softness of the light.

Gels
Photographers, cinematographers and lighting designers use colored filters or 

gels in front of lights. Whatever mood you wish to create, we have the colors 

needed to achieve the effect. Select one of the Gels presets from the pop-up 

menu. 

Color
Sets the color of the light through the use of a standard color picker.
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 SPIKES

Description
Long radial rays emanating from the center point.

Go to the Spikes Tutorial to see how the filter works.

Category
Light.

Controls

Blend
Determines the blend mode used to create the spikes effect.

Add
The spikes are added to your image.

Screen
The spikes are combined with the image using a Screen blend mode. This 

looks kind of like the Add blend mode, but highlights are retained.
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Brightness
Controls the brightness.

Color
Sets the color.

Scale
Changes the size.

Aspect
Sets the aspect ratio.

Angle
Sets the angle.

Element Count
Determines the number of rays.

Softness
Blurs the rays.

Randomize 
Randomizes the size and position.
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 SPIRAL RAYS

Description
Creates spiral rays.

Go to the Spiral Rays Tutorial to see how the filter works.

Category
Light.

Controls

Blend
Determines the blend mode used to create the rays effect.

Add
The rays are added to your image.

Screen
The rays are combined with the image using a Screen blend mode. This looks 

kind of like the Add blend mode, but highlights are retained.
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Brightness
Controls the brightness.

Color
Sets the color.

Scale
Changes the size.

Aspect
Sets the aspect ratio.

Angle
Sets the angle.

Element Count
Determines the number of rays.

Softness
Blurs the rays.

Randomize 
Randomizes the size and position.
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 SPLIT FIELD

Description
Split Field splits the image with a line that can be positioned, rotated and 

blurred. On one side of the line, the image is blurred and on the other, it is in 

focus.

Go to the Split Field Tutorial to see how the filter works.

Category
Lens.

Controls

Presets
To select a preset, pick one from the Presets window.

Blur
Sets the softness of the split portion of the image.

Split
The Split controls manipulate the position, rotation and blur of the split line.

Before After

Photo by Anthony Cantin on Unsplash
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Position
There is an on-screen control in the center of the image. By clicking and 

dragging the on-screen control, the position of the split line can be adjusted.

Rotate
Rotates the split line.

Blur
Blurs the split line using a quality blur.
DFT User Guide    
• 
• 
•
•
•



• 

Split Tone  556 

• 
• 
• 
•
•
•

 SPLIT TONE

Description
Shadows, midtones and highlights can be individually tinted with the Split tone 

filter.

Go to the Split Tone Tutorial to see how the filter works.

Category
Grads/Tints.

Controls

Shadows
Opacity
Set the opacity of the tint color.

Color
The Color parameter sets the color of the shadow tint through the use of a 

standard color picker.

Position
Selects the shadow values to be adjusted.

Before After

Photo by Aaron Burden on Unsplash
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Range
Controls the range of values to be used for the shadows. A higher Range value 

considers more values as shadows. 

Midtones
Opacity
Set the opacity of the tint color.

Color
The Color parameter sets the color of the midtone tint through the use of a standard 
color picker.

Position
Selects the midtone values to be adjusted.

Range
Controls the range of values to be used for the midtones. A higher Range value 

considers more values as midtones. 

Highlights
Opacity
Set the opacity of the tint color.

Color
The Color parameter sets the color of the highlight tint through the use of a standard 
color picker.

Position
Selects the highlight values to be adjusted.

Range
Controls the range of values to be used for the highlights. A higher Range value 

considers more values as highlights.

Go to the Matte section of Common Filter Controls to see how the Position and 

Range controls work.
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Preserve Highlights
Preserves the white areas of the image.

Exposure Compensation
Exposure Compensation adds back the brightness loss as a result of the 

tinting.
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 STAR

Description
A star pattern similar to those created by lens flares.

Go to the Star Tutorial to see how the filter works.

Category
Light.

Controls

Blend
Determines the blend mode used to create the star effect.

Add
The star is added to your image.

Screen
The star is combined with the image using a Screen blend mode. This looks 

kind of like the Add blend mode, but highlights are retained.
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Brightness
Sets the brightness.

Color
Changes the color.

Element Count
Determines the number of spikes.

Hotspot
Adjusts the size of the center hotspot.

Offset
Sets the inner diameter.

Scale
Changes the size.

Aspect
Sets the aspect ratio.

Width
Determines the width.

Angle
Adjusts the angle.

Spread
Sets the spike distribution.

Noise
Controls the amount of noise applied to the spikes.

Noise Density
Changes the strength of the noise.

Randomize 
Randomizes the size and position.
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Softness
Blurs the star.
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 STREAKS

Description
The Streaks filter creates horizontal or vertical streaks around highlights in the 

image.

Go to the Streaks Tutorial to see how the filter works.

Category
Light.

Controls

Presets
To select a preset, pick one from the Presets window.

Streaks
Blend
Determines the blend mode to be used to create the streak effect.

Add
The streaks are added to your image.

Before After

Photo by Allef Vinicius on Unsplash
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Screen
The streaks are combined with the image using a Screen blend mode. This 

looks kind of like the Add blend mode, but highlights are retained.

Brightness
Sets the intensity of the streaks.

Streaks

Horizontal Streaks
Creates horizontal streaks.

Vertical Streaks
Creates vertical streaks.

Color
The Color parameter sets the color of the streaks through the use of a standard 

color picker. The default color is white.

Matte
A matte is used to create the streak effect. Go to the Matte section of Common 

Filter Controls to see how the Matte controls work.
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 SUNSET

Description
Sunset applies three photographic filters to the image which are blended 

together with a gradient. Presets for your favorite Color Gradient filters are 

provided as well as the ability to create custom colors.

Go to the Sunset Tutorial to see how the filter works.

Category
Grads/Tints.

Controls

Presets
To select a preset, pick one from the Presets window.

Color 1
Sets the color for the top third of the image. Select the desired color using the 

color picker or choose a filter preset.

Presets
Select one of the filters from the pop-up menu.

Before After

Photo by Mark Harpur on Unsplash
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Color
The Color parameter sets the color of the grad through the use of a standard 

color picker.

Opacity
Sets the opacity of the color filter.

Color 2
The Color 2 controls are the same as the controls for Color 1 except it is applied 

to the middle third of the image.

Color 3
The Color 3 controls are the same as the controls for Color 1 except it is applied 

to the bottom third of the image.

Highlights
Preserve Highlights
Preserves the white areas of the image.

Exposure Compensation
Exposure Compensation adds back the brightness loss as a result of the filter 

application.

Grad 
Grad is the combination of the three blended tints. Its direction, corners and 

size can be adjusted.Go to the Grad section of Common Filter Controls to see 

how the Grad controls work.
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 TEXTURE

Description
Applies textures to an image for a stylized look.

Go to the Texture Tutorial to see how the filter works.

Category
Special Effects.

Controls

Presets
To select a preset, pick one from the Presets window.

Amount
Sets the amount of texture applied to the image.

Complexity
Generates a more detailed, repetitive texture.

Before After

Photo by Luke Braswell on Unsplash
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Randomize
Randomizes the texture.

Transform
Transform the texture using Position, Scale, Rotate, Corner-Pin, Shear and 

Crop controls. Go to the Transform section of Common Filter Controls to see 

how the Transform Controls work.
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 THREE STRIP / TWO STRIP

Three Strip
Known and celebrated for it ultra-realistic, saturated levels of color, the 

Technicolor® Three Strip process was commonly used for musicals, costume 

pictures and animated films. It was created by photographing three black and 

white strips of film each passing through red, green and blue filters on the 

camera lens and then recombining them in the printing process.

Two Strip
The Technicolor® Two Strip process was the first stab at producing color 

motion pictures and consisted of simultaneously photographing two black and 

white images using red and green filters. This look creates an odd but pleasing 

hand-painted look where faces appear normal and green takes on a blue-green 

quality, while the sky and all things blue appear cyan.

Before After

Photo by Rob Jaudon on Unsplash

Before After

Photo by Rob Jaudon on Unsplash
DFT User Guide    
• 
• 
•
•
•



• 

Three Strip / Two Strip  569 

• 
• 
• 
•
•
•

Our Three Strip and Two Strip filters were created under the direction of 

Academy Award Winning Visual Effects Supervisor Rob Legato.

Go to the Three Strip / Two Strip Tutorial to see how the filters work.

Category
Film Lab.

Controls

Presets
To select a preset, pick one from the Presets window.

Opacity
Sets the intensity of the of the effect.

Strips
Red Intensity
Intensifies red values in the image.

Red Smooth
Blurs the red matte that is used to isolate the red values. Use this control to 

smooth out any noise that may appear if the Red Intensity is turned up to a high 

value.

Green Intensity
Intensifies green values in the image.

Green Smooth
Blurs the green matte that is used to isolate the green values. Use this control 

to smooth out any noise that may appear if the Green Intensity is turned up to 

a high value.

Blue Intensity
Intensifies blue values in the image when using the Three Strip filter, but 

darkens image areas that were blue in the source image when using the Two 

Strip filter.
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Blue Smooth
Blurs the blue matte that is used to isolate the blue values. Use this control to 

smooth out any noise that may appear if the Blue Intensity is turned up to a high 

value.

Color Correct
Go to the Color Correct filter to see how the Color Correct controls work.
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 TINT

Description
Tints the entire image with a selected color using a variety of colorization 

modes.

Go to the Tint Tutorial to see how the filter works.

Category
Grads/Tints.

Controls

Presets
To select a preset, pick one from the Presets window. If you would like to view 

presets from a different category, use the pop-up menu at the top left of the 

Presets window.

Before After

Photo by Joshua Medway on Unsplash
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Black and White
Enable
Converts the image to Black and White.

Filter
The Filter pop-up selects the type of black and white filter to be applied to your 

color image. Go to the Black and White section of Common Filter Controls to 

see how the Black and White controls work.

Brightness
Adjusts the brightness of the image. Positive values brighten, negative values 

darken.

Contrast
Adjusts the contrast of the image. Positive values increase contrast, negative 

values decrease contrast.

Gamma 
Adjusts the gamma of the image. The gamma adjustment leaves the white and 

black points the same and only modifies the values in-between. Positive values 

lighten the midtones, negative values darken the midtones.

Tint
Color
Sets the color that the image will be colorized with. Select the desired color 

using the color picker.

Opacity
Sets the opacity of the color.

Mode
Selects how color is applied to the image.

Normal
Tints the image while retaining highlights.
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Tint
The image is tinted by replacing hue and saturation.

Hue
The image is tinted by only replacing hue.

Lighten
Pixels darker than the color are replaced, and pixels lighter than the color do 

not change.

Darken
Pixels lighter than the color are replaced, and pixels darker than the color do 

not change.

Grad
Tint can optionally use a gradient that limits where the filter is applied. Grad is 

the transition area that goes from the tinted image to the original image. Its 

direction, corners and size can be adjusted. Go to the Grad section of Common 

Filter Controls to see how the Grad controls work.
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 TONE ADJUST

Description
Tone Adjust approximates the appearance of high dynamic range images by 

adjusting the tonal values. Specifically, detail is recovered from the darker 

portions of the images and can optionally be denoised.

Go to the Tone Adjust Tutorial to see how the filter works.

Category
Color

Controls

Amount
Lightens shadows to reveal more detail. Take care not to over apply this setting 

and reveal image noise.

DeNoise
Removes film grain and noise in the shadow areas.

Before After

Photo by Brand X Design
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Position
Selects the shadow values to be adjusted.

Range
Controls the range of values to be used for the shadows. A higher Range value 

considers more values as shadows.
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 VIGNETTE

Description
A vignette, or soft fade, is a popular photographic effect where the photo 

gradually fades into the background, usually in a circular or rectangular shape. 

The vignette can be any color as well as thrown out of focus.

Go to the Vignette Tutorial to see how the filter works.

Category
Lens.

Controls

Presets
To select a preset, pick one from the Presets window.

Vignette
Color
The Color parameter sets the color of the vignette through the use of a standard 

color picker. The default color is black.

Opacity
Sets the opacity of the colored vignette. For defocused vignettes, you may want 

to turn down the Opacity so you can see the defocused effect.

Before After

Photo by Srikanta H. U. on Unsplash
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Blur
Sets the softness of the image in the area of the vignette.

Shape
Roundness
Sets the roundness of the vignette. The vignette can either be circular or square 

or anywhere in between.

Size
Sets the size of the vignette.

Aspect Ratio
Changes the aspect ratio of the vignette. A value of -100 would be wider, and 

100 would be taller.

Rotation
Rotates the vignette.

Distortion
Distorts the edge of the vignette.

Distortion Size
Sets the size of the distortion.

Randomize
Randomizes the distortion.

Softness
The Softness parameters control the softness of the vignette edge.
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 WATER DROPLETS

Description
Simulates the circular, rainbow colored optical effects produced by tiny water 

droplets in clouds, mist and fog.

Go to the Water Droplets Tutorial to see how the filter works.

Category
Light.

Controls

Presets
To select a preset, pick one from the Presets window.

Light
Blend
Determines the blend mode to be used to add the rainbow.

Add
The rainbow is added to your image.

Before After

Photo by Peter Hershey on Unsplash
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Screen
The rainbow is combined with the image using a Screen blend mode. This 

looks kind of like the Add blend mode, but highlights are retained.

Brightness
Sets the intensity of the rainbow.

Displacement
Displaces the rainbow by the luminance values of the image. This “fakes” the 

effect of the rainbow wrapping over objects in the image.

Blur
Sets the softness of the rainbow.

Rainbow
Blend
The rainbow can be added to the entire image or limited to a matte. 

Rainbow Only
The rainbow is added to the entire image.

Matte
The rainbow is added only in areas of the matte.
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Type

Corona
A corona has a bright center and is surrounded by a number of concentric 

colored rings.

Fogbow
A fogbow is similar to a rainbow, but because of the very small size of water 

droplets that cause fog, the fogbow has little color and appears white.
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Glory
Formed when light is scattered backwards by water droplets, glories have 

multiple colored rings with a bright center, but not as bright as a corona’s. In 

addition, the rings dissipate much slower than those of the corona.

Position
The rainbow position can be adjusted by clicking and dragging an on-screen 

control in the center of the image.

Scale

Scale X
The horizontal scale of the rainbow.

Scale Y
The vertical scale of the rainbow.

Gang Scale
The Scale X and Scale Y slider values can be ganged together.

Matte
A matte can be used to limit where the rainbow will be placed. Wherever there 

is white in the matte is where the rainbow will be added. Go to the Matte 

parameters to see how they work.

Note: To use a matte to limit where the rainbow will be added, Rainbow > Blend must 
be set to Matte.1
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 WIDE ANGLE LENS

Description
Simulates the effect of a wide angle lens.

Go to the Wide Angle Lens Tutorial to see how the filter works.

Category
Lens.

Note: Wide Angle Lens must be applied as the first layer (bottom of the layer stack) 
when multiple layers are used. Otherwise, all filters below will not be rendered.

Distortion
Pulls the corners of the image outward.

X and Y Correction
X and Y Correction compensate for the deformation introduced with the 

Distortion parameter.

Before After

Photo by Dawid Zawila on Unsplash
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 X-RAY

Description
Simulates the look of X-Ray images.

Go to the X-Ray Tutorial to see how the filter works.

Category
Special Effects.

Controls

Presets
To select a preset, pick one from the Presets window.

Black and White
Filter
The Filter pop-up selects the type of black and white filter to be applied to your 

color image. Go to the Black and White section of Common Filter Controls to 

see how the Black and White controls work.

Brightness
Adjusts the brightness of the image. Positive values brighten, negative values 

darken.

Before After

Photo by Clem Onojeghuo on Unsplash
DFT User Guide    
• 
• 
•
•
•



• 

X-Ray  584 

• 
• 
• 
•
•
•

Contrast
Adjusts the contrast of the image. Positive values increase contrast, negative 

values decrease contrast.

Gamma 
Adjusts the gamma of the image. The gamma adjustment leaves the white and 

black points the same and only modifies the values in-between. Positive values 

lighten the midtones, negative values darken the midtones.

Color
Opacity
Sets the opacity of the color.

Color
The Color parameter sets the color of the x-ray through the use of a standard 

color picker and defaults to blue.
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 BLEND MODES

Blend modes are used to combine images in a variety of different ways.

Normal
Edits each pixel to make it the result color. This is the default mode. Changing 

the opacity results in a mix between two layers.

Darken
Looks at the color information in each channel and selects the base or blend 

color—whichever is darker—as the result color. Pixels lighter than the blend 

color are replaced, and pixels darker than the blend color do not change.

Multiply
Looks at the color information in each channel and multiplies the base color by 

the blend color. The result color is always a darker color. Multiplying any color 

with black produces black. Multiplying any color with white leaves the color 

unchanged.

Color Burn
Looks at the color information in each channel and darkens the base color to 

reflect the blend color by increasing the contrast between the two. Blending 

with white produces no change.

Linear Burn
Looks at the color information in each channel and darkens the base color to 

reflect the blend color by decreasing the brightness. Blending with white 

produces no change.

Darker Color
Compares the total of all channel values for the blend and base color and 

displays the lower value color. Darker Color does not produce a third color, 

which can result from the Darken blend, because it chooses the lowest channel 

values from both the base and the blend color to create the result color.
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Lighten
Looks at the color information in each channel and selects the base or blend 

color—whichever is lighter—as the result color. Pixels darker than the blend 

color are replaced, and pixels lighter than the blend color do not change.

Add
The pixels of one image are added to another image

Screen
Looks at each images color information and multiplies the inverse of the two 

images. This looks kind of like the Add blend mode, but highlights are retained.

Color Dodge
Looks at the color information in each channel and brightens the base color to 

reflect the blend color by decreasing contrast between the two. Blending with 

black produces no change.

Linear Dodge (Add)
Looks at the color information in each channel and brightens the base color to 

reflect the blend color by increasing the brightness. Blending with black 

produces no change.

Lighter Color
Compares the total of all channel values for the blend and base color and 

displays the higher value color. Lighter Color does not produce a third color, 

which can result from the Lighten blend, because it chooses the highest 

channel values from both the base and blend color to create the result color.

Overlay
Multiplies or screens the colors, depending on the base color. Patterns or colors 

overlay the existing pixels while preserving the highlights and shadows of the 

base color. The base color is not replaced, but mixed with the blend color to 

reflect the lightness or darkness of the original color.
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Soft Light
Darkens or lightens the colors, depending on the blend color. The effect is 

similar to shining a diffused spotlight on the image. If the blend color (light 

source) is lighter than 50% gray, the image is lightened as if it were dodged. If 

the blend color is darker than 50% gray, the image is darkened as if it were 

burned in.

Hard Light
Multiplies or screens the colors, depending on the blend color. The effect is 

similar to shining a harsh spotlight on the image. If the blend color (light source) 

is lighter than 50% gray, the image is lightened, as if it were screened. This is 

useful for adding highlights to an image. If the blend color is darker than 50% 

gray, the image is darkened, as if it were multiplied. This is useful for adding 

shadows to an image.

Vivid Light
Burns or dodges the colors by increasing or decreasing the contrast, 

depending on the blend color. If the blend color (light source) is lighter than 50% 

gray, the image is lightened by decreasing the contrast. If the blend color is 

darker than 50% gray, the image is darkened by increasing the contrast.

Linear Light
Burns or dodges the colors by decreasing or increasing the brightness, 

depending on the blend color. If the blend color (light source) is lighter than 50% 

gray, the image is lightened by increasing the brightness. If the blend color is 

darker than 50% gray, the image is darkened by decreasing the brightness.

Pin Light
Replaces the colors, depending on the blend color. If the blend color (light 

source) is lighter than 50% gray, pixels darker than the blend color are 

replaced, and pixels lighter than the blend color do not change. If the blend 

color is darker than 50% gray, pixels lighter than the blend color are replaced, 

and pixels darker than the blend color do not change. This is useful for adding 

special effects to an image.
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Difference
Looks at the color information in each channel and subtracts either the blend 

color from the base color or the base color from the blend color, depending on 

which has the greater brightness value. Blending with white inverts the base 

color values; blending with black produces no change.

Exclusion
Creates an effect similar to but lower in contrast than the Difference mode. 

Blending with white inverts the base color values. Blending with black produces 

no change.

Subtract
Looks at the color information in each channel and subtracts the blend color 

from the base color. In 8 and 16-bit images, any resulting negative values are 

clipped to zero.

Hue
Creates a result color with the luminance and saturation of the base color and 

the hue of the blend color.

Saturation
Creates a result color with the luminance and hue of the base color and the 

saturation of the blend color.

Color
Creates a result color with the luminance of the base color and the hue and 

saturation of the blend color. This preserves the gray levels in the image and is 

useful for coloring monochrome images and for tinting color images.
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  KEYBOARD SHORTCUTS

Crop Shortcuts

EZ Mask Shortcuts

Help Shortcuts

Layout Shortcuts

Shortcut Action

Drag on one of the vertical boundaries Crops horizontally

Drag on one of the horizontal boundaries Crops vertically

Drag bounding box corner Scales the Crop

Drag inside the bounding box Moves the Crop

Shortcut Action

Enter Processes the mask

Shortcut Action

F1 Opens the DFT User Guide

Shortcut Action

F2 Selects the Default Layout

F3 Selects the Edit Layout

F4 Selects the View Layout

F5 Selects the Dual Monitor Layout
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Paint Keyboard Shortcuts

Path Mask Point Selecting Shortcuts

Shortcut Action

B Selects the Black/White brush

Shift+B Selects the Blur brush

C Selects the Clone brush

Shift+C Selects the Color brush

E Selects the Eraser brush

Shift+M Selects the Mosaic brush

R Selects the Red-Eye brush

Shift+R Selects the Repair brush

S Selects the Scatter brush

Ctrl(Win)/Cmd(Mac)+drag Sizes the brush

[ ] Sizes the brush

Shift with clone brush Sets the clone offset

Shift+click or tap Resets the clone offset

Arrow keys Moves the Clone source by 1 pixel

Shift+Arrow keys Moves the Clone source by 10 pixels

Hold down Arrow keys Moves the Clone source continuously

Right-mouse drag Paints with the Eraser brush

Shortcut Action

Click a point Selects one point

Click and drag over multiple points Selects multiple points

Ctrl+click on a point Toggles the matte on or off

Shift+click a point Adds the point to the current matte
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Path Mask Point Editing Shortcuts

Path Mask Point Editing Pop-up Menu

Snap Mask Point Editing Shortcuts

Shortcut Action

Alt+click on a path Inserts a new point along the path

Delete key Delete all selected points

Click and drag selected points All selected points move

Click and drag an unselected point Moves one point

Alt+click+drag on a point Opens a slider to adjust the point’s tension. Left of center 
forces the path to curve through the point (Cardinal 
spline). The center position creates a corner point while 
the right position moves the curve towards the center of 
the path (B-Spline). If multiple points have been selected, 
they will all be set to the same tension.

Alt+click+drag+Shift on a point Snaps the point tension to Cardinal, Corner or B-Spline 
positions

Menu Option Action

Cardinal Creates a path that passes smoothly through each point

Corner Creates a corner point

B-Spline Creates a path that is determined by the surrounding points

Shortcut Action

Alt+click between two points Add points 

Hover over point + Delete Key Delete points

Alt+drag a point Uses magnetism to snap a point to an object’s boundary
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Viewer Keyboard Shortcuts

Shortcut Action

Middle-mouse drag Pans the image

Space Bar+drag Pans the image

I Key Zooms the image in

O Key Zooms the image out

Zoom icon+Drag a square Zooms into the defined area

Scroll wheel over image Zooms the image in and out

Middle-mouse double click Fits the image to the window

Ctrl(Win)/Cmd(Mac)+click 
A/B Comparison

Turns off A/B Comparison mode, if enabled,

F Fits the image to the window

M Cycles the display between the full color image and the Mask 
channel 

H Opens the Histogram window

1 Opens the Magnifier window
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